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前言

� (截止于2021年11月)

可以使用以下手册了解和操作此对讲机。
 如有必要，您可以从Icom网站下载HAM电台术语表 。

提示: 可以从Icom网站下载每个手册和指南：
https://www.icomjapan.com/support/
在网站的搜索框中输入“ID-52A”或“ID-52E”。

基本说明书（随机提供）

包括基本操作和注意事项。
D-STAR指南还包括向网关中继器注册呼号以及
D-STAR的基本操作。

高级说明书 (本手册)

• 连接附件
• 使用microSD卡
• 电池充电
• 调频广播操作
• D-STAR操作（高级）
• GPS操作（高级）
• 语音传输功能
• 录音功能
• 存储操作
• 扫描操作
• 中继器和双工操作
• 设置模式
• 蓝牙操作
• 其他功能
• 更新固件
• 选件

CI-V参考指南（PDF格式）

描述远程控制操作中使用的控制命令（使用CI-V进行
串行通信）。

关于DV网关功能（PDF类型）

使用DV网关功能的系统要求或操作说明。

更新中继器列表（PDF类型）

更新中继器列表的步骤说明。

使用GPS记录器功能（PDF格式）

操作GPS记录器功能的说明，该功能将GPS接收器
的位置数据作为日志保存到microSD卡上。

商标
Icom、Icom股份有限公司和Icom徽标是Icom Incorporated（日本）在日本、美国、英国、德国、法国、西班牙、俄罗斯、澳大
利亚、新西兰和/或其他国家的注册商标。
蓝牙单词标记和徽标是Bluetooth SIG，Inc.拥有的注册商标，Icom股份有限公司对此类标记的任何使用均受许可。其他商标和商
号是其各自所有者的商标和商号。
Adobe、Acrobat和Reader是Adobe Systems Incorporated在美国和/或其他国家/地区的注册商标或商标。
APRS®是Bob Bruninga先生在美国和其他国家的注册商标。
Microsoft和Windows是Microsoft公司集团的商标。
Google、Google徽标、Google Play、Google Play徽标、Android和Android徽标是Google，LLC的商标。iOS是Cisco在美国和
其他国家的商标或注册商标，并经许可使用。
iPadOS是iOS股份有限公司的商标。
App Store是iOS股份有限公司的服务标志。
所有其他产品或品牌均为其各自持有人的注册商标或商标。

感谢您选购Icom产品。 该产品采用Icom的最新技术和工艺进行设计和制造。 精心护理，本产品应可为您提供多年的
无故障运行。
该产品将传统的模拟技术与现代数字技术(D-STAR)相结合，从而更容易和操作业余无线电设备。



•• Advanced search screen

 根据Adobe Acrobat Reader版本的不同，界面可能有所不同。 
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Adobe® Acrobat® Reader® 功能介绍
以下功能可与Adobe Acrobat Reader一起使用。

• 关键词搜索
 打开说明书，单击编辑菜单中
的“查找”(Ctrl+F)或“高级搜
索”(Shift+Ctrl+F)打开搜索关键
词。
方便在本说明书中搜索特定单词
或短语。 

菜单界面可能会有所不同，具
体取决于Adobe Acrobat Reader
的版本。

点击打开查找或高级搜索界面

• 查询对话框

• 朗读功能.
“大声朗读”功能可大声朗读此PDF中的文
本。
有关详细信息，请参阅Adobe Acrobat
Reader帮助。(此功能可能不可用，具体取
决于您的PC环境和操作系统。)

• 打印出所需的页面
 单击“文件”菜单中的“打印”，然后选择要打印的纸张大
小和页码。

*打印设置可能不同，具体取决于打印机。有关详细
信息，请参阅打印机使用手册。

*如按说明书的实际大小打印，纸张大小请选
择“A4”。
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文本输入和编辑

用于文本输入的控件 更改字符类型
1. 当未选择文本或选择了输入的文本时，按下

[QUICK]。
2. 旋转[DIAL] 选择字符类型，然后按[ENT]。

字符转换

ABC A to Z, 0 to 9, (space) A/a
abc a to z, 0 to 9, (space) A/a
123 0 to 9, (space) –

!”# ! “ # $ % & ’ ( ) * + , - . / : ; < = >
? @ [ \ ] ^ _ ` { | } ˜ (space)

–

提示:输入字符为“AB”或“ab”时，按[QUICK]选择大
写或小写字母。

按[QUICK]

• 要插入文本，请将光标移到要输入的位置，然后旋转
[DIAL]，或按D-pad()来选择显示字符。

[DIAL] (旋转) 
选择字符

[ENT]
设置

取消

打开字符

选择一个字符

清除字符

向左移动光标

打开进入模式选择窗口

向右移动光标

•  按[CLEAR]取消输入字符。
• 要连续清除字符，请连续按[CLEAR]。

字符类型 可选字符和符号



iv

可用字符
可用字符和符号以及最多字符数，因项目而异，详见下表。
每种字符类型的可用字符和符号在页面底部描述。

调频广播信道
群组名称 [ABC] [abc] [123] [!”#] 16 –

名称 [ABC] [abc] [123] [!”#] 16 –

存储信道
群组名称 [ABC] [abc] [123] [!”#] 16 –

名称 [ABC] [abc] [123] [!”#] 16 –
呼叫信道 名称 [ABC] [abc] [123] [!”#] 16

对方呼号
名称 [ABC] [abc] [123] [!”#] 16 –
呼号 A to Z, 0 to 9, /, (space) 8 –

中继器列表

群组名称 [ABC] [abc] [123] [!”#] 16 –
名称 [ABC] [abc] [123] [!”#] 16 –

副段名称 [ABC] [abc] [123] [!”#] 8 –
呼号 A to Z, 0 to 9, /, (space) 8 –

网关信号 A to Z, 0 to 9, /, (space) 8 –

GPS发射模式

取消地址 [ABC] [abc] [123] [!”#] 56 通常为12个字符 
(API52,DSTAR*)

一般设置 [ABC] [abc] [123] [!”#] 43
根据数据扩展和高度设置，可以输
入的字符数不同。

项目名称/ 
I选项名称 [ABC] [abc] [123] [!”#] 9 –

GPS信息 [ABC] [abc] [123] [!”#] 20 –

GPS 存储
群组名称 [ABC] [abc] [123] [!”#] 16 –

名称 [ABC] [abc] [123] [!”#] 16 –
P-边界扫描 名称 [ABC] [abc] [123] [!”#] 16 –
编程链接 编程链接名称 [ABC] [abc] [123] [!”#] 16 –

CS界面

UR A to Z, 0 to 9, /, (space) 8 –
R1 A to Z, 0 to 9, /, (space) 8 –
R2 A to Z, 0 to 9, /, (space) 8 –

自己呼号 呼号 A to Z, 0 to 9, /, (space) 12 (+1) 在呼号和备忘录字段之间包
含“/”。

自己站点 发射信息 [ABC] [abc] [123] [!”#] 20 –
DTMF存储 DTMF编码 0 to 9, A, B, C, D, *, # 24 –

SD卡
保存设置 [ABC] [abc] [123] [!”#] 23 非法字符： / : ; * 

< >

输出 [ABC] [abc] [123] [!”#] 23 非法字符： / : ; * 
< >

蓝牙 设备名称 [ABC] [abc] [123] [!”#] 9 不包括 “ICOM BT”

DR 界面
直接输入(UR) A to Z, 0 to 9, /, (space) 8 –
直接输入(RPT) A to Z, 0 to 9, /, (space) 8 –

类别 项目 字符类型 最多字符数 参考信息

[AB]: A to Z, 0 - 9, (空格)
[ab]: a to z, 0 - 9, (空格)
[12]: 0 to 9, (空格)
[!”#]: ! " # $ % & ’ ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (空格)
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文本输入
示例: 输入“Calling”作为存储名称。

[MENU] > MEMORY > Memory CH
1. 按[MENU]。
2. 在菜单屏幕的第二页选择“MEMORY” 。
3. 选择“Memory CH”。
4. 选择要编辑的存储信道所在的信道群组。
5. 旋转[DIAL] 选择存储信道。

6. 按[QUICK]。
7. 选择“Edit”。

• 显示编辑屏幕。

8. 选择 “NAME”。

9. 按[QUICK]。
10. 选择字符类型。

 要输入符号，请选择“!"#.。

11. 旋转[DIAL] 选择字符, 然后按[ENT]。

 相关信息
• 要向右移动光标，请按下()。
• 要向左移动光标，请按D键()。
• 插入字符，请将光标移动到要输入的位置，然后旋转

[DIAL]。
• 要清除字符，请按[CLR]。
• 要连续清除字符，请连续按住[CLR]。
• 当字符类型为“ABC”或“ABC”时，在输入字符时，按

[QUICK] 选择大写或小写字母。�

12. 重复步骤9 ~ 11 输入名称，然后按[ENT]。

• 返回“编辑”屏幕，并显示输入的名称。

13. 选择“<<OverWrite>>”。

• 将显示确认对话框。

14. 选择“YES”。

• 存储名称被覆盖。
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第1部分
连接天线..................................................................................................1-2 
连接和拆卸电池 .......................................................................................1-2 
连接和拆卸背夹 .......................................................................................1-3 
连接手绳..................................................................................................1-3

连接附件
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连接和拆卸电池 

要连接或拆卸电池组或电池盒，请参见下图。电池盒
详情见第3-8页。
连接电池盒时，滑动电池盒并用力按压，直到用两
    个锁闩固定。
拆卸电池盒时，关闭对讲机。

.

提示: 
第三方高增益天线可以提高对讲机性能。可选的
AD-92SMA天线连接适配器，可转换天线接口为
BNC的，就可以使用BNC接口天线。 (p. 17-2)

注意:
.







电池或电池盒

安装 拆卸

天线

连接天线
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连接手绳

..








安装

.



背夹

电池或电池盒

拆卸

凸舌

手绳

连接和拆卸背夹



2-1

第2部分
存储在microSD卡上的数据..................................................................
将设置保存到microSD卡 .....................................................................

D 存储为一个新文件..........�������������������������������������������������������������������������
使用其他文件名保存.............................................................................
从microSD卡加载数据 .........................................................................
将microSD卡上的数据备份到PC上 .....................................................

D microSD卡的文件夹................................................................................
D 在电脑上制作备份文件 ...........�����������������������������������������������������............

导入或导出CSV格式文件 ....................................................................
D 导入 ����������������������������������������������������������������������������������������������������....
D 导出����������������������������������������������������������������������������������������������������.....

SD卡模式 ............................................................................................
检查microSD卡上的可用空间和录制时间.............................................

使用microSD 卡
.
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2 使用microSD 卡
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存储在microSD卡上的数据

以下数据可以保存到卡上:

•对讲机的设置
•通信/接收日志和内容
•在DV模式下自动应答语音音频
•语音传送功能的语音音频
•录制的音频
•屏幕截图
•存储信道内容
•调频广播存储数据�

•UR呼号存储
•中继器列表
•GPS存储
•GPS接收器的位置数据
•共享图片功能的图片
•发送和接收共享图片日志
•打开图片设置的图片

• 将设置保存到microSD卡

存储信道、菜单屏幕上的设置和中继器列表可以保存
在microSD卡上。

将数据保存在卡上，能够轻松地将对讲机恢复到以前
的配置，即使执行了全部重置。

可以将设置数据保存为新文件，也可以覆盖当前文
件。

D存为一个新文件

[MENU] > SET > SD Card > Save Setting
1. 按[MENU]。
2. 在“SET” 菜单选择“SD Card” 。

3. 选择 “Save Setting”。

4. 选择 “<<New File>>”。

5. 按 [ENT]。

.
6. 选择“YES” 。

.


.

.



提示:
•数据以“icf”文件格式保存。可以在PC上复制icf数据，并使
用CS-52编程软件对其进行编辑。

•如果“保存表单”设置为较早的固件版本，则在步骤4后显示
确认窗口。要在早期固件版本中保存数据，请选择“YES”。

文件名按以下方式自动命名：
Setyyyymmdd_xx（yyyy:年，mm:月，dd:日，xx:序列号）。
 如果要更改文件名，请参见第2-3页。
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使用其他文件名保存

[MENU] > SET > SD Card > Save Setting

3� 选择“Save Setting” 。

4� 选择 “<<New File>>” 。

5� 按住[CLEAR]删除输入错的字符。

6� 输入完成后按 [ENT]确认。

 详细参考页码iii。 
7. 选择“YES”。

1. 按[MENU]。
2. 在“SET” 菜单选择“SD Card” 。

• 保存时，将显示进度条。保存完成后，将显示SD卡屏
幕。

 按[MENU]，退出 MENU屏幕。
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从microSD卡加载数据

.


示例：加载设置数据 “Set20211101_01” 
[MENU] > SET > SD Card > Load Setting

5. 选择加载内容。

.










6� 选择“YES” 或者 “NO”。

••

••

.




7� 选择“YES” 。

.


8� 重新启动对讲机以使用新设置进行操作。

使用microSD 卡

保存的存储信道，菜单界面上的项目设置和中继器列
表，都可以复制到另一部对讲机上.

此功能在与其他ID-52A/ID-52E对讲机共享数据时非
常方便。

3� 选择“Load Setting” 。

4. 选择要加载到对讲机中的数据文件。

1. 按[MENU]。
2. 在“SET” 菜单选择“SD Card” 。
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将microSD卡上的数据备份到PC上

ID-52 Capture

Csv MemoryCh

GpsMemory

RptList

Picture

Voice yyyymmdd

yyyymmdd

VoiceTx

QsoLog

Reply

RxLog

Setting

Private Rx

Tx

OpeningPicture

RadioMemory

YourMemoryGps

yyyymmdd

yyyymmdd

VoiceRec

.









.



























































使用microSD 卡

备份文件还原，防止microSD卡上的数据被意外删
除或损坏。

D microSD卡的文件夹

microSD卡中包含的文件夹如下：
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将microSD卡上的数据备份到PC上

    D 在电脑上制作备份文件
           基于Windows® 10 

1. 将microSD卡插入电脑上的microSD卡驱动器
或读卡器中。

2. 点击 “Open folder to view files(打开文件夹以
查看文件)” 选项访问卡。

点击

.
3. 右键单击 “Removable disk”(可移动磁盘)。
4. 单击 “Copy(复制)” 。

5. 打开文件夹以复制备份文件，然后右键单击，
然后单击“Paste(粘贴)”

• 将卡数据复制到电脑上。
(示例:  复制到C盘“Backup(备份)”文件夹”。 

6. 要移除卡，请单击任务栏中的移除媒体图标
(“ ” （如下图所示）。然后单击“Eject
Removable Disk(弹出可移动磁盘)” 。

7. 当显示 “Safe To Remove Hardware(安全移除硬件)” ,
可移除卡

右键单击

单击

使用microSD 卡

点击

点击

提示
当“USB Connect(USB连接设)"设置为"SD Card Mode(SD
卡模式)”并且对讲机通过USB数据线连接到PC时，可以从
PC直接访问对讲机中设置的microSD卡。
([MENU] > SET > Function > USB Connect)
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•存储信道
•调频广播存储信道
•呼号
•中继器列表
•GPS存储信道�

D导入
注意:

.







.

[MENU] > SET > SD Card > Import/Export > Import

1. 按[MENU]。
2. 在“SET” 菜单选择 “SD Card” 。

3. 选择 “Import/Export”。

4. 选择“Import” 。

5. 选择“Your Call Sign”。

6. 选择要导入的CSV文件。

.

.



7. 选择 “YES” 。

.


.

使用microSD 卡

导入或导出CSV格式文件
可以从microSD卡导入或导出逗号分隔符(CSV)格
式文件。可以分别导入或导出以下数据：
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.





[MENU] > SET > SD Card > Import/Export > Export

6� 选择 “<<New File>>” 。

 文件名按以下方式自动命名Mch*yyyymmdd_xx 
(yyyy: 年, mm: 月, dd: 日, xx:序列号)

* 选择其他项目时，每个文件的名称如下所示。

	 “Mch” 
FM Radio Memory(调频广播存储): “Radio” 
	 “Rpt” 
	 “Gps” 

 有关如何输入字符，请参见第iii页。
7. 按 [ENT]。

.
8. 选择 “YES” 。

.


覆盖当前文件：
覆盖当前文件中的数据时，请在步骤6中选择要覆盖
的文件。

使用microSD 卡

1. 按[MENU]。
2. 在“SET” 菜单选择 “SD Card” 。

3. 选择 “Import/Export”。

4. 选择“Export” 。

5. 选择“Your Call Sign”。

• 显示 FILE NAME (文件名)屏幕
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SD卡模式

.



[MENU] > SET > Function > USB Connect
1. 使用USB电缆将对讲机连接到PC。
2. 按[MENU]。
3. 在“SET” 菜单选择 “Function” 。
4. 选择“USB Connect(USB连接)”。�

5. 选择“SD Card Mode” 。

.
6. 选择 “Yes” 。

注意: 使用USB电缆将处于SD卡模式的对讲机连接
到PC之前，必须插入microSD卡。
 如果未插入microSD卡，请在对讲机关闭的情况下将其

 插入，然后重新连接USB电缆。 

提示: 在SD卡模式下，对讲机不是用作收发，而是
用作数据存储设备。它暂时停止一些功能，如下所
示：
•停止录制
•暂停GPS记录功能和RX历史记录功能
•断开蓝牙设备的连接
•禁用自动关机功能

退出SD卡模式
 基于 Windows 10。
1. 点击 “  ” ,在任务托盘中。
2. 点击 “Eject Device(弹出设备)”。
3. 显示“Safe to Remove Hardware(安全移除硬

件)”后，从电脑上移除USB电缆。

使用microSD 卡
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检查microSD卡上的可用空间和录制时间

[MENU] > SET > SD Card > SD Card Info
1. 按 [MENU]。
2. 在“SET” 菜单选择  “SD Card” 。
3. 选择 “SD Card Info” 。

使用microSD 卡

• 此时会显示microSD卡上的可用空间和录制时间。
按 [MENU]退出菜单。
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电池信息

D 电池寿命
根据以下假设计算出如下所示的近似电池寿命
（工作时间）：
• 省电设置: Auto (Short)
• 占空比：TX:RX：待机= 1 : 1 : 8

近似电池寿命:

电池 FM 模式
BP-271 4.25 小时
BP-272 7.25小时
BP-307 12 小时

 有关可选的BP-273电池盒电池寿命，请参见第3-8页。 

注意: 
请确保在购买约五年后，即使电池仍能充电，也需购
买新电池更换之前的电池。电池即使很少使用的情况
下，内部材料在一段时间后会变弱。
电池充电的次数在300到500次之间。当出现以下情况
时，即使电池看起来充满电，对讲机的工作时间也可
能变短：

.


.


.


图标 电池状态

.

.

.

(绿)
.

(红)

电池几乎耗尽。 
 立即给电池充电。否则，图标将很快开

 始闪烁，显示“LOW BATTERY”（电池
 电量不足），对讲机将自动关闭。

无图标

当连接外部直流电源（12 V DC）时，
电池未充电，因为：
•电池已完全充电。
•“Charging (Power ON)充电（电源开启）”设
    置为“OFF(关闭)”

 BP-273的电池图标不能显示碱性电池的容量。电池图标始
     终显示“          ”，它不会反映真实的电池容量。 

显示正确的电池状态
在以下项目中选择需要连接的电池。 (默认: BP-271/
BP-272)
([MENU] > SET > Function > Battery Pack Select)
要在每次连接电池时显示“电池选择”对话框，请将以下项
目设置为“ON”。
([MENU] > SET > Function > Battery Pack Confirmation)

(基于操作风格)
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充电信息

注意:
.





 充电时，显示充电图标"           ", 和 .
 充电完成，充电图标和 “Charging....” 消失。 

D 通过[DC IN]插孔充电
根据以下假设，计算出如下所示的近似电池寿命
（工作时间）：
.






充电时长(约)
• BP-271: 3 小时
• BP-272: 5 小时
• BP-307: 8 小时

 到AC交流插座

自动关机*2

到 [DC IN]

BC-167S*1

到点烟器插座 
(12 V DC)

到12V直流电
源

CP-12L

OPC-254L

黑:		
白:	

.


为电池充电:
• 使用提供的电池充电器或可选适配器。
• 使用USB电缆（用户自备）。（第3-4页）
• 使用可选快速充电器。（第3-6页）

充电注意
.
•
• 
.



电池充电
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充电信息

D 使用USB电缆充电
操作对讲机时，可以使用USB电缆（micro B型）为电池充电。

�
.




















提示:
• 连接USB电缆后，电池充满电时停止充电。
之后，当连接USB电缆消耗了一定容量时，充电将恢
复。

• 当对讲机通过USB电缆连接到PC时，可以更改操作。
([MENU] > SET > Function > USB Connect)

USB 电缆

到USB端口

电源适配器或外部
电池（用户提供）

到[USB]端口

PC,
移动设备

电池充电
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使用BC-202IP2可选快速充电器充电

可选BC-202IP2可快速为电池充电。
当大约90%的电池容量充电时，BC-202IP2停止充电，充
     电指示灯亮起绿色。因此，电池寿命将比使用对讲机充电
     时稍短。

 这是电池耗尽充电的时间，并且在关闭对讲机的情况下
充电。

.
• BC-123S (L型插头）
（根据充电器型号，提供不同类型的电源适配器或
不提供电源适配器。）

充电注意事项：
R  危险！切勿使用未经Icom制造或批准的电池。 
.

















对讲机+ 电池

电池
BP-271, BP-272,或 BP-307

AC 插座

选项

导轨 

.



充电指示
.



BC-202IP2

.






关机

电池充电

充电时长(约)
• BP-271: 1.5 小时
• BP-272: 2.5 小时
• BP-307: 4 小时
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使用BC-202IP3L可选快速充电器充电

对讲机 + 电池

AC插座

要将电源适配器连接到充电器，请卸下充电器的左盖。 

BC-202IP3L

电池 BP-271, 
BP-272, 或 BP-307

BC-123S
(直接插头)

充电指示灯

关机

 也可以使用CP-25H
    代替电源适配器。 

电池充电

可选BC-202IP3L可快速为电池充电。
当大约90%的电池容量充电时，BC-202IP3L停止充电,  充
     电指示灯亮起绿色。因此，电池寿命将比使用对讲机充电
     时稍短。

 这是电池耗尽充电的时间，并且在关闭对讲机的情况下
充电。

 以下是随机配件
• BC-123S (直接插头）
（根据充电器型号，提供不同类型的电源适配器或
不提供电源适配器。）�

充电时长(约)
• BP-271: 2 小时
• BP-272: 3 小时
• BP-307: 5 小时

充电注意事项：
R  危险！切勿使用未经Icom制造或批准的电池。 
• 不要将任何注意：将对讲机连接到快速充电器时，
东西连接到对讲机侧面的[DC IN]插孔或[USB]端

•

口。这可能会导致充电器故障。如果充电指示灯呈
橙色闪烁，请断开电源适配器与充电器的连接，然
后重新连接。
务必关闭对讲机。当对讲机电源因电池耗尽而无法
关闭时，将电池从对讲机上拆下。然后自行给电池
充电。

• BC-202IP3L快速充电器只能为BP-271、BP-272或
BP-307锂离子电池充电。其他类型的可充电电池，

•
镍镉或镍氢不能充电。
如果充电指示灯呈橙色闪烁，则电池或充电器可能
有问题。如果新电池充电有问题，请联系您的经销
商。
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_

外部直流电源操作

操作说明
•

• 

.





• 

• 

• 

• 

.









.


提示: 
当“Charging(Power ON)(充电(电源打开)”设置为“ON”
(默认)时，即使对讲机打开，电池也可以充电。
此操作可能会产生某些杂散信号，并且可能会出现S
表显示，或者可能会听到噪声。
当在充电时操作对讲机，如果无法正确接收信号，请
设置“Charging(Power ON)(充电(电源打开)”设置
为“OFF”
([MENU] > SET > Function > Charging (Power ON))

CP-12L

OPC-254L

至点烟器插座 
(12 V DC)

到12V DC 电源到[DC IN]

.

 BC-167S不能用于外部直流电源操作。 

		
白: 	

将BC-202IP3L连接在一起

可以将6个BC-202IP3L连接到一起。
1.取下充电器的右盖。(1)
2�将直流电源插头插到另一个充电器的直流电源插座

上。 (2)

.






2

1

电池充电
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可选电池盒

BP-273使用三节AA(LR6)(国内5号)碱性干电池。
1.拆下电池盒顶部，如下图所示。
2.安装三节AA(LR6)(国内5号)型碱性电池。
仅安装碱性电池。
务必遵守正确的极性。
3.连接电池盒。（第1-2页）

电池注意事项
.















提示:
.










D电池寿命
大致电池寿命(工作时间)如下所示，根据以下假
设计算得出：
• 省电设置: Auto (Short)
• 值守:  TX : RX : 待机 = 1 : 1 : 8

(基于操作风格)

近似电池寿命
FM 模式

4.5 小时

 电池寿命可能会有所不同，具体取决于您的操作风格或
      安装的碱性电池 

D电池更换
当碱性电池几乎耗尽时，显示“LOW BATTERY”(低电
量)，电池图标开始闪烁。10秒后，对讲机电源自动关
闭。在这种情况下，请更换新的碱性电池使用。

 BP-273的电池图标不能显示碱性电池的容量。电池图标
       始终显示“           ”，它不会反映真实的电池容量。

BP-273 碱性电池

电池充电
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充电器和电池组规定

D BP-271 锂电池 (选件)
• 电压:
• 容量:

7.4V
1150 mAh (最小)
–20°C ~ +60°C
0°C ~ 40°C
–20°C ~ +50°C(1个月内)

• 可用温度范围:
• 充电温度范围:
• 储存温度范围:

•尺寸:

–20°C ~ +35°C(3个月内)
–20°C ~ +20°C, (1年内)
 58 (W) × 86.9 (H) × 9.1 (D) mm) (不含凸出部分)

D BP-272锂电池 (随机)

D BP-307锂电池 (选件)

D BC-202IP2 快速充电器(选件)
12 V ~ 16 V DC或指定的Icom电源适配器
0°C ~ 40°C
约105 g, 3.7 oz (不含适配器)
88.0 (W) × 47.5 (H) × 72.5 (D) mm (不含凸出部分)

D BC-202IP3L快速充电器(选件)

电池充电

• 电压:
• 容量:

7.4V
1880 mAh (最小)
–20°C ~ +60°C
0°C ~ 40°C
–20°C ~ +50°C(1个月内)

• 可用温度范围:
• 充电温度范围:
• 储存温度范围:

•尺寸:

–20°C ~ +35°C(3个月内)
–20°C ~ +20°C, (1年内)
 58 (W) × 86.9 (H) × 14.2 (D) mm) (不含凸出部分)

• 电压:
• 容量:

7.4V
3050 mAh (最小)
–20°C ~ +60°C
0°C ~ 40°C
–20°C ~ +60°C(1个月内)

• 可用温度范围:
• 充电温度范围:
• 储存温度范围:

•尺寸:

0°C ~ 40°C(3个月内)
–20°C ~ +50°C, (1年内)
 58 (W) × 86.9 (H) × 22.4(D) mm) (不含凸出部分)

• 电源:
• 温度:
• 重量:
• 尺寸:�

12 V ~ 15V DC或指定的Icom电源适配
器10°C ~ 40°C
约120 g, 3.7 oz (不含适配器)

 106.5 (W) × 52.5 (H) × 78.0 (D) mm(不含凸出部分)

• 电源:
• 温度:
• 重量:
• 尺寸:�
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4 调频广播操作

4-2

.









.



调频广播的频率范围
FM: 76.0 MHz* -108.0 MHz
* 可用频率范围有可能不同，具体取决于对讲机版本。

基本操作

D 打开调频广播
1� 按[QUICK]。
2� 选择“<<FM Radio ON>>”。

.
 

.

.






.

 再次打开调频广播，按[QUICK]选择“<<FM Radio>>”

注意:如果在使用Dualwatch(双重值守)功能时，打开
Band Scope(频段范围)，调频广播的音频输出，可能
会因 AF Output (DUAL/AIR Band)功能中断。
在这种情况下，将“Auto Mute(自动静音)”设置为
OFF，或将“AF Output (DUAL/AIR Band)设置为
OFF。
 当“AF Output (DUAL/AIR Band)” 设置为ON时，

在扫描过程中会立即听到接收到的音频，在不看显示器
的情况下接收到信号。
([MENU] > FM RADIO > FM Radio Set > Auto Mute) 
([MENU] > SET > Scope > AF Output (DUAL/AIR Band))



4

4-3

基本操作

D 选择调频广播模式

1. 当显示FM RADIO窗口时，按下[MR]，在
Tuning(调谐)和Memory(存储)模式之间进行选择。

2. 旋转[DIAL]以选择频率或存储信道。

.






D选择存储群组模式 
在存储群组，每组最多可分配50个调频广播存储信
道，以便于管理。

如果更改群组，则可以选择其他群组信道。

1. 按 [MR] 选择存储模式。

• “ ” 显示所选信道 。

2. 按[QUICK]。
3. 选择 “Group Select” 。

4. 选择需要的群组。

.

.

.



调谐模式

存储模式

.





调频广播操作
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.



D使用衰减器功能
当非常强的FM无线电信号接近频率时，或者当非常
强电场(例如来自广播电台的信号)靠近对讲机位置
时，衰减器可防止所需信号失真。

1. 按[QUICK]。
2. 选择“ATT ” 。

3. 选择 “ON”。

.

.

.

收到信号时

.





调频广播操作

基本操作
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.








自动静噪 最大静噪电平

 相关信息
• 选项:  “OPEN ”， “AUTO” (默认), 和 “LEVEL 1” ~
• “LEVEL 1” 低等级(针对弱信号), “LEVEL 3”高等级 (针对强
信号)。

• “AUTO”是使用噪声脉冲计数系统的自动电平调整。
• “OPEN” 静噪打开。

“LEVEL 3”。

.





.

.

提示：
可以在菜单屏幕上设置监听保持功能。每次按下
[SQL]时，对讲机都会打开或关闭静噪。
([MENU] > SET > Function > Monitor)

调频广播操作

基本操作
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调频广播存储

.








.



D 添加调频广播信道

步骤1 ：添加调频广播信道并进入编辑模式 。

[MENU] > FM RADIO > FM Radio Memory
1� 按[MENU]。
2. 在 “FM RADIO” 菜单，选择 “FM Radio Memory” 。

3� 选择群组。

 如果没有存储，则显示“-- Blank --” 
4.按下[QUICK]。
5.选择 “Add” 。

.

.



调频广播操作
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1� 选择 “NAME”。

2� 输入名称。

.


.


步骤3：输入频率。

1. 选择“FREQUENCY”。

2. 旋转[DIAL] 设置频率。

 按D-pad()移动光标。
 根据对讲机的版本，可用频率范围有所不同。 

.

步骤4： 选择跳过设置。
1. 选择 “SKIP        ”。

2. 选择 “OFF” 或 “SKIP  ”。 

• OFF:     可以在存储模式下选择信道
• SKIP:  在存储模式下，不显示信道 

步骤5：存储调频广播信道
1. 选择 “<<Add Write>> ” 。

2. 选择 “YES ” 。

.


提示: 如何取消输入的数据：
1. 按[CLR]。
2. 选择“YES”。 

.

D 添加调频广播信道

步骤2：输入调频收音机存储器名称。

调频广播操作

调频广播存储
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[MENU] > FM RADIO > FM Radio Memory
1� 按[MENU]。
2. 在“FM RADIO” 菜单选择“FM Radio Memory” 。

3� 选择包含要编辑的存储群组。

4� 选择存储信道进行编辑。

 不要按 [ENT]。
5� 按 [QUICK]。
6� 选择 “Edit ” 。

.
.

8. 编辑完成，选择 “<<Overwrite>>” 。

9. 选择 “YES ” 。

.

调频广播存储

D 编辑调频广播信道
此功能可编辑调频接收广播存储内容。当已输入的数
据不正确、已更改或应将新数据添加到列表中时，此
项非常有用。

调频广播操作
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.


.

[MENU] > FM RADIO > FM Radio Memory

3. 选择需要删除信道所在的群组。

4. 选择要删除的信道 。

7� 选择 “YES” 。

.

调频广播操作

调频广播存储

1� 按[MENU]。
2. 在“FM RADIO” 菜单选择“FM Radio Memory” 。

 不要按 [ENT]。
5� 按 [QUICK]。
6� 选择 “Delete ” 。
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D 调频广播信道重新排序 
.


[MENU] > FM RADIO > FM Radio Memory
7. 选择一个存储位置，插入到其上方位置。

.

 如选择“<<Move End>>”， 则信道将移动到群组的
     底部。

调频广播操作

调频广播存储

4. 选择要移动的信道。

 不要按 [ENT]。
5� 按 [QUICK]。
6� 选择 “Move ” 。

3. 选择需要移动信道所在的群组。

1� 按[MENU]。
2. 在“FM RADIO” 菜单选择“FM Radio Memory” 。
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D 调频广播信道跳过设置 
.


[MENU] > FM RADIO > FM Radio Memory
1. 按[MENU]。
2. 选择“FM RADIO ”
3. 选择“FM Radio Memory”。

4. 选择跳过的信道的群组 。

5. 选择跳过信道。

.

7. 选择“SKIP ” 。

• “SKIP” 显示在所选信道上 。
 按[QUICK]，然后再次选择“ skip”，取消跳过设置。 

.


调频广播操作

调频广播存储

 不要按 [ENT]。
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使用调频广播模式

对讲机具有专用调频广播模式，即只有调频广播
才能工作的模式，其他模式都不能工作。

1. 按[QUICK]。
2. 选择“<<FM Radio Mode>>”。

.

提示：要取消调频广播模式 
1. 按[QUICK]。
2. 选择 “<<Normal Mode>>”。

 在专用调频广播模式下，其他模式处于休眠状态。
     要以正常方式操作对讲机，请取消调频广播模式。 

调频广播操作



4

4-13

调频广播选项

FM Radio Memory(调频广播信道)

[MENU] > FM RADIO > FM Radio Memory
共有26个群组，可用于调频广播存储。
每组最多可分配50个信道，便于管理信道。(调频广播
信道最多有500个。)

FM Radio memory contents(调频广播信道内容)

NAME
调频广播信道的名称。
 每个信道最多16个字符的进行命名。 

GROUP 群组字母号和群组名称

FREQUENCY
输入频率
 频率范围有可能不同，具体取决于
对讲机的版本。 

SKIP
显示跳过状态
 跳过信道不会在存储模式下显示。 

� (默认: 2sec)

[MENU] > FM RADIO > FM Radio Set > Auto Mute
选择在接收A或B频段的信号时，是否将背景中的调频
广播音频静音*。
 无论此设置如何，调频广播音频在发射信号时都会静音。
* 有关详细信息，请参见第4-2页的“在监听A/B频段的同时，

收听调频广播”。
• OFF: .




• 0 to 10sec:   当广播在A或B频段进行发送或接收时，调频
广播音频会自动静音。发送或接收后，自动静
音计时器启动。定时器结束后，可以再次收听
调频广播。
 当频谱扫描过程中接收到信号时，调频广播
      音频将静音。

� (默认: Not Used)

[MENU] > FM RADIO > FM Radio Set > 
Earphone Antenna

.
.
• Use: .

� (默认: ON)

[MENU] > FM RADIO > FM Radio Set > 
Power Save (FM Radio)

.

• OFF: 关闭节电功能。
• ON:   .




.


<<FM Radio ON>>(打开调频广播)

[MENU] > FM RADIO > <<FM Radio ON>>
打开调频广播。
当对讲机主频段和副频段接收时，仍然可以收听调频广
播。 当调频广播打开时，调频广播屏幕上将显示<FM 
Radio OFF>>。要关闭调频广播，请选择<<FM Radio 
OFF>>.
 也可以在快捷界面，选择<<FM Radio OFF>> 关闭广播。

<<FM Radio Mode>>(调频广播模式)

[MENU] > FM RADIO > <<FM Radio Mode>>
对讲机进入专用调频广播模式，只有调频广播才能工
作。
在调频广播模式下，<<Normal Mode>>将显示在调
频广播屏幕上。要退出调频广播模式，请选择
<Normal Mode>>。
 也可以在快捷界面，选择 <<Normal Mode>> 退出调频
       广播模式。

调频广播操作
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“FROM” (接入中继器) 设置.���������������������............�����������������������������������
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D 输入发送信息 ���������������������������������������������������������������...............�������������
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数据通讯 ...............................................................................................
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数字静噪功能 .......................................................................................

D 数字呼号静噪设置 �������������������������������������������������������.............................
D 数字代码静噪设置 �������������������������������������������������������������.......................

中继列表 ..............................................................................................
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您的设置正确吗?...................................................................................
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重要信息!
•本手册中描述的中继器列表可能与对讲机的预加载内容不同。

•尽管在设置示例中使用了日本中继器，但日本中继器节点(端口)字母与其他国家的不同。
  请务必根据下面显示的频带，在呼号的第8位添加中继器节点字母。
  1200 MHz: A (B在日本)
  430 MHz: B (A在日本)
  144 MHz: C (日本没有中继器) 

.







对于本地呼叫或网关呼叫：
1.设置接入中继器的频率。（第11-2页）
2.设置双工方向和频率偏移。（第11-4页）
3.设置呼号（UR/R1/R2）。（第12-8页）

对单工调用：
1.设置工作频率。
2.设置呼号（UR/R1/R2）。（第12-8页）

使用D-STAR中继器（DR）功能以外的功能开始数字模式通信

5-27
5-27
5-27

5-28
5-28
5-29
5-29
5-29
5-30
5-30
5-31
5-31
5-32
5-36
5-36
5-36
5-37
5-38
5-39
5-40
5-41
5-41
5-42
5-43
5-44

第5部分



5 D-STAR 操作 (高级版)

5-3

.



.


 旋转[DIAL]时
显示

.



•当知道接入中继器时

.
















•当不知道可以访问哪些中继器时

扫描选项

.


•当“FROM”数据保存在发送历史记录中时。
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“FROM” (接入中继器) 设置

1. 按住[DR] 1秒钟显示 DR 屏幕。
2. 按D-pad() 选择“FROM” ，然后按[ENT]。

3. 选择“Repeater List ” 。

4. 在中继器列表中选择群组。

提示:
当您选择调频中继器时：
当调频中继器在对讲机中继器列表中时，您可以从
列表中选择它。
选择调频中继器时，不需要“TO”设置，“TO”中会显
示“–––”。

.

如何更改中继器组：
要更改DR屏幕上的中继器组，请按[QUICK]，然
后选择 “Group Select ”。

5. 选择接入中继器。

• 返回DR屏幕，所选中继器名称显示在“FROM”中。

 本手册中描述的中继器列表可能与对讲机的预存内容不同。 

D 使用对讲机的中继器列表
当您的接入中继器在对讲机的中继器列表中时，您可以
从列表中选择它。只需从列表中选择中继器，中继器呼
号、频率、双工设置和频率偏移都会自动设置，便于操
作。
示例:  从中继器列表中选择美国华盛顿州的“Kirkland 
(IA)” 中继器。

D-STAR 操作 (高级版)
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([MENU] > MEMORY > Repeater List)

附近中继器扫描。
附近中继器扫描通过使用您的位置和中继器输入的位置
数据，在160公里内搜索最多20个附近的中继器，然后
列出中继器。
 即使关闭对讲机，然后在扫描过程中再次打开，近中继器
                 扫描仍会继续。
 如果没有从GPS卫星接收到您自己的位置数据，则使用最

      后接收到的位置数据。 

.





.


示例: 使用DR扫描选择启动的中继器。
1. 按住[DR] 1秒钟选择DR屏幕。
2. 按住[SCAN]1秒钟。

.

.
.















 扫描恢复与其他扫描相同。 (p� 12-5)

.

4. 当对讲机接收到来自中继器的信号时，扫描停止。
按下[SCAN]。

• DR扫描被取消，中继器被设置为“FROM”

DR扫描功能可以在中继器或单工频率上搜索频率，
以找到信号。
您可以使用两种DR扫描，正常扫描和附近中继器扫
描。

正常扫描
要快速查找中继器，正常扫描会跳过未设置接入中继
器的中继台。
 将中继器列表上的“USE(FROM)”设置(第5-33页)设置
    为“NO”。

D-STAR 操作 (高级版)

“FROM” (接入中继器) 设置

D 使用DR扫描
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注意:
.









示例:  从附近中继器列表中选择一个近中继器。
步骤1:  从GPS卫星接收自己的位置。

.

→  → →

 接收可能只需要几秒钟，也可能需要几分钟，具体取决于您
   的操作环境。如果您在接收时遇到困难，我们建议您更换其 
   他地点。 

如果没有收到自己的位置，则最后收到的位置将用于当前
    您的位置。 

步骤 2:  从附近中继器列表中选择接入中继器

1. 按住DR] 1秒钟，显示 DR 屏幕。
2. 按住D-pad()选择“FROM” ，然后按[ENT]。

3� 选择 “Near Repeater ” 。

4. 选择要显示的附近中继器的类型。

5� 考虑到您所在位置到中继器的距离，选择要用
作接入中继器的中继器。

.



从您所在的位置到中继器的
距离和方向*

*   当中继器列表上的“POSITION(位置)"(第5-34页)设置
  为“Approximate(近似)”时，到中继器的距离小于5公
  里，则不显示方向数据。

• 返回DR屏幕，所选中继器设置为 “FROM”。

D 使用附近中继器搜索功能
对讲机使用您的位置和中继器输入的位置数据搜索最近的中
继器。
对讲机中继器列表中最近的中继器显示为可选选项。

D-STAR 操作 (高级版)

“FROM” (接入中继器) 设置

• 接收时，GPS图标闪烁。

• 当正确接收到当前位置时，将显示GPS图标。 

• 附近中继扫描(ALL):
搜索最多20个附近的DV或FM中继器。(共40个中继
器）

• 附近中继扫描(DV):
搜索最多20个附近的DV中继器。

• 附近中继扫描(FM):
搜索最多20个附近的FM中继器。
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3. 选择“TX History ”。

4. 选择 TX History (DV)或TX History (FM)。

• TX History (DV): 显示DV中继器的发送历史记录。
• TX History (FM): 显示FM中继器的发送历史记录。

5� 选择中继器以将其用作接入中继器。

• 返回DR屏幕，所选中继器设置为“FROM”

.



D 使用TX历史记录
TX 历史记录最多可保存10次最新访问(From) 中继
器。可以从TX 历史记录中选择一个中继器作为您的接
入中继器。
示例:  从TX 历史记录中选择“Hirano”中继器。

1. 按住 [DR] 1秒钟选择 DR 屏幕。
2. 按D-pad() 选择“FROM” ，然后按[ENT]。

D-STAR 操作 (高级版)

“FROM” (接入中继器) 设置
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“TO” (目的地)设置

.



提示: 如何更改中继器组: 
当选择 “Local CQ”或“Gateway CQ” (“本地
CQ”或“网关CQ”)时，可以更改中继器组。
要更改DR屏幕上的中继器组，请按
[QUICK]，然后选择“Group Select(组选
择)” 。

D-STAR 操作 (高级版)

提示：
在接收到单个电台或中继器的信号后，可以通过按
住呼号捕获键([RX→CS])，快速进行回复呼叫。

通过旋转[DIAL]:
在DR界面上，旋转[DIAL]选择中继器或呼号。(当
设置了“CQCQCQ”时，此操作被禁用。)

本地CQ呼叫:
在“TO” (目的地)中设置“CQCQCQ” 。(p. 5-9)

网关CQ呼叫
网关呼叫，请从中继列表中选择中继器。(p. 5-9)

特定站点呼叫
请在呼号中选择站点呼号。(p. 5-10)

要通过反射器进行呼叫:                            
选择连接呼叫的中继器的反射器。(p. 5-14)

要从RX历史记录中选择:
当接到呼叫时，主叫站数据将保存在RX历史记录
中。可以从记录中选择目的地。(p. 5-10)

从TX历史记录中选择:
当呼叫时，目的地中继器或被叫站数据将保存在
发送历史记录中。可以从记录中选择目的地。(p. 
5-11)

要直接输入目的站呼号:
直接输入目的站的呼号。(p. 5-11)

要直接输入目的地中继器呼号:
直接输入目的地中继器的呼号。(p. 5-12)
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“TO”(目的地)设置

D制定“Local CQ” (本地呼叫)
当在TO SELECT屏幕上选择“Local CQ”（本地CQ）
时，“CQCQCQ”设置为“TO”。

示例: 通过访问“Kirkland(IA)”中继器进行本地呼叫。

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。

3. 选择 “Local CQ.”

• 返回DR屏幕，“TO”中显示“CQCQCQ”。 

D制定“Gateway CQ” (网关呼叫)
当在TO SELECT屏幕上选择“Gateway CQ”（网关
CQ）时，可以选择中继器进行网关呼叫。

示例: 从“Kirkland (IA)”中继器向“Hirano”中继器进行网
关CQ呼叫。 

3� 选择“Gateway CQ”。

4� 选择列出目的中继器的中继器组。

5� 选择目的中继器。

 每个中继器都有一个正确的节点(A、B或C频段)，
     看您希望在那个上进行传输。有关频段字母的详
       细信息，请参阅第5-2页“重要事项”。 
• 返回DR屏幕，所选中继器名称显示在“TO”中。

.



D-STAR 操作 (高级版)

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。
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.



示例:  从 “Your Call Sign”选择“Rick” 。 

3. 选择 “Your Call Sign” 。

4. 选择目的地名称或呼号。

• 返回DR屏幕，所选名称显示在“TO”中。

.



D 使用 RX历史记录
当在DV模式下接收到呼叫时，呼叫数据将保存在RX历
史记录中。
最多可以保存50个呼叫者，并且只存最后一次呼叫的
呼号，总共可以保存51个历史记录。

3. 选择“RX History” 。

4. 选择目的地名称或呼号。

  “*”(星号)显示在被叫电台呼号的开头。(第5-19页) 

提示: 
要将RX历史数据添加到 “Your Call Sign” 存储器，
请按[QUICK]，然后选择 “Add To Your Memory”。

D-STAR 操作 (高级版)

“TO”(目的地)设置

D 使用“Your Call Sign”
“Your Call Sign”（您的呼号）存储器可保存单个呼号
或中继站呼号。当您为“TO”（目的地）设置选择呼号
时，您可以拨打网关呼叫。当您通过网关呼叫单个电
台时，信号会自动发送到该电台访问的最后一个中继
器。因此，即使您不知道单个电台的位置，也可以呼
叫。

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。

示例:  从RX历史记录中选择“Rick” 。 
1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。

• 返回DR屏幕，所选名称显示在“TO”中。
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.




.


3. 选择 “TX History ” 。

4. 选择目的中继器。

.


• 返回DR屏幕，所选中继器名称显示在“TO”中。

D 直接输入(UR)
可以直接输入目的站呼号。

3. 选择“Direct Input (UR)”。

4. 输入最多8个字符的呼号，包括空格。

 详见第 iii 页，字符输入。
5. 输入后, 按[ENT]。

• 返回DR屏幕，输入的呼号显示在“TO”中。

输入后，可以在DIRECT INPUT(UR)屏幕中编辑呼号。
输入的呼号将保留在DIRECT INPUT (UR)屏幕上，
  直到您输入新的呼号。 

提示:如果输入的呼号在“Your Call Sign”存储器中重
复，则会显示名称。
（仅限已输入名称时。）

.



D-STAR 操作 (高级版)

“TO”(目的地)设置

示例:  从TX历史记录中选择“Kirkland (IA)” 。 

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。

示例:  直接输入呼号“JM1ZLK” 。 

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。
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.



3� 选择 “Direct Input (RPT)” 。

4� 输入最多8个字符的呼号，包括空格。

• 返回DR屏幕，“TO”中显示“JP3YDH A。
 输入后，您可以在DIRECT INPUT (RPT)屏幕中编辑
      呼号。
 输入的呼号将保留在DIRECT INPUT (RPT)屏幕上，
      直到您输入新的呼号。 

提示:
.




D-STAR 操作 (高级版)

“TO”(目的地)设置

D 直接输入(RPT)
可以直接输入目的地中继器呼号。

示例:  直接输入“P3YDH A” 。 

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。

 详见第 iii 页，字符输入。
5. 输入后, 按[ENT]。
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REPEATER DETAIL(中继器详细信息) 界面

根据内容，如位置数据或UTC偏移，您的位置和中继
器之间的距离，或中继器时间可以显示在REPEATER 
DETAIL(中继详细信息)屏幕上。
也可以从FROM SELECT屏幕进入详细信息屏幕。

3. 选择 “Gateway CQ ” 。

4. 选择“13: Japan”。

.


6. 按[QUICK]。
7. 选择 “Detail ” 。

.
.

* 当中继器列表上的“POSITION(位置)”设置(第5-34页)设置
为“Approximate(近似)”时，如果到中继器的距离小于5公
里，则不显示方向数据。

 如果没有位置数据，则不会显示与您所在位置的距离和方向。
     请参阅第6-3页以确认您的立场。 
 选择调频中继器时，将显示“FM”或“FM-N”以及音调设置。 

提示: 当显示DR屏幕时，您可以显示REPEATER 
DETAIL屏幕。
如下图所示设置中继器时，按下[QUICK]，然后选
择“Repeater Detail(中继器详细信息)”。

.

与您所在位置
的距离 

REPEATER DETAIL(中继器详细信息) 界面

副名
呼号 

群组号

您的方向指示 

中继时间

中继频率

双工设置 

中继名称
中继类型

D-STAR 操作 (高级版)

示例:  显示“Hirano/Icom”中继器详细信息屏幕 。 

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。
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.







.

3� 选择“Reflector” 。

.

4. 选择“Unlink Reflector ”。

.
.

D-STAR 操作 (高级版)

CAN

AUS

USA
UK

D-STAR 反射器系统

反射器

接入中继

D 取消反射器链接
在链接另一个反射器之前，请取消当前中继器的反
射器链接。

1. 按住[DR] 1秒钟显示DR屏幕。
2. 按住D-pad()选择“TO” ，然后按[ENT]。

• 返回DR界面，在 “TO”中显示“Unlink Reflector”和“U”。

注意：
如果反射器已经连接，请先询问是否可以更换反射器
并等待响应。当结束谈话时，一定要重新连接到同一
个反射器。
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2. 选择 “Reflector ”。

3. 选择“Link to Reflector ” 。

4. 选择 “Direct Input ” 。

5. 按D-pad移动光标, 旋转[DIAL] 选择反射器类型、
反射器编号或模块字母。

6. 按 [ENT]。

• 返回DR屏幕，“TO”中显示“Link to Reflector(链接到反
射器)和“REF030CL”。

7� 按住[PTT] 链接反射器。

使用TX历史记录
发送历史记录(TX History)可保存接入中继器之前最
多5个反射器。
示例: 在发送历史中选择“REF030CL”。
1. 按D-pad() 选择“TO” ，再按 [ENT]。

.
2. 选择 “Reflector” 。

显示REFLECTOR 屏幕。
3. 选择 “Link to Reflector ” 。

·将显示 Link to Reflector屏幕。
4. 选择要链接到的反射器。

• 返回DR界面，在“TO”中显示 “Link to Reflector(链接到
反射器)”和“REF030CL” 。

.

D-STAR 操作 (高级版)

连接反射器

D 链接到反射器
如果中继器当前未链接到反射器，或者想将其更改为其
他反射器，请执行以下步骤。在链接到另一个反射器之
前，请确保断开当前反射器的链接。(p. 5-14)

直接输入反射器

示例： 直接输入“REF030CL”。

1. 按D-pad()选择“TO”，然后按[ENT]。
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连接反射器

.


.
2. 选择“Reflector”。

•显示REFLETOR 屏幕
3. 选择 “Use Reflector”。

• 返回DR界面，在“TO”中显示“Use Reflector(使用反
射器)” 和 “CQCQCQ” 。

.






• 返回DR界面，在“TO”中显示“Echo Test” 和 “E” 。

.


• 返回DR界面，在“TO”中显示“Repeater
Information” 和 “I” 。

.


D-STAR 操作 (高级版)

• 显示 TO SELECT 屏幕

2. 选择“Reflector”。
•显示REFLETOR 屏幕

3. 选择 “Echo Test”。

D请求中继器信息
当发送中继信息命令时，将发回一条ID消息。
1. 按D-pad() 选择“TO”，然后按[ENT]。

• 显示 TO SELECT 屏幕
2. 选择“Reflector”。

•显示REFLETOR 屏幕
3. 选择 “Repeater Information”。
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信息操作

您最多可以在对讲机的内存中保存5条短消息，以
便在DV模式下传输。每条消息最多可以包含20个
字符。

D输入发送的信息
[MENU] > SET > My Station > TX Message

示例：在发送消息存储器1中输入“JAPAN TOM”。
1. 按[MENU]。
2. 在“SET”中选择“My Station”  。

3� 选择“TX Message ” 。

4� 选择TX Message（发送消息）存储器编号。

 不要按[ENT]
5� 按[QUICK]。
6. 选择“Edit ” 。

7� 输入最多20个字符的消息。

.


.

.




[MENU] > SET > My Station > TX Message

.


 相关信息
.



提示: 接收呼号和信息显示
默认情况下，接收到的呼号和信息会自动显示和滚
动。
如不需要显示和滚动，请将RX Call Sign设置
为“OFF”。
([MENU] > SET > Display > RX Call Sign)

D-STAR 操作 (高级版)

1. 按[MENU]。
2. 在“SET”中选择“My Station”  。

1. 按[MENU]。
2. 在“SET”中选择“My Station”  。

3� 选择“TX Message ” 。

4� 选择TX Message（发送消息）存储器编号。
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信息操作

D 删除传输的消息
[MENU] > SET > My Station > TX Message

.
7. 选择 “YES ” 。

.


D-STAR 操作 (高级版)

4� 选择TX Message（发送消息）存储器编号。

示例：在发送消息存储器1中删除“JAPAN TOM”。
1. 按[MENU]。
2. 在“SET”中选择“My Station”  。

3� 选择“TX Message ” 。

1. 按[MENU]。
2. 在“SET”中选择“My Station”  。

 不要按[ENT] 
5. 按[QUICK]。
6. 选择“Clear” 。�
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.


相关信息
• “RX HISTORY”屏幕的第一页显示主频段的最新接收记
录。第二页或更晚的页面根据接收的日期和时间显示记
录，而不考虑在哪个频段接收。

• 显示接收历史号码、呼叫者姓名（或呼号）、目的地、
接收消息、接收日期和时间、“GW”和“GPS”。

• 当收到网关呼叫时，会显示“GW”。
• 当接收到的呼叫包括位置数据时，会显示“GPS”。
• 当接收到中继器上行链路信号时，显示“UP”。�
• 在“快速菜单”窗口中，您可以选择以下选项。

.





.
.



<第1页>
• CALLER:  .


• CALLED:   显示被叫电台的呼号*2.

接收本地呼叫或网关呼叫时显示 
“CQCQCQ” 。

<第2页>
• RX RPT1:  .





• RX RPT2:
 当呼叫不是通过中继器(单工呼叫)时，
       将显示工作频率，而不是上述项目。 

查看收到的呼号

当您接到DV呼叫时，会保存主叫台和中继器呼号。最多可保存50个呼叫。当您接到第51个呼叫时，最旧的通话
记录将被删除。
 即使对讲机关闭，RX记录也不会被删除。

D查看接收历史屏幕上的呼号

RX HISTORY 界面 (RX01)

*1  显示的图标会有所不同，具体取决于D-PRS TX格式。
GPS: 位置 OBJ: 对象
	 WX: 天气

*2  当在存储器中输入名称时，也会显示该名称。

.


D-PRS TX
格式图标*1

历史记
录序号 

呼叫站点*2 

L “/”之后可能会显
示注释 

接收数据和时间 

呼叫站点
(如果接到CQ呼叫，则
会显示“CQCQCQ” 。)

      RX 信息

D-STAR 操作 (高级版)

RX>CS:
Call Sign Display:
Name Display:
Delete:
Delete All:

显示您接到的中继器呼号*2。
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查看收到的呼号

D 查看接收历史屏幕上的呼号
<第3页>
• RX MESSAGE:  

•• RX TIME:

如果输入，则显示接收到的呼
叫中包含的任何消息。
显示接到呼叫的日期和时间。

.



.

提示: 删除接收历史数据
在接收历史记录或详细信息屏幕上，按下
[QUICK]，然后选择“Delete” 或者 “Delete All”。

.




JM1ZLK JM1ZLK 
calling you...calling you...

JM1ZLK JM1ZLK 

calling you...calling you...

JM1ZLK JM1ZLK 

calling you...calling you...  RXRPT2 RXRPT1

CALLED

CALLER

YOUR STATION

.

JM1ZLK calling from

JP1YIU port A...
JM1ZLK calling from

JP1YIU port A...

JM1ZLK calling from

JP1YIU port A...

JM1ZLK calling from

JP1YIU port A...

RXRPT2

RXRPT1

JP1YIU port A...
JM1ZLK calling from JM1ZLK calling from 
JP1YIU port A...

CALLER

GW

INTERNETINTERNET

CALLED

YOUR STATION

D-STAR 操作 (高级版)
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BK模式通信

插话（BK）功能使您能够插话，两个电台在启用数字呼
号静噪（DSQL）的情况下进行通信。 
当您关闭对讲机时，BK功能会自动关闭。

[MENU] > SET > DV Set > BK
1. 当2个工作站在DV模式下通信时，

按住[RX→CS]1秒钟。
• 松开[RX→CS]后，主叫站的呼号或中继器的
呼号设置为“TO”.

.
 当未正确接收到呼号时，会发出错误提示音，
    并且未设置呼号。 

2. 按 [MENU]。
3. 在 “SET” 菜单选择 “DV Set”。

如何使用Break-in?
.


4. 选择“BK”。

5. 选择 “ON”。

6. 按[MENU]。

.
7.当两个电台都处于待机状态时，按下[PTT] 发射。
“BK”在接到断开呼叫时闪烁。
要取消BK模式，请在步骤5中选择“OFF”，
     或关闭对讲机。

.


.


A站  A站 B站  B站

 C站

B站没有听到C站正在呼叫A站。

C站

B站也听到C站正在呼叫A站。

D-STAR 操作 (高级版)
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EMR 通信

.


 相关信息
•所有可以接收EMR信号的对讲机都会自动接收该信号。除非
在紧急情况下，否则不要使用此功能。
•当接收到EMR信号时，即使音量设置级别被设置为最小级
别，也能以设置的级别听到音频（语音）。
•当您关闭对讲机时，EMR通信功能会自动关闭。

[MENU] > SET > DV Set > EMR
示例:  使用EMR功能，从“Hirano”中继器进行传输。
1. 按 [MENU]。
2. 在 “SET” 菜单选择 “DV Set”。

3. 选择 “EMR ” 。

4. 选择“ON”。

5. 按[MENU]。

• 返回待机屏幕并显示“EMR”。按下[PTT]。
• 发送/接收指示灯在发送时亮起红色。
“EMR”在接收EMR信号的电台上闪烁。音频(语音)以设
      定的音量或[VOL]音量(以较高者为准)收听。
要取消EMR模式，请在步骤4中选择“关闭”，
    或关闭对讲机 

D 调整EMR音频输出
当接收到EMR信号时，音频输出电平可在0和39之间调
节。
当接收到EMR信号时，以预设电平或[VOL]控制电平
(以较高者为准)收听音频。
要关闭设置，请设置为“0”

[MENU] > SET > DV Set > EMR AF Level

3� 选择 “EMR AF Level”。

4. 旋转[DIAL]，在0(关闭)和39(最大)之间调整EMR
音频输出电平。（默认值：19）

D-STAR 操作 (高级版)

1. 按 [MENU]。
2. 在 “SET” 菜单选择 “DV Set”。

按 [MENU]退出菜单。
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自动DV检测

如果在DV模式下接收到调频信号，则“DV”和“FM”图标
交替闪烁，表示接收到的信号为调频信号。

当DV Auto Detect(DV自动检测)功能打开时，对讲机会
自动选择FM模式对其进行临时监控。(默认值：OFF)

 无论此设置如何，如果在DV模式下接收到调频信号，
      “DV”和“FM”图标交替闪烁。

.




[MENU] > SET > DV Set > DV Auto Detect
1. 选择 [MENU]。
2. 在 “SET” 菜单选择 “DV Set”。

3. 选择 “DV Auto Detect ” 。

4. 选择 “ON”。

按[MENU]退出菜单。
当在DV模式下接收到调频信号时，“DV”和“FM”图标依
    次闪烁，对讲机在调频模式下接收信号。 

当在DV模式下接收到调频信号时

.


.


. .

. 听到音频

● ● 
Thanks for 
the nice QSO!

D-STAR 操作 (高级版)
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自动回复功能

.




.


提示：录制“自动回复”消息
您可以录制“自动回复”消息。详见第5-25页。
([MENU] > RECORD > DV Auto Replay)

[MENU] > SET > DV Set > Auto Reply

3� 选择 “Auto Reply ”。

4. 选择项目。

•• ON:  使用您自己的呼号自动回复。（不
发送音频回复）

• Voice:  使用您自己的呼号和microSD卡上录制
的自动回复信息自动回复（最长10
秒）。
 如果未插入SD卡，或未录制消息，
     则只使用您自己的呼号进行回复
  （不发送音频回复）。 

• Position: 使用内部GPS接收器自动回复您的呼
号和位置数据。
 当“GPS Select”设置为“OFF”或
     “Manual”时，内部GPS接收器将暂时
      打开。

.
• 返回待机屏幕，并显示“        ”

当选择“ON”或“Voice”时，按下[PTT]时，自动回复功
     能会自动关闭。
当选择“Position”（位置）时，当您按下[PTT]时，
     Automatic Reply（自动回复）功能保持打开状态。 

示例:  收到来自“JM1ZLK”的呼叫后，会发出嘟嘟声，
            对讲机会自动发送回复呼叫。

.


D-STAR 操作 (高级版)

1. 选择 [MENU]。
2. 在 “SET” 菜单选择 “DV Set”。



5

5-25

自动回复功能

.



.

[MENU] > RECORD > DV Auto Reply

3� 按住[PTT]可开始录制，松开可停止录制。

 相关信息
.





.

DV AUTO REPLY（DV自动应答）屏幕

提示:要删除录制的消息，请在DV AUTO REPLY(DV
自动应答)屏幕上按[QUICK]，然后选择“Clear ”  。

显示音频等级 调整麦克风增益，使REC电平不会达到
该范围
([MENU] > SET > Function > MIC Gain 
(Internal), MIC Gain (External))

D-STAR 操作 (高级版)

1. 选择 [MENU]。
2. 在 “RECORD” 菜单选择 “DV Auto Reply”。 
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自动回复功能

D自动位置回复功能
当您接到一个指向呼号的呼叫，但处于难以操作对讲
机的情况下时，此功能会发出嘟嘟声，并自动回复呼
号并传输您的位置数据。

在接收到自动定位应答呼叫后，呼叫者的位置数据会
显示在一个窗口中。 
 Icom对讲机*在接到呼叫后显示位置。
 您可以关闭呼叫者的位置显示。 (p� 12-26) 

([MENU] > SET > Display > Reply Position Display)

* 除去ID-31A/E, IC-9100, ID-880H/E880, IC-80AD/E80D,
IC-92AD/E92D, IC-2820H/E2820, ID-800H, IC-91AD/
E91, IC-V82, IC-U82

3. 接收后，位置数据显示在
目的地的对讲机上。

1. 一个打给你呼号的呼叫。

2. 您的位置数据会
自动传输。

你的站点

目的地 
(ID-52A/E)

.


当未接收到有效的位置数据时

在接到指向呼号的呼叫后，即使“GPS Select”设置
为“OFF”或“Manual”，内部GPS接收也会暂时打开约5
分钟，以接收您的位置数据。然后，对讲机会自动回
复一条消息，如下所述。
([MENU] > GPS > GPS Set > GPS Select)
 .




未收到有效位置数据时的回复消息列表

信息 状态

No Position .


Old Position .


No Posi & GPS Start .


Old Posi & GPS Start
.



贴士:
•位置数据根据“GPS发送模式”传输。（第6-12页）
•当自动应答功能的“GPS TX Mode”设置不正确时，
  对讲机会自动将其更正为应答呼叫。
•当“GPS TX Mode”设置为“OFF”时，
会自动选择“D-PRS”。

JA3YUA

D-STAR 操作 (高级版)
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数据通信

.





.




.



.

• 设置 “GPS Out (USB Port)” 为 “OFF ”
([MENU] > GPS > GPS Set > GPS Out (USB Port))

• 设置 “USB Connect” 为 “Serialport,”
([MENU] > SET > Function > USB Connect)

• 设置 “USB Serialport Function” 为 “DV Data.”
([MENU] > SET > Function > USB Serialport Function)

D 数据通信应用程序设置 
.

 ID-52A/E使用的COM端口号*
需要的速率
8 bit
无
1bit
Xon/Xoff

• Port:
• Baud rate:
• Data:
• Parity:
• Stop:
• Flow control: 

* .



D正在发送数据
1. 设置呼号、目的呼号和中继器呼号。
2. 按照您的数据通信应用软件的说明进行操作。
3. 当您在通信软件中输入文本数据时，对讲机可能会

自动传输，具体取决于软件及其设置。

 当“DV Data TX”设置为“PTT”时，按下[PTT]
   发送文本数据和语音信号。 (p. 12-10) 

    ([MENU] > SET > DV Set > DV Data TX) 
在发送数据之前，对讲机发送大约500毫秒的载波感
     测信号。

注意:
.








PC

[USB]接口 USB 接口

对讲机

USB 电缆

D-STAR 操作 (高级版)
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数据通信

DDV快速数据功能
要使用DV快速数据功能发送数据，请按照以下说明
进行操作。
 DV快速数据通信只能通过以下Icom对讲机进行：

 (截至2021 年11月)
• IC-705
• IC-9700
• ID-31A/E PLUS
• ID-4100A/E
• ID-5100A/E*
• ID-51A/E (PLUS、PLUS2、50周年纪念型)
• ID-52A/E

* 仅当安装了CPU M 1.10、S 1.00、C 1.10和DSP 1.10
或更高版本的固件时才可用。

注意:如果您想将GPS数据发送到只能接收低速数据
的其他对讲机，请将 “GPS Data Speed” 设置
为“Slow” 。（第6-4页）
([MENU] > SET > DV Set > DV Fast Data > GPS Data Speed

[MENU] > SET > DV Set > DV Fast Data > Fast Data

3. 选择 “DV Fast Data”。

4. 选择 “Fast Data ” 。

5. 选择“ON ”。

关于显示类型

您可以放大字符，例如DR功能显示的中继器名称。
 此设置只能在选择“单频段显示”时使用。
1.在单频段显示中显示要更改的主屏幕。

2. 选择 [QUICK]。
3. 选择 “Display Type”。

4� 选择 “Large”。

.

D-STAR 操作 (高级版)

1. 选择 [MENU]。
2. 在 “SET” 菜单选择 “DV Set”。

按 [MENU]退出菜单。



5

5-29

数字静噪功能

只有收到一个指向你自己呼号的信号或一个包含匹配
数字代码的信号时，数字静噪才会打开。
你可以静静地等待别人的呼叫。
您可以在VFO模式、内存模式、呼叫通道模式或DR功
能中独立设置数字静噪功能。

D 数字呼号静噪设置
1. 按 [QUICK]。
2. 选择 “D.SQL” 。

3� 选择DSQL”。

.

.


  .



注意:
.







D 数字代码静噪设置
1. 按[QUICK]。
2. 选择“D.SQL” 。

3� 选择“CSQL”。

.

4. 按[MENU]。
5. 在“SET”菜单选择 “DUP/TONE...” 。
6. 选择 “Digital Code” 。

7� 旋转[DIAL] 选择数字编码。

.


 当接收到的信号不包括匹配码时，数字码静噪不打开。
    但是，S/RF仪表会显示信号电平。
 按[MENU]退出MENU屏幕。 

.



D-STAR 操作 (高级版)
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中继列表

您可以保存中继器信息，以便在最多50个组中的2500
个中继器（中继器列表）中进行快速简单的通信。
数据必须在中继器列表中才能使用DR功能。
您可以在中继器列表中添加和编辑中继器内容和组。
您可以在中继器列表中输入4种类型的频率，如下所
示：
• DV Repeater
• DV Simplex
• FM Repeater
• FM Simplex

TIP:
• 为了便于操作，中继器列表已预加载到您的对讲
机中。但是，如果执行“全部重置”，CPU将删除所
有设置数据、内存通道和中继器列表。我们建议
您使用CS-52编程软件将内存数据备份到microSD
卡或保存到PC。

• 中继器列表可以从Icom网站下载。请参阅可从
Icom网站下载的“更新中继器列表”，了解如何使用
microSD卡更新中继器列表。 https://
www.icomjapan.com/support/

D 中继列表内容
中继器列表中包括以下内容：
• TYPE:  
• NAME: 
• SUB NAME: 
• CALL SIGN: 
• GW CALL SIGN:
• GROUP:
• USE (FROM):
• FREQUENCY:
• DUP:
• OFFSET FREQ:
• MODE:
• TONE:
• REPEATER TONE: 
• POSITION:
• LATITUDE:
• LONGITUDE:
• UTC OFFSET: 

示例: “Hirano” 中继器信息

D-STAR 操作 (高级版)

通信类型(p. 5-32)
中继名称(p. 5-33)
副中继名称(p. 5-33)
中继器呼号和端口号(p. 5-32)
网关中继器的呼号和端口“G”(p. 5-32)
中继群组 (p. 5-33)
接入中继器使用(p. 5-33)
接入中继器频率(p. 5-33)
双工指向(p. 5-33)
频率偏差(p. 5-33)
操作模式(p. 5-34)
亚音设置(p. 5-34)
中继亚音(p. 5-34)
位置数据准确度等级(p. 5-34)
中继器的纬度(p. 5-34)
中继器的经度(p. 5-35)
UTC偏移(p. 5-35)
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.





.



D案例所需项目
中继列表 

内容
用作接入
中继器

用作目的
中继器

用作调频
中继器 单工 (FROM)

TYPE DV Repeater DV Repeater FM Repeater DV Simplex FM Simplex

NAME ○ ○ ○ ○ ○
SUB NAME ○ ○ ○ ○ ○
CALL SIGN ● ● ○ N/A N/A

GW CALL SIGN ●
(For a Gateway call)

● N/A N/A N/A

GROUP ○ ○ ○ ○ ○
USE(FROM) ● ○ ● ● ●
FREQUENCY ● ○ ● ● ●
DUP ● ○ ● N/A N/A

OFFSET FREQ ● ○ ● N/A N/A

MODE N/A N/A ○ N/A ○
TONE N/A N/A ○ N/A ○
REPEATER 
TONE N/A N/A ○ N/A ○
POSITION ○ ○ ○ ○ ○
LATITUDE ○ ○ ○ ○ ○
LONGITUDE ○ ○ ○ ○ ○
UTC OFFSET ○ ○ ○ ○ ○
●:  必须输入
○:  可以输入
N/A: 不适用

D-STAR 操作 (高级版)
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步骤 1. 选择中继群组

[MENU] > MEMORY > Repeater List
1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY” 。
3. 选择 “Repeater List ” 。

4. 选择要添加中继器的中继器组。

.

5. 按[QUICK]。
6. 选择 “Add ”。

.

步骤2. 选择通信类型
.


. 
 

 

步骤 3. 输入中继名称
.





在中继器列表中输入新信息

D 在中继器列表中输入新信息

步骤 4. 输入副中继名称
1. 选择 “SUB NAME”。
2. 输入最多8个字节的名称。

详见第 iii 页字节输入。
3. 完成后，按[ENT]。
步骤5. 输入中继器呼号
 在步骤2选择通信类型设置为“DV Simplex”或“FM 

 Simplex”，转至步骤7。更改中继器组。

1. 选择“CALL SIGN”。
2. 输入最多8个字符的中继器呼号，

包括空格和节点字母。

.







• 1200 MHz: A (B在日本)
• 430 MHz: B (A在日本)
• 144 MHz: C (日本没有中继器)) 

3. 输入最多16字节名称。

步骤6. 输入网关中继器呼号
 步骤2时显示此项目。选择通信类型设置为
                “DV Repeater”。 
 在步骤5中输入的呼号中的第8位数字。输入中继器
       呼号会自动设置为“G”作为网关端口，因此您可以
       跳过此设置并转到下一项。

1. 选择 “GW CALL SIGN”。
2. 输入最多8字节网关中继器呼号 ，包括空格。

.

.

D-STAR 操作 (高级版)
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.



1. 选择 “GROUP ”。
2. 选择中继群组(01 ~ 50) 。

步骤8.将“USE（FROM）”设置为用作接入中继器

  .





1. 选择“USE(FROM) ”。
2. 选择“YES” 将中继器用作接入中继器

步骤9.输入接入中继频率

1. 选择 “FREQUENCY ”。
2. 旋转 [DIAL] 选择输入频率。

.


在中继器列表中输入新信息

D在中继器列表中输入新信息

步骤7. 更改中继器组 步骤 10. 选择双工方向
 当步骤2选择通信类型设置为“DV Simplex”或“FM
           Simplex”时，不显示此项。
 当在步骤9中输入接入中继器频率时，会自动设置
       DUP–“。输入接入中继器频率。如有必要，您可以
       更改双工方向。

1. 选择 “DUP ”。 。
2. 选择双工方向

• OFF: 关闭双工。
• DUP–: 发射频率相对接收频率而言向下偏移。
• DUP+:  发射频率相对接收频率而言向上偏移。

步骤 11. 输入频率偏差

1. 选择 “OFFSET FREQ”。
2. 旋转 [DIAL] 选择频率偏差

(0.000.00 ~ 59.995.00 MHz)。

D-STAR 操作 (高级版)

按D-pad()移动光标。
3. 完成输入按 [ENT]。

 当步骤2选择通信类型设置为“DV Simplex”或“FM
           Simplex”时，不显示此项。
 当在步骤9中输入接入中继器频率时，自动设置自

     动设置*。输入接入中继器频率。如有必要，您可
    以更改频率偏差  。
* 默认数值有所区别，具体依靠对讲机版本。



5

5-34

1. 选择 “MODE ”。
2. 选择“FM” 或 “FM-N”。

步骤13. 设置亚音

1. 选择“TONE ”。
2. 选择选项。

• OFF: 关闭亚音
• TONE: 中继器接入时的亚音。
• TSQL:  单工操作时，使用的亚音静噪。

步骤14. 选择中继器亚音频率

1. 选择 “REPEATER TONE”。
2. 旋转[DIAL] 选择亚音频率，然后按[ENT]。

在中继器列表中输入新信息

D 在中继器列表中输入新信息

步骤 12. 设置调频模式

1. 选择 “POSITION”。
2. 选择位置数据精度级。

.



• None:
• Approximat：
• Exact:

步骤 16. 输入纬度
 仅限步骤15选择位置数据精度级别设置
为“Approximate”或“Exact”时，才会显示此项目 。
1. 选择 “LATITUDE ”。
2. 旋转 [DIAL] 输入纬度。

 按 D-pad() 移动光标。
 要输入北纬，选择“N”，要输入南纬，选择“S” 

D-STAR 操作 (高级版)

 当步骤2选择通信类型设置为“DV Simplex”或“DV
   Simplex”时，不显示此项。

 当步骤2选择通信类型设置为“DV Simplex”或“DV
   Simplex”时，不显示此项。

步骤15.  选择位置数据精度级

 当不使用近中继器搜索功能，或者不需要您的位
    置和中继器之间的距离时，选择“关闭”，然后转
    到步骤18，设置UTC偏移量。

3. 完成输入按 [ENT]。
当步骤2选择通信类型设置为“DV Simplex”或“DV

           Simplex”时，不显示此项。
当在步骤13需要此设置。将亚音设置为

      “tone”或“TSQL”。
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步骤18. 设置UTC偏差

世界时间(UTC)偏差是UTC和中继器本地时间之间
   的时差。这是一个有用的功能，可以在你呼叫之前
   知道中继器的本地时间。（第5-13页） 
1. 设置“UTC OFFSET ”。
2. 旋转[DIAL]设置UTC和当地时间之间的时差，

然后按下[ENT]。

步骤19. 保存中继列表

1. Select选择 “<<Add Write>> ”。
.

2. 选择“YES”。

.


提示: 取消输入的数据
1. 按[CLR] 显示 “Cancel edit?” 屏幕。
2. 选择“YES ” 。

.
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在中继器列表中输入新信息

D 在中继器列表中输入新信息

步骤 17. 输入经度

仅限步骤15选择位置数据精度级别设置
为“Approximate”或“Exact”时，才会显示此项目 。

1. 选择 “LONGITUDE”。
2. 旋转 [DIAL] 输入纬度。

 按 D-pad() 移动光标。
 要输入北纬，选择“N”，要输入南纬，选择“S” 

3. 完成输入按 [ENT]。
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中继器列表操作

.




[MENU] > MEMORY > Repeater List
1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Repeater List ” 。

4. 选择要编辑的中继器所在的中继器组。

5. 选择要编辑的中继器，然后按 [QUICK]。
6. 选择 “Edit ”。

7. 选择一个项目，然后对其进行编辑。
 详见 5-32 ~ 5-35 。

8. 完成后，按 “<<Overwrite>> ” 。

.
9� 选择 “YES ” 。

.


.

D删除中继器数据
[MENU] > MEMORY > Repeater List

.



D-STAR 操作 (高级版)

1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Repeater List ” 。

4. 选择要删除的中继器所在的中继器组。

5. 选择要删除的中继器，然后按 [QUICK]。
6. 选择 “Delete ”。

• 显示确认对话框。
7� 选择 “YES ” 。

• 编辑后的内容将保存到中继器列表中，并返回到所选
中继器组屏幕。

 退出菜单模式，按 [MENU]。
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[MENU] > MEMORY > Repeater List

4� 选择要移动的中继器所在的中继器组。

5� 选择要移动的中继器。

 不要按[ENT]。
6. 按 [QUICK]。
7. 选择“Move ” 。

8. 选择插入点，要在移动中继器的中继器上面的位置。

 移动时， “DESTINATION” 在屏幕左上角闪烁。

.

.


中继器列表操作

D 重新排列中继器的显示顺序
您可以移动输入的中继器，以重新排列它们在所选中继器组中的显
示顺序。

D-STAR 操作 (高级版)

1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Repeater List ” 。
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.
.

2. 按D-pad() 显示要添加到中继器列表中的中继器，
然后按[ENT]。

.
3. 按D-pad() 显示 “RXRPT1” 和“RXRPT2 ” 。

4. 按[QUICK]。
5. 选择“Add To RPT List ” 。

6. 选择要添加到中继器列表中的中继器呼号

.


 如果所选中继器已在中继器列表中，则会显示
     "Duplicate Call Sign"。
 详见 5-32 ~ 5-35 编辑内容。

7. 选择“<<Add Write>> ”。

.

中继器列表操作

D 从接收历史添加新的中继器信息
8� 选择 “YES ” 。

.


.

D-STAR 操作 (高级版)
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中继器列表操作

D 跳过DR扫描的设置
您可以将中继器设置为扫描跳过中继器。跳过所选
中继器以加快扫描速度。您可以将跳过设置设置为
所选中继器组中的所有中继器或单个中继器。 
 当中继器设置为跳过中继器时，其“USE（FROM）”
     设置会自动设置为“NO”。在这种情况下，无法在DR
     屏幕上的“FROM”（访问中继器）中选择中继器。

<单个跳过设置>

[MENU] > MEMORY > Repeater List

5. 选择要跳过的中继器，然后按下 [QUICK]。
6. 选择 “SKIP ” 。

 所选中继器显示 “SKIP”

再次选择“SKIP”以取消跳过设置。
选择“SKIP All ON”（跳过全部打开），将跳过设
     置设置为组中的所有中继器。

<组跳过设置>
1. 在中继器组屏幕上，选择一个中继器组，

如左侧所述。
2. 按[QUICK], 选择“SKIP All ON”以在DR扫描期间

跳过该组的中继器。
 要取消组中的跳过设置，请选择 “SKIP All OFF ”。�

提示:
.




.

D-STAR 操作 (高级版)

1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Repeater List ” 。

4� 选择要跳过的中继器所在的中继器组。
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[MENU] > MEMORY > Repeater List

4� 选择要编辑名称的中继器组。

5. 按 [QUICK]。
6. 选择“Edit Name ”。

7� 输入最多16个字符的组名 。

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * + , - . / : ; < = > ? 
@ [ \ ] ^ _ ` { | } ˜ (space)

8. 完成后按[ENT]。�

D 输入或编辑中继器组名称

D-STAR 操作 (高级版)

中继器列表操作

1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Repeater List ” 。

 不要按[ENT]。
如果选择了已命名的组，则该名称将被覆盖。

 详见第 iii 页字节输入。

• 设置输入的名称。
 退出菜单模式，按 [MENU]。
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呼号

.





[MENU] > MEMORY > Your Call Sign
示例:  在您的呼号存储器中输入“Rick/JM1ZLK”。

4. 在 YOUR CALL SIGN界面按 [QUICK]。
5. 选择 “Add ” 。

6. 选择 “NAME ” 。

7. 输入最多16个字符的电台名称。

.

9. 选择“CALL SIGN ” 。

10. 输入最多8个字符的名称，包括空格。

11. 完成输入后按[ENT]。
12. 选择 “<<Add Write>> ” 。

.
13. 选择 “YES”。

D-STAR 操作 (高级版)

1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Your Call Sign ” 。

 详见第 iii 页字节输入。

• “Rick JM1ZLK”已经输入到了存储器中。
 退出菜单模式，按 [MENU]。
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提示:
取消输入的呼号
1. 按[CLR]显示 “Cancel edit?” 屏幕。
2. 选择“YES” 取消输入，返回到

YOUR CALL SIGN 界面。

.




呼号

 D输入呼号 D 删除呼号
[MENU] > MEMORY > Your Call Sign

4� 选择需要删除的呼号 。

.
7. 选择 “YES ” 。

注意：
DR屏幕上当前选择的Your Call Sign无法编辑或删
除。要编辑或删除Your Call Sign，请在DR屏幕上
选择另一个Your Call Sign。

D-STAR 操作 (高级版)

1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Your Call Sign” 。

5. 按 [QUICK]。
6. 选择“Delete ”。

 不要按[ENT]。

• 所选呼号将从“您的呼号”列表中删除，并返回到
YOUR CALL SIGN 屏幕。

 退出菜单模式，按 [MENU]。  



5

5-43

D 重新排列呼号的显示顺序 
.



[MENU] > MEMORY > Your Call Sign
示例: 将“Eddy” 移到 Rick”上方。

呼号

7. 选择插入您要将呼号移到上面的呼号的位置。

 移动时, “DESTINATION” 在屏幕左上角闪烁。

D-STAR 操作 (高级版)

4� 选择需要移动的呼号 。

1. 按[MENU]。
2. 在菜单屏幕的第二页上选择“MEMORY”。
3. 选择 “Your Call Sign” 。

5. 按 [QUICK]。
6. 选择“Move ”。

 不要按[ENT]。
• 所所选呼号将插入目的呼号的上方。
如果选择“<<Move End>>”，您的呼号将移动到组
     的底部。
退出菜单模式，按 [MENU]。   
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您的设置正确吗？
.











CQ D-STAR Hirano, this is JA3YUA 
through JP3YHH port A for a local call���
CQ D-STAR Hirano, this is JA3YUA 
through JP3YHH port A for a local call���

CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call���CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call���

CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call���

CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call���

INTERNETINTERNET

设置错误，
不能进入中继器。

JA3YUA’s 设置

目的地（“TO”）设置不正确。

正确设置

.


.





Caller
(JA3YUA)

Hirano 区域 Hamacho 区域

Called

D-STAR 操作 (高级版)
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6-2

D-PRS扩展功能(p. 6-4)
D-PRS扩展功能使您能够传输或接收除位置数据之外的对象、项目和天气信息。通过此扩展，您可以在DV模式下同
时传输或接收地震信息、交通事故信息、紧急情况信息或天气信息等，以及语音音频。

GPS 存储 (p. 6-22)
.


可以输入我要徒步旅行的山的位置
信息！我要去登山！

使用电脑编辑GPS信息比对
讲机编辑更容易一些。

GPS报警功能(p. 6-27)
.


I’m almost there!I’m almost there!

GOAL!GOAL!

GPS 日志记录
.


跟踪我的GPS登录地图软件。
这就是我旅行的方式...会很趣的!

GPS 操作特点

请参阅可从Icom网站下载的“Using the GPS Logger function” ，了解如何使用该功能。
https://www.icomjapan.com/support/
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开始GPS操作之前

.

.


.


.


.
→  → →

.


.



(�[MENU] > GPS > GPS Set > GPS Option 
> Power Save)

提示：在GPS模式下延长电池寿命
使用接收到的GPS数据手动更新您的位置。

1. 将“GPS Select”设置为“ON”，内置的GPS接收位
置数据。

([MENU] > GPS > GPS Set > GPS Select)
2. 打开MANUAL POSITION屏幕, 然后按[QUICK]。

([MENU] > GPS > GPS Set> Manual Position)

3� 选择 “Capture From GPS ”。

.


4. 将 “GPS Select”设置为“Manual ”。
([MENU] > GPS > GPS Set > GPS Select)

GPS 操作(高级版)

 相关信息
• 接收可能只需要几秒钟，也可能需要几分钟，具体取决于
您的操作环境。如果您在接收时遇到困难，我们建议您尝
试其他职位。。

• 当“GPS Select” 设置成 “Manual”时，GPS图标不显示。
([MENU] > GPS > GPS Set > GPS Select)
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示例：当来电者的发送格式为D-PRS位置(移动)。 
([MENU] > GPS > GPS Position)

(截至2021 年11月)
.



















旧型号之间的差异

GPS 操作(高级版)

GPS TX模式和TX格式类型

GPS位置数据有两种发送模式：D-PRS和NMEA。
此外，采用D-PRS模式数据，有5个位置格式。位
置(移动台/基站)、对象、项目和天气均可选择。

D-PRS D-PRS是一种同时从内部或外部发送GPS接收到的位置数
据的功能，使用低速数据包间隔，以及语音。

Position (Mobile)
位置(移动)

从车辆或其他位置运行的站点，远离其正常的基本位置。

Position (Base)
位置(基站)  在固定地点工作的站点。

Object
目标

传输目标数据，如地震信息、卫星轨道信息等。 对象
包含时间标记。

Item
项目

传输项目数据，如交通事故、灯塔、天线或DV接入点
位置等。

项目不包含时间标记。

Weather
天气预报

传送从气象设备接收到的天气信息的站点。

NMEA 传输从GPS接收到的位置数据(NMEA0183)的站点。
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当接收到的信号包含位置
数据时

当接收到的信号包含位置数据时，呼叫者的位置数据
显示在RX位置屏幕上。

有关详细信息，请参见右侧。

示例：当来自JM1ZLK的信号包含位置数据 

当您接收到信号时，RX位置数据将显示在
RX位置窗口中。

几秒钟后，窗口消失。

RX 位置图标

.


 您可以关闭呼叫者的位置数据显示。
   ([MENU] > SET > Display > RX Position Display) 
 您可以关闭RX位置图标指示。

([MENU] > SET > Display > RX Position Indicator)

查看位置数据
您可以查看当前位置。
本节使用接收到的位置数据进行描述。 
 屏幕只是示例。

D 显示位置数据
1. 按[QUICK]。
2. 选择“GPS Position ”。

.
.

.



.


4. 要关闭GPS POSITION 屏幕，请按 [MENU]。

.


提示:
• 如果您在GPS POSITION屏幕打开的情况下进行传
输，则该屏幕将关闭。要查看位置，请按[[QUICK]，
然后在发送时选择“GPS Position”。

• 在MY屏幕或RX屏幕上，按下[QUICK]并选择“GPS
Memory”，即可在GPS Memory中输入显示的位置信
息。

• 请参阅第6-22页中有关GPS存储功能的内容，并参阅
第6-27页中关于GPS报警功能的内容。

GPS 操作(高级版)
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查看位置数据

D GPS 定位及其含义

 相关信息
• 按[QUICK]]键，改变罗盘指针的方向。（第6-10页）
• 关于航向（第6-8页）
• 关于坐标定位（第6-9页）

251 mi

248 mi

107 mi

 (p� 6-30) ([MENU] > GPS > GPS Set > GPS Select)

带SSID的呼叫者呼叫标志

MEM 界面 (GPS存储道信息）

ALM界面（GPS报警存储信道信息）

*

*

*

GPS 操作(高级版)

GPS位置示例:

GPS 报警 
东京国际展示场

GPS存储
东京天空树

呼叫站点
(D-PRS: 移动) 
航向: 95 度 
速度: 5.6 英里/小时

你的位置
航向: 0度 
速度: 2.3英里/小时

MY screen (你的位置信息)

当GPS选择设置为“Manual ”时，罗盘航向和航线不显示。

航向

你的航向 纬度
经度

时间

坐标定位
海拔高度
速度

从你的位置
出发的方向

与您位置的距离 

RX界面(呼叫站位置信息）
根据呼叫者的GPS发送模式和发送格式，显示项目的
含义可能不同，某些数据可能无法显示。(p. 6-7)

示例：呼叫站的GPS发送模式为“D-PRS” ，它的发送
格式是“Position  (Mobile)”。

从你的位置
出发的方向

D-PRS符号

呼叫方向

呼叫者的速度 呼叫方获取位置
数据的时间

从你的位置
出发的方向

 当GPS存储信道中没有输入名称时，将显示日期和
时间而不是名称。可以在GPS位置界面上更改GPS
存储或GPS报警。(第6-9页）

与您位置的距离 
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D接收界面

TX 格式:
D-PRS

.

.


天气

TX 格式:
NMEA

GPS 操作(高级版)

查看位置数据

位置(基站）

目标 项目

移动符号 对于移动台，
将显示航向和速度

速度和航向

对于基站，将显示输出功
率、天线高度、天线增益
和天线方向。

调用方发送
对象数据的时间

对于项目工作站，不显示时间

位置(移动）

基站符号

 显示带有SSID的呼叫标志。
 当对象或项目的状态完成时，将显示“KILLED” 。

 发射格式为NMEA时，不显示符号或SSID。
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.


0°

90°270°

180°

45°

135°225°

315° N

E

S

W

D 设置显示类型 (MAIN/SUB)(主/副)
可以选择接收界的显示类型。

1. 显示接收屏幕时按下[QUICK] 。
2. 选择 “Display Select (MAIN/SUB) ” 。

3� 选择要切换的项目。

• Latest (MAIN/SUB)

• MAIN

• SUB:

.







GPS 操作(高级版)

查看位置数据
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D更改GPS存储或警报 
可以在GPS POSITION屏幕中，更改GPS 
Memory(GPS存储)或GPS Alarm(GPS报警)。

1. 在MEM屏幕或ALM屏幕的同时，按[QUICK]。
2. 选择 “GPS Memory Select” 或选择

“Alarm Select”。�

MEM 屏幕界面

ALM 屏幕界面

3� 在GPS位置上选择显示的GPS存储或GPS警报。

.

00

09

08

07

06

05
04

03
02
01

19

18

17

16

15
14

13
12
11

29

28

27

26

25
24

23
22
21

10 20

01 11 21

221202

231303

241404

90

99
98
97

96

95
94

93
92
91

91

92

93

94

80

89
88
87

86

85
84

83
82
81

81

82

83

84

70

79
78
77

76

75
74

73
72
71

71

72

73

74

60

69
68
67

66

65
64

63
62
61

61

62

63

64

50

59
58
57

56

55
54

53
52
51

51

52

53

54

40

49
48
47

46

45
44

43
42
41

41

42

43

44

140°

40°

PN

PM

QN

QM

PM74SO
区域

正方形 辅助正方形

GPS 操作(高级版)

查看位置数据

坐标定位(GL)是一个压缩成6位字符代码的位置，由经
度和纬度计算得出。定位是简单地通过把地球表面分成
正方形来计算的。
它用于查找收发站的区域。

日本坐标定位图

 添加或编辑GPS存储：p. 6-22
 设置GPS警报：p. 6-27
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D  更改罗盘指针方向
您可以将罗盘指针方向设置为向上、向北或向
南。

1. 在GPS POSITION 显示界面, 按 [QUICK]。
2. 选择 “Compass Direction ”。

3. 选择指针方向。

D    保存自己或接收电台的位置

1. 选择要保存的屏幕。
保存您自己的位置：MY屏幕。
保存接收的位置：RX屏幕。

2. 按下[QUICK]。
3. 选择“Add To GPS Memory ”。

 详见 6-22 ~ 6-24页。 
4. 选择 “<<Add Write>> ”。

 要选择要保存的目标组，请选择 “GROUP”。

5. 选择 “YES ”。

• 将数据保存在GPS存储器中，然后返回到GPS
POSITION（GPS位置）屏幕。

6. 按[MENU]关闭 GPS POSITION 界面。

提示：位置保存在GPS MEMORY EDIT屏幕的选
定组中。（步骤4）
([MENU] > GPS > GPS Memory)

箭头总是向上
   的方向。

顶部总是向北。 顶部总是向南。 

GPS 操作(高级版)

查看位置数据

向上移动    北向上 南向上

您可以保存自己的位置和呼叫站的位置。
GPS有300个存储信道，这些信道可以分配到27个信
道群组中的 A ~ Z和(No Group)。
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1� 按[QUICK]。
2. 选择 “GPS Information ” 。

显示含义：

.

•• GPS: 01 ~ 32
•• SBAS: 33 ~ 71
•• GLONASS:	65 ~ 96
•• QZSS: 193 ~ 202

3. 按[MENU]，关闭GPS INFORMATION 界面。

查看GPS信息(天空视图界面) 

.

GPS 操作(高级版)

此界面用于查看GPS卫星信息。

GPS信息显示：GPS卫星的数量、信号功率和位置。天空视图界面显示GPS
卫星的位置。屏幕还显示方向、仰角、卫星号及其接收信号强度状态。

纬度
       海拔高度

天空视图屏幕

经度

跟踪卫星数量

• (     ): 正在追踪卫星。
• (     ): 弱信号跟踪卫星，用卫星编号表示。
• (  ): 强信号跟踪卫星，用卫星编号表示。
• (SAT): 跟踪卫星数量。
• 海拔高度: 电台的海拔高度。

 只有在跟踪4颗或更多卫星时才会显示高度。
当跟踪3个或更少的卫星时，将显示“---ft”。

•经度/纬度：电台所在位置的经度和纬度。

正在追踪卫星

0 度线 

30 度线 

60 度线

90 度线 (天顶)

06号卫星信号强 

N

W

E

S

仰角30度线

 仰角0度线

仰角60度线
仰角90度线(天顶)

 06 号卫星

06号卫星的图像
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 发送D-PRS数据

当选择D-PRS作为GPS发送模式时，您可以发送D-
PRS数据。
在D-PRS模式下操作时，以下代码会传输到电脑。
D-PRS代码基于APRS®代码。
（APRS®：自动数据包报告系统）

D D-PRS
D-STAR数据包报告系统（D-PRS）是一种在DV模式
下使用低速数据包空间同时发送从内部GPS接收器接收
的位置数据以及语音音频的模式。在模拟模式下，您一
次只能发送或接收语音音频或数据。然而，当正在发送
或接收语音时，具有D-PRS功能的无线电可以同时发送
或接收消息数据或GPS位置数据。需要I-GATE将位置
数据发送到APRS服务器。

D-PRS图像

D-STAR 中继

<使用中继>

<单工

语音, 信息, 和
D-PRS 位置

I-GATE

APRS服务器

INTERNETINTERNET

PC

JA3YUA-Z

可以在地图上面查看位置

D-PRS 位置

D-PRS 位置

D-PRS 
位置

来自APRS 网络的信息

D在D-PRS模式下操作
要传输D-PRS数据，请执行以下步骤。有关更多详细
信息，请参阅随步骤一起列出的页面。

1. 输入“MY” (自己呼号)。
(基本手册D-STAR指南)

2. 确认GPS信号正在接收。
3. 将GPS发送模式设置为“D-PRS”（第6-14页）
4. 设置发送信息。
您必须设置“SSID”和“Symbol”。

([MENU] > GPS > GPS TX Mode > D-PRS)
↓

完成！您可以在D-PRS模式下进行传输。

提示：在D-PRS模式下，除了位置数据外，您还可以
传输地震或天气信息。
([MENU] > GPS > GPS TX Mode > D-PRS > TX Format)
TX format of D-PRS
• Position (移动台/基地台):

• Object:

• Item:

用于传输位置数据。
用于传输特定位置数据。（包含时间标
记。）
用于传输特定位置数据。（不包含时间
标记。）

• Weather: 用于传输天气信息。

注意:
• 如果“GPS select”设置为“Manual(手动)”，则“Manual

position”中,手动输入的位置数据将更改为要传输的D-
PRS数据格式。
([MENU] > GPS > GPS Set > GPS Select)

• 请注意，如果“GPS Auto TX” 设置为“OFF”以外的任何其
他设置，则会根据设置的时间进行发送。
([MENU] > GPS > GPS Auto TX)

GPS 操作(高级版)

语音, 信息, 和
D-PRS 位置

语音, 信息, 和
D-PRS 位置

语音, 信息, 和
D-PRS 位置
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D-PRS
位置 目标 项目

天
气

移
动

站

基
站

数
据

扩
展

：
关

闭

数
据

扩
展

：
航

向
/速

度

数
据

扩
展

：
功

率
/高

度
/增

益
/方

向
性

数
据

扩
展

：
关

闭

无标题地址 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

备注 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

海拔高度 ✓ ✓

对象名称/
项目名称 ✓ ✓ ✓ ✓ ✓ ✓

数据类型 ✓ ✓ ✓ ✓ ✓ ✓

位置信息
（纬度/经度/海拔高
度）

✓ ✓ ✓ ✓ ✓ ✓

数据扩展 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

航向 ✓ ✓

速度 ✓ ✓

功率 ✓ ✓ ✓

高度 ✓ ✓ ✓

增益 ✓ ✓ ✓

方向性 ✓ ✓ ✓

符号 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

SSID ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

时间标记 ✓ ✓ ✓ ✓ ✓ ✓

✓: 显示

发送D-PRS数据

D 项目显示
根据TX格式的不同，设置项目和项目的显示顺序不同。

GPS 操作(高级版)

数
据

扩
展

：
航

向
/速

度

数
据

扩
展

：
功

率
/高

度
/增

益
/方

向
性
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D 设置 D-PRS 位置 (移动站/基站)
设置为作为D-PRS位置（移动/基站）进行传输。
 详见 6-31页。

1.将GPS发送模式设置为D-PRS

[MENU] > GPS > GPS TX Mode > D-PRS

2. 检查无标题的地址
建议使用默认地址，不建议进行编辑。

3. 将发送格式设置为“Position”
将 “TX Format”设置为“Position ” 。

4. 选择符号
选择指示您的操作情况的符号。
 详见 6-31 页。

5. 选择 SSID
为了帮助识别您的电台类型，请在D-PRS数据呼号后
选择基于APRS®（自动数据包报告系统）的SSID。
（第6-32页）

6. 输入备注
输入注释，并将其与D-PRS位置数据一起传输。
您可以输入的字符数不同，
取决于数据扩展和海拔设置。（第6-32页）
1. 选择“Comment”。
2. 按 [QUICK]。
3. 选择“Edit ”。
4. 输入备注。
5. 输入完成后, 按[ENT]。
6. 再次按[ENT]。

7. 设置时间标记
设置时间戳功能，以UTC（协调世界时）时间传输接
收到的时间数据。（第6-32页）

8. 设置海拔高度
设置是否发送从GPS接收器获取的高度数据。
(p. 6-33)

注意：如果在海拔设置为ON的情况下进行传输，则
字符串将包含在无法显示海拔的产品的注释中。
（第6-4页）

发送D-PRS数据

9. 设置数据扩展
设置电台信息的数据扩展。 
将“数据扩展”设置为“航向/速度”以作为移动站进行传输。
 将“数据扩展”设置为“功率/高度/增益/方向性”，以作为基站
进行传输。

将 “Data Extension” 设置为 
“Power/Height/Gain/Directivity”:
9-1.设置发射功率
选择要与位置数据一起发送的基站的TX功率电平。

9-2. 设置天线高度
选择要与位置数据一起发送的基站天线的高度。       

9-3. 设置天线增益
选择要与位置数据一起发送的基站天线的增
益。

9-4. 设置天线方向
.


10. 退出POSITION界面
.
•返回待机界面，并显示"            "。

GPS 操作(高级版)
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D 设置 D-PRS 目标/项目
设置发射的 D-PRS目标/项目。
详见6-31页。

1. 设置 GPS发射模式为 D-PRS

[MENU] > GPS > GPS TX Mode > D-PRS

输入目标或项目名称，例如事件信息或位置。

5. 选择数据类型
设置目标或项目状态。
  例如，如果您想将完成的事件信息作为目标传输，请

将数据类型设置为“Killed Object”

6. 设置符号
选择表示目标象或项目的符号。
 详见6-31页。

7. 输入备注
输入要作为目标或项目传输的备注。 
 您可以输入的字符数不同，具体取决于数据扩展和海拔

设置。(pp. 6-34, 6-36) 

8. 输入位置数据
输入目标或项目位置数据。
   .





输入目标或项目的速度。

将Data Extension”设置
“Power/Height/Gain/Directivity”:
9-3. 设置发射功率
如果是中继，设置目标或项目的发射功率。 

9-4. 设置天线高度

选择目标或项目天线的高度。

9-5. 设置天线增益
选择目标或项目天线的增益。

9-6. 设置天线方向
.

10. 选择SSID
为了帮助识别您的电台类型，请在D-PRS数据呼号
后选择基于APRS®(自动数据包报告系统)的SSID。
(第6-32页）

11.设置时间标记
 当发送格式为“Object”时，会显示此项目。
设置时间标记功能，以UTC(协调世界时)时间传输接
收到的时间数据。（第6-35页）

12. 退出BJECT或ITEM 界面
.
•  

GPS 操作(高级版)

发送D-PRS数据

2. 检查无标题的地址

建议使用默认地址，不建议进行编辑。

3. 将发送格式设置为 “Object”或“Item”
将 “TX Format”设置为“Object” 或 “Item ”。 

4. 输入目标名称或者项目名称

1. 选择“Comment”。
2. 按 [QUICK]。
3. 选择“Edit ”。
4. 输入备注。
5. 输入完成后, 按[ENT]。
6. 再次按[ENT]。

9. 设置数据扩展

设置目标/项目数据扩展信息。 
将“数据扩展”设置为“航向/速度”以作为移动站进行传输。 
将“数据扩展”设置为“功率/高度/增益/方向性”，以作为基站
进行传输。

将 “Data Extension” 设置为 
“Power/Height/Gain/Directivity”:
9-1.设置航向
当工作站移动时，输入目标或项目的路线。

9-2. 设置速度

增

返回待机界面，并显示"            "。
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D 设置D-PRS 天气
设置为作为D-PRS气象站发送。
 详见第6-31页。

1. 将GPS发送模式设置为D-PRS

[MENU] > GPS > GPS TX Mode > D-PRS

选择指示气象站的符号。 
 请参阅第6-31页，直接输入符号。

5. 选择 SSID
为了帮助识别您的电台类型，请在D-PRS数据呼
号后选择基于APRS®(自动数据包报告系统)的
SSID。(第6-32页）

输入备注
输入要作为D-PRS气象站传输的备注。

设置时间戳功能，以UTC(协调世界时)时间传输接收
到的时间数据。（第6-38页）

8. 退出WEATHER 界面
.

GPS 操作(高级版)

发送D-PRS数据

2. 检查无标题的地址

建议使用默认地址，不建议进行编辑。

3. 将发送格式设置为 “Weather”。

将 “TX Format”设置为“Weather” 。 

4. 选择符号

1. 选择“Comment”。
2. 按 [QUICK]。
3. 选择“Edit ”。
4. 输入备注。
5. 输入完成后, 按[ENT]。
6. 再次按[ENT]。

7. 设置时间标记

• 返回待机界面，并显示"            "。
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.









.







天气设备 

微型计算机

PC

USB 电缆
(用户自备)

或
到[USB] 端口

.

• Port:  对讲机*使用的COM端口号。 
• Baud rate:  需要的速率

8 bit
无
1 bit

• Data:
• Parity:
• Start:
• Stop: 1 bit
• Flow control: 无

* .




D确认天气数据输入
您可以确认天气数据是否从[USB]端口输入。
1. 将“GPS TX Mode”设置为“D-PRS”，将“TX
format”设置为“Weather”（第6-16页）
2. 在待机屏幕上，按下[QUICK]。
3. 选择 “Weather Information ”。
 如果天气数据输入正确，则显示WEATHER
      INFORMATION界面。
当天气信息显示时，您可以作为气象站进行传输。
    如果屏幕上显示“-”，则不输入天气数据。在这种情
    况下，请检查输入的数据设置。

D天气数据内容
天气数据应按照如下所示的格式(基于APRS®天气数
据)输入。

示例:
220/004 g005 t077 r000 p000 P000 h50 b09900 End code
1	 2	 3	 4	 5	 6	 7	 8	 9
序号. 项目 数值 单位

1 风向 000 - 360 °
2 风速 000 - 999 mph
3 阵风速度 g000 - g999 mph

4 温度 t-99 - t-01,
t000 - t999

°F

5 降雨 r000 - r999*1 inch
6 雨量 (24 小时) p000 - p999*1 inch
7 雨量 (午夜) P000 - P999*1 inch

8 湿度 h00, h01 - h99
(h00 增加100%.)

%

9 气压 b00000 - b99999*2 hPa,
mb

*1 最后两位数字表示小数点后一位和小数点后两位。
*2 最后一位数字表示小数点后一位。
 如果没有数据，请输入空格或“.”（句点），而不是数字。

(示例: “.../...g...t077r000p...P...h50b.....”)
.

GPS 操作(高级版)

发送D-PRS数据
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.









.

              你可以在网上查一下！

PC 智能手机

.


← 你的符号和呼号

GPS 操作(高级版)

发送D-PRS数据

D 使用地图软件显示您的位置
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提示:
D-PRS数据备注
D-PRS 数据内容如下所示

D位置 (移动端)
(e�g�)

(e�g�)

D位置(基站)

(e�g�)

D目标对象

(e�g�)

D项目

(e�g�)

D天气

q w e r
o

iu
o

!1 !3 !4!0

!0

JA3YUA-A>API52,DSTAR*:/002338h3437�38N/13534�29E>090/002/A=000012ID-52 OP�SATOH

q w e r
o

i

i

u

u

u

o
!2

!2

!4!0

JA3YUA-A>API52,DSTAR*:/002338h3437�38N/13534�29E-PHG5132OP�SATOH

q w e r
o

yt
o

!4

JA3YUA-A>API52,DSTAR*:;HAM FESTA*012345z3437�38N\13534�29Eh2021�11�01 am10-pm4

!0iq w e r
o

yt
o

!4

JA3YUA-A>API52,DSTAR*:)REPEATER!3454�00N/13536�00ErPHG5132439�39MHｚ DV RPT JP3YHH A

!5 !6 !7 !8 !9 @0 @1 @2!0iq w e r
oo

JA3YUA-A>API52,DSTAR*:/012345z3454�00N/13536�00E_220/004g005t077r000p000P000h50b09900

q呼号

e无标题的地址 
rD-PRS 数据类型
    / 带有时间标记的位置

! 没有时间戳的位置 
    ; 目标对象  
    ) 项目
t对象名称/项目名称 
y数据类型

* 有效目标
! 有效项目
_ 停止的目标/停止的项目 

u时间标记 (UTC)
    h 时分秒     
    z 天时分
i纬度
o符号
⑩经度
⑪数据扩展 (方位/速度)

方位:0 ~ 360°
速度:0 ~ 999 knots

!2数据扩展(PHG 编码)
wSSID    PHG代码定义

⑬海拔高度
99999 ~ 999999 英尺
⑭备注
⑮风向/风速

!6

风向:0 ~ 360°
风速: 0 ~ 999

    mph 阵风速度
0 ~ 999 mph

⑰温度
99 ~ 999华氏度

⑱雨量
0 .00 ~ 9.99英寸

⑲雨量 (24 小时)
0�00 ~ 9�99 英寸
⑳雨量(午夜)

0�00 ~ 9�99 英寸 
@1湿度
    1 ~ 99%, 00=100%
@2大气压

    0�0 ~ 9999�9 hPa

第一: 功率

第二: 高度

第三: 增益

第四: 方向性

0

0

10

0

omni

2

4

40

2

90°E

3

9

80

3

135°SE

4

16

160

4

180°S

5

25

320

5

225°SW

6

36

640

6

270°W

7

49

1280

7

315°NW

8

64

2560

8

360°N

9

81

5120

9

−

(W)

(feet)

(dB)

−

1

1

20

1

45°NE

GPS 操作(高级版)

发送D-PRS数据
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传输NMEA数据

在DV模式下,设置GPS语句,以传输GPS数据。

D 设置GPS数据句式

 GPS 句式内容

句式 Lon
/Lat Alt UTC Date

(UTC) Status 2D
/3D

COG
(True)

SOG
(knot) Others

RMC ✔ ✔ ✔ ✔ ✔ ✔ 磁性变化，模式指示器。

GGA ✔ ✔ ✔ ✔
正在使用的卫星数量、HDOP、地磁分
离、差分GPS数据年龄、差分参考站ID

GLL ✔ ✔ ✔ 模式指示

VTG ✔ ✔
COG（磁北）、SOG（km/h）、模
式指示器

GSA ✔ ✔
解决方案、PDOP、HDOP、VDOP中使
用的卫星的PRN数量

GSV 句子总数、句子数、视图中的卫星总
数、卫星信息（ID、海拔、方位、S/N）

1. 按[MENU]。
2. 在“GPS”菜单，选择 “GPS TX Mode” 。
3. 选择 “NMEA ”。
4. 选择 “GPS Sentence ” 。�

5� 选择GPS 句式。

• 句式设置为ON时显示“       ”。
 可选择的GPS句式有RMC,GGA,GLL,VTG,GSA和

        GSV。GGA句式设置为ON为默认的GPS句式。 
 要重置为默认设置，请按[QUICK]，然后选

 择“Default”。

[MENU] > GPS > GPS TX Mode > NMEA > GPS Sentence

.



注意:
• 当向传统数字对讲机发送GPS信息时，将“GSV

Sentence”设置为“OFF”。（第6-4页）
• 如果“GPS Select”设置为“Manual”，对讲机会自动设置

NMEA语句，并将其与“Manual position”中手动输入的
位置数据一起发送。
([MENU] > GPS > GPS Set > GPS Select)
([MENU] > GPS > GPS Set > Manual Position)

• 请注意，如果“GPS Auto TX”设置为“OFF”以外的任何其
他选项，数据将根据设置的时间自动发送。
([MENU] > GPS > GPS Auto TX)
.


GPS 操作(高级版)

• 返回待机界面，并显示"            "。
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传输NMEA数据

D 设置GPS信息
输入要与位置数据一起发送的GPS信息。

示例: 输入 “OSAKA Suzuki”

[MENU] > GPS > GPS TX Mode > NMEA >  
GPS Message

5. 选择 [QUICK]。
6. 选择 “Edit ”。

7. 输入最多20个字符的GPS信息。

详见第iii 字符说明。 
8. 输入完毕, 按[ENT]。

.
9. 按[MENU]关闭 “GPS Message” 界面。

注意:
.


.

[MENU] > GPS > GPS Auto TX

如果设置此功能，GPS数据将根据设置的时间自动传
输。
如果对讲机中未输入您的呼号(MY)，则此功能不会激活。
如果“GPS Select”设置为“OFF”或“Manual”，则此功能不会
    激活。 

([MENU] > GPS > GPS Set > GPS Select)

GPS自动传输

GPS 操作(高级版)

1. 按[MENU]。
2. 在“GPS”菜单，选择 “GPS TX Mode” 。
3. 选择 “NMEA ”。
4. 选择 “GPS Message ” 。 
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GPS 存储

.






D添加GPS存储
示例: 将“HOME” 添加到(无组)。

1. 添加GPS存储信道并进入编辑模式

[MENU] > GPS > GPS Memory

.

3� 选择 “(No Group) ” 。

4� 按[QUICK]。
5� 选择“Add ” 。

.

.



GPS 存储信道

(无组)

B: HAM festa

A: ICOM

C: Railroad

Z:

Icom Osaka HC

Tokyo Big Sight

Dayton Hamventio

.

Icom America

Friedrichshafen

2.输入GPS存储信道名称
1� 选择 “NAME ”。
2. GPS 命名不超过16 个字符。(示例: HOME)

 详见第 iii 字符输入。
3. 输入完成，按[ENT]。

GPS 操作(高级版)

1. 按[MENU]。
2. 在“GPS”菜单，选择 “GPS TX Memory” 。



6

6-23

GPS 存储

D 添加GPS存储(续) 
3.输入GPS存储数据
1. 选择 “DATE ”。
2. 按D-pad() 移动光标。
3. 旋转[DIAL] 输入数据
 时间在 2000/01/02 ---2099/12/30之间设置。

4. 重复 2 和 3 输入数据。

5� 输入完成，按[ENT]。

4. 输入GPS 存储时间

5. 输入GPS存储纬度

 相关信息
• 在 0°00.00′-- 90°00.00′之间设置。
• 可以改变单位。

( [MENU] > SET > Display > Display Unit >
Latitude/Longitude)

• 要输入北纬，选择“N”，要输入南纬，选择“S”

4� 重复 2 和 3 输入纬度。

GPS 操作(高级版)

1. 选择 “TIME ”。
2. 按D-pad() 移动光标。
3. 旋转[DIAL] 输入数据

时间在 00:00:00 --23:59:59之间设置。
4. 重复 2 和 3 输入数据。

5� 输入完成，按[ENT]。

5� 输入完成，按[ENT]。

1. 选择 “LATITUDE ”。
2. 按D-pad() 移动光标。
3. 旋转[DIAL] 输入纬度

6. 输入GPS存储经度

1. 选择 “LATITUDE ”。
2. 按D-pad() 移动光标。
3. 旋转[DIAL] 输入经度

 相关信息
• 在 0°00.00′ --180°00.00′之间设置。
• 可以改变单位。

( [MENU] > SET > Display > Display Unit > Latitude/
Longitude)

• 若要输入东经，请选择“E”，若要输入西经，则选
择“W”

4� 重复 2 和 3 输入经度。

5� 输入完成，按[ENT]。



6

6-24

8. 选择 GPS 存储群组
1. 选择 “GROUP ” 。

2. 群组为在(无组) 和 A ~ Z之间循环。

.

9. 写入 GPS信道
1. 选择“<<Add Write>> ”。

• 此时将显示确认对话框。
如果编辑以前添加的GPS信道，
     请选择“<<Overwrite>>”。 

2. 选择 “YES ”。

.


.

.



.




GPS 操作(高级版)

GPS 存储

D 添加GPS存储(续) 
3.输入GPS海拔高度
1. 选择 “ALTITUDE ”。
2. 旋转[DIAL] 增加或者减少数值。
3. 按D-pad() 移动光标。
4. 旋转[DIAL] 输入海拔高度。
   在 –32808 ---- +32808 之间设置。

5. 重复 3 和 4 输入海拔高度。 

6� 输入完成，按[ENT]。
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GPS 存储

.


[MENU] > GPS > GPS Memory
1. 按 [MENU]。
2. 在“GPS”菜单，选择“GPS Memory” 。

3. 选择要输入名称的组。

不要按[ENT]。
4. 按[QUICK]。
5. 选择 “Edit Name ” 。

6� 输入最多16个字符的组名。

 详见第iii页字符说明。
7. 完成输入按 [ENT]。

D 删除GPS存储内容
可以删除GPS存储内容。
有两种方法可以删除存储：
.




[MENU] > GPS > GPS Memory
示例: 删除群组E。

.
6. 选择 “YES ” 。

.


提示: 删除特定的GPS存储器
1. 选择要删除的GPS存储器，然后按[QUICK]。
2. 选择 “Delete ” 。

3. 选择 “YES ”。
.

GPS 操作(高级版)

不要按[ENT]。
4. 按[QUICK]。
5. 选择 “Edit Name ” 。

 按MENU]退出菜单。

1. 按 [MENU]。
2. 在“GPS”菜单，选择“GPS Memory” 。
3. 选择要删除的GPS存储的群组。�

 按MENU]退出菜单。

• 此时将显示确认对话框。
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[MENU] > GPS > GPS Memory

3. 选择要移动的GPS信道的群组。

4. 选择要移动的GPS存储器，然后按 [QUICK]。

5. 选择 “Move ” 。

.

6. 选择插入要移动的信道的位置。

.

.




GPS 存储

D 重新排列GPS数据的显示顺序
可以移动输入的GPS存储信道，以在选定的GPS存储群组中重新
排列其显示顺序。
要将GPS Memory移出指定的存储群组，请在GPS Memory EDIT屏
    幕中选择Memory，然后保存。

GPS 操作(高级版)

1. 按 [MENU]。
2. 在“GPS”菜单，选择“GPS Memory” 。
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GPS 报警

当目标站或位置进入警报区域时，对讲机以发出GPS警报。
此功能可设置为主叫站、所有GPS存储、选定的GPS存储群组或选定的GPS存储信道。

报警区域(组)(设置多个站）
当选择所有存储或GPS存储群组时：

站点C 
发出3提示声。

你的位置

站点A

站点B

0.
25

′
0.

25
′

0.25′ 0.25′
N

报警区域(接收/存储器)(设置特定电台)选择特定GPS
存储器时：

目标
站点

发出1提示声 发出3提示声

目标 约 1 km, 1094 Y

有限范围  约500米 547 Y

你的位置

N

GPS 操作(高级版)
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[MENU] > GPS > GPS Alarm
1. 按 [MENU]。
2. 在 “GPS” 选择“GPS Alarm” 。

3. 选择“Alarm Select ” 。

4. 选择 “Group ” 。

5. 选择“All Memories ” 。

• 返回GPS警报屏幕。
如果要将报警设置为特定的GPS存储群组，

     请选择“(No Group)”或“A”至“Z”。
要退出MENU屏幕，请按[MENU]。 

GPS 报警

D 为所有存储信道设置GPS报警功能(所有GPS存储信道）

相关信息
.





闪烁

GPS ALARM

.


提示：当在左侧的步骤5中选择“All Memories”、“No 
Group”或 GPS Memory group (A ~ Z)时，必须设
置“Alarm Area (Group)”才能使用GPS报警功能。
（第6-43页）
([MENU] > GPS > GPS Alarm > Alarm Area (Group))

GPS 操作(高级版)
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[MENU] > GPS > GPS Alarm

GPS 报警

D 为RX设置GPS报警功能(主叫站)

 相关信息
• 当带有GPS警报装置的电台进入大约1公里的范围内
时，它会发出一次声音。当它进入大约500米的范围内
时，警报会响起3次。

• 当对讲机发出GPS警报时，屏幕上显示“GPS
ALARM”，“     ”闪烁。请参见下图。

• 要取消GPS报警功能，请在左侧第4步中选择“OFF”。
闪烁

GPS ALARM

.



提示：当在左侧的步骤4中选择“RX”或特定的GPS信
道时，还必须设置“Alarm Area (RX/Memory)”报警区
域，才能使用GPS报警功能。（第6-44页）
([MENU] > GPS > GPS Alarm > Alarm Area (RX/Memory))

GPS 操作(高级版)

1. 按 [MENU]。
2. 在 “GPS” 选择“GPS Alarm” 。

3. 选择 “Alarm Select ” 。

4. 选择 “RX ” 。

• 返回GPS警报屏幕。
如果为特定的GPS群组设置报警功能，请选
     择Memory，然后在GPS存储群组中选择
     GPS 信道。
要退出MENU屏幕，请按[MENU]。  

屏幕上显示“GPS ALARM”，
警报响起3次。
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GPS 项目

注意：
下面显示的默认设置适用于美国对讲机版本。默认设置可能会有所不同，具体取决于您的对讲机版本。要返回对
讲机版本的默认设置，请按[QUICK]并选择“Default”。

� (默认: ON)

[MENU] > GPS > GPS Set > GPS Select
.



 
 
 在“手动位置”中手动输入当前的纬度、经度

和海拔高度

� (默认: OFF)

[MENU] > GPS > GPS Set > GPS Option > SBAS
打开或关闭SBAS(卫星增强系统)功能。
  

.


•• OFF:
•• ON:

.


GLONASS (默认: OFF)

[MENU] > GPS > GPS Set > GPS Option > GLONASS
选择是否使用GLONASS卫星的数据。
 

• OFF:
• ON:

.


� (默认: Auto)

[MENU] > GPS > GPS Set > GPS Option > 
Power Save

.



. 
•• 1, 2, 4, 8min:

•• Auto:

.










Satellite Information Out(卫星信息输出) 
(默认: GPS/QZSS/GLONASS)

[MENU] > GPS > GPS Set > GPS Option >  
Satellite Information Out

.
• GPS/QZSS/GLONASS:

.


• GPS Only:输出仅限GPS卫星数据。

Manual Position(手动位置)
    (默认:  纬度: 0°00.00′N, 

经度:0°00.00′W, ALTITUDE: ------ft)

[MENU] > GPS > GPS Set > Manual Position
手动输入当前位置的纬度、经度和海拔高度。
.



GPS 操作(高级版)

打开此功能时，可以提高GPS定位精度，但对讲机的电
池很快就会耗尽。
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� (默认: Person)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Symbol

.














可选择的字符和符号

<第一个字符> /, \, 0 to 9, A to Z
<第二个字符> A to Z, a to z, 0 to 9, ! “ #$ % & ’ ( ) 
* + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜

.
.

�

(默认: OFF)

[MENU] > GPS > GPS Set > GPS Out (USB Port)
.
• OFF: 不从USB端口输出位置信息。
• ON:  从USB 端口输出位置信息。 

� (默认: OFF)

[MENU] > GPS > GPS TX Mode
.

. 
• D-PRS: 以D-PRS格式传输GPS数据。

[MENU] > GPS > GPS TX Mode > D-PRS > 
Unproto Address

.

.


GPS 操作(高级版)

• NMEA：   以NMEA格式传输GPS数据。 

Unproto Address (无标题地址)
  (默认：: API52,DSTAR*) 

<  选择预设符号> 
1. 选择一个符号信道。

 不要按 [ENT]。
2. 按[QUICK]。
3. 选择 “Edit Symbol ”。
4. 选择符号。

• 将符号设置到步骤1中选择的符号信道中。
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GPS 项目

Comment(备注)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Comment

.




数据扩展 海拔高度
字符输入 
(最多)

OFF OFF 43 (默认)
OFF ON 35

方向/速度 OFF 36
方向/速度 ON 28

功率/高度/增益/方向性 OFF 36
功率/高度/增益/方向性 ON 28

.


可传输备注范围显示
（示例：最多28个字符）

� (默认: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Time Stamp

选择传输时间标记类型。
在D-PRS模式下，时间标记与位置数据一起传输，
并使用UTC(世界时)时间。
  手动设置位置时，不会传输时间标记数据。
• OFF: 不传输时间信息 
• DHM:  以天、小时和分钟格式传输时间标记。
• HMS:  以小时、分钟和秒的格式传输时间标记。

SSID� (默认： ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > SSID

选择基于APRS®的SSID添加到呼号中，向其他电台
显示您的操作风格。
  SSID的其他方法不同，这取决于呼号是否包含空格。

• ---: 呼号中的空格转换为“-”。
 如果在空格后没有输入文本，空格将被删

除，并且空格不会转换为“-”
示例:  JA3YUA → JA3YUA 

.
 

 如果呼号中包含空格，则空格后的任何文
本或数字都将被删除。 
示例:  JA3YUA → JA3YUA 

JA3YUA A → JA3YUA
. 

示例:  SSID 是 “-9” 。
JA3YUA → JA3YUA-9 
JA3YUA A → JA3YUA-9

. 
 示例:  SSID is是 “-Z ” 。

JA3YUA → JA3YUA-Z 
JA3YUA A → JA3YUA-Z

提示：关于SSID
根据通用指南，为了帮助识别电台的类型，
D-PRS(或APRS®)中使用指定的呼号SSID。
当基础设施环境（如产品或网络）发生变化时，指
南可能会发生变化。查看网站上与D-PRS和APRS®
相关的最新指南，并正确设置。
http://aprs.org/aprs11/SSIDs.txt

GPS 操作(高级版)
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GPS 项目

� (默认: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Position > Height

选择要与位置数据一起发送的基站天线的高度。
  

•选择10, 20, 40, 80, 160, 320, 640, 1280, 2560, 或
5120 feet.*
*如果海拔高度/距离单位设置为“m”，则选择3、6、12，

.

� (默认：0dB)

[MENU] > GPS > GPS TX Mode > D-PRS > 
 TX Format > Position > Gain

选择要与位置数据一起发送的基站天线的增益。
  

•在 0 - 9 dB之间选择

Directivity(方向性) (默认: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Directivity

选择基站天线指向的方向，以便与位置数据一起发送。 
 

.


�

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Object Name

.

� (默认: Live Item)

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Object > Data Type

.
. 
 

� (默认: Transceiver)

[MENU] > G(PS > GPS TX Mode > D-PRS 
> TX Format > Object > Symbol

.



� (默认: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Altitude

选择是否在D-PRS模式下发送高度数据和位置数据。
.



•• OFF: .
•   ON:         传输高度数据和位置数据。

Data Extension(数据扩展) (默认: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Data Extension

选择是否在D-PRS模式下传输航向/速度数据或功率/
高电平/增益/方向性数据以及位置数据。
 .



•• OFF: .
•• Course/Speed:

 将航向和速度数据与位置数据一起传输。
 当位置设置为手动时，航向和速度数据不会被
       传输。
 .


•• Power/Height/Gain/Directivity:

 传输TX功率电平、高度、天线增益、天
线方向和位置数据。
 即使您的位置是手动设置的，也会传输功
率、高度、增益和方向性数据。
 .



� (默认: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Power

选择要与位置数据一起发送的基站的TX功率电平。
当 “Data Extension”设置为“Power/Height/Gain/Directivity”。

.

GPS 操作(高级版)

当 “Data Extension”设置为“Power/Height/Gain/Directivity”。

当 “Data Extension”设置为“Power/Height/Gain/Directivity”。

当 “Data Extension”设置为“Power/Height/Gain/Directivity”。
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Comment(备注)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Comment

.




数据扩展 海拔高度

OFF — 43 (默认)
OFF 进入 35

方向/速度 — 36
进入 28

功率/高度/增益/方向性 — 36
功率/高度/增益/方向性 进入 28

GPS项目

Position (位置)
        (默认:  LATITUDE: 0°00.00′N, 

LONGITUDE:0°00.00′W, ALTITUDE: ------ft)

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Object > Position

.


.




.


.
.


 选择“N/S”可切换北纬和南纬。 
.



 选择 “E/W” 可选择东经和西经。
7. 选择[ENT]。
8. 选择 “ALTITUDE ”。
9. 输入海拔高度。

 输入后，选择[+/−]切换“+”和“−”。
10. 选择[ENT]。
11. 选择 “<<Write>> ”。
12. 选择“YES ”。

.

GPS 操作(高级版)

字符输入 
(最多)

方向/速度

显示的符号“    ”，是可传输的备注范围。请注意，超
出范围的字符将不会被传输。

可传输备注范围显示
（示例：最多28个字符）
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� (默认: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Gain

选择要与位置数据一起传输的目标对象天线的增益。

•在0 - 9 dB之间。

Directivity(方向性) (默认: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Directivity

选择要与位置数据一起传输的对目标象天线的增益。 

.


SSID� (默认: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > SSID

• ---:
• (-0):
• -1 ~ -15:
• -A ~ -Z:

(默认: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Time Stamp

� (默认: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Data Extension

选择是否在D-PRS模式下传输航向/速度数据或功率/
高电平/增益/方向性数据以及位置数据。
 .


•• OFF: .
•• Course/Speed:

.


•• Power/Height/Gain/Directivity:
.


� (默认: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Course

将对象的路线设置为0°到360°之间。
 当 “Data Extension”设置为“Course/Speed”。

� (默认: 0mph)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Speed

将对象的速度设置为0到1150英里/小时之间*
* 如果速度单位设置为“km/h”，则设置为0到1850 km/h
   之间，或设置为“节”，则将设置为0和999节之间。
 当 “Data Extension”设置为“Course/Speed”。 

� (默认: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Power

选择与位置数据一起传输的目标对象的TX功率电平。

.

� (默认: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Height

选择要与位置数据一起传输的目标对象天线的高度。

.





GPS 操作(高级版)

GPS项目

 当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

 当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

 当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

 当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

Time Stamp(时间标记) 

选择传输时间标记类型。
在D-PRS模式下，时间标记与位置一起传
输，并使用UTC(世界时)时间。
  手动设置位置时，不会传输时间标记数据。
• DHM:  以天、小时和分钟格式传输时间标记。
• HMS:  以小时、分钟和秒的格式传输时间标记。

选择基于APRS®的SSID添加到呼号中，向其他电台
显示您的操作风格。
  SSID的其他方法不同，这取决于呼号是否包含空格。

呼号中的空格转换为“-”。
未添加SSID。 
将-1到-15的SSID添加到呼号中。 
将-A到-Z的SSID添加到呼号中。 

. 有关SSID的详细信息，请参阅第6-32页。
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[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Item > Position

 当您想进入该位置时，请参阅第6-34页说明。 

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Data Extension

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Course

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Speed

�

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Item Name

.

(默认: Live Item)

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Item > Data Type

.
. 
 

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Item > Symbol

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Item > Comment

GPS 操作(高级版)

GPS项目

Data Type(数据类型) 

Symbol(符号) (默认: Transceiver)

符号是一个图标，表示对象的运输方式或位置。
在D-PRS模式下，保存的符号与位置数据一起发送。
有关编辑符号的详细信息，请参见第6-31页。

Comment(备注)

输入备注，以将其与D-PRS位置数据一起传输。
最多可以输入四条备注。
可以输入的字符数不同，具体取决于数据扩展和海拔高
度设置。

数据扩展 海拔高度

OFF — 43 (默认)
OFF 进入 35

方向/速度 — 36
进入 28

功率/高度/增益/方向性 — 36
功率/高度/增益/方向性 进入 28

字符输入 
(最多)

方向/速度

显示的符号“    ”，是可传输的备注范围。请注意，超
出范围的字符将不会被传输。

可传输备注范围显示
（示例：最多28个字符）

Position (位置)
        (默认:  LATITUDE: 0°00.00′N, 

LONGITUDE:0°00.00′W, ALTITUDE: ------ft)

显示对象的位置信息。按下[QUICK]键，打开如下所示
的快速菜单窗口。

提示：
当您选择“Capture From GPS”或“Set From GPS 
Memory”时，您可以从GPS位置或从GPS存储中设
置项目的位置。

Data Extension(数据扩展) (默认: OFF)

选择是否在D-PRS模式下传输航向/速度数据或功率/
高电平/增益/方向性数据以及位置数据。
 可以在备注中输入的字符数不同，具体取决于“海拔高

 度”和“数据扩展”设置。

• OFF: 不传输任何信息。
• Course/Speed:

 将航向和速度数据与位置数据一起传
输。

• Power/Height/Gain/Directivity:
 传输TX功率电平、高度、天线增益、

Course(航向

天线方向和位置数据。

) (默认: 0°)

将对象项目的路线设置为0°到360°之间。
 当 “Data Extension”设置为“Course/Speed”。

Speed(速度) 

将对象的速度设置为0到1150英里/小时之间*
* 如果速度单位设置为“km/h”，则设置为0到1850 km/h
   之间，或设置为“节”，则将设置为0和999节之间。
 当 “Data Extension”设置为“Course/Speed”。 
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GPS 操作(高级版)

GPS项目

Power(功率) (默认: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item> Power

•选择0, 1, 4, 9, 16, 25, 36, 49, 64, 或者 81 W。

Height(高度） (默认: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Height

•选择10, 20, 40, 80, 160, 320, 640, 1280, 2560, 或者
5120 英尺。*
* 如果“高度/距离”单位设置为“m”，则选择

3、6、12、24、49、98、195、390、780或1561米。 

选择与位置数据一起传输的项目的TX功率电平。 
 当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

选择要与位置数据一起传输的目天线的高度。戀 
 当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

Gain(增益) (默认: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item> Gain

•在0 - 9 dB之间。

Directivity(方向性) (默认: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item> Directivity

•选择Omni、45°NE、90°E、135°SE、180°S、
225°SW、270°W、315°NW或360°N。

SSID (默认: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > SSID

• ---:
• (-0):
• -1 ~ -15:
• -A ~ -Z:

选择要与位置数据一起传输的项目天线的增益。
  当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

选择要与位置数据一起传输的项目天线的增益。 
 当 “Data Extension”设置为“Power/Height/Gain/Directivity”。 

选择基于APRS®的SSID添加到呼号中，向其他电台
显示您的操作风格。

呼号中的空格转换为“-”。
未添加SSID。 
将-1到-15的SSID添加到呼号中。 
将-A到-Z的SSID添加到呼号中。 

  SSID的其他方法不同，这取决于呼号是否包含空格。
  有关SSID的详细信息，请参阅第6-32页。



6

6-38

GPS 操作(高级版)

GPS项目

SSID (默认: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Weather > SSID

• ---:
• (-0):
• -1 ~ -15:
• -A ~ -Z:

选择基于APRS®的SSID添加到呼号中，向其他电台
显示您的操作风格。

呼号中的空格转换为“-”。
未添加SSID。 
将-1到-15的SSID添加到呼号中。 
将-A到-Z的SSID添加到呼号中。 

  SSID的其他方法不同，这取决于呼号是否包含空格。
  有关SSID的详细信息，请参阅第6-32页。

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Weather > Symbol

Symbol(符号) (默认: WX Station)

符号是一个图标，表示气象站运输方式或位置。
在D-PRS模式下，保存的符号与位置数据一起发送。
有关编辑符号的详细信息，请参见第6-31页。

[MENU] > GPS > GPS TX Mode > D-PRS > 
TX Format > Weather  > Comment

Comment(备注)

输入备注，以将其与D-PRS位置数据一起传输。
最多可以输入43个字符。

Time Stamp(时间标记) (默认: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Weather > Time Stamp

选择传输时间标记类型。
在D-PRS模式下，时间标记与位置数据一起传
输，并使用UTC(世界时)时间。

• OFF: 不传输时间信息 
• DHM:  以天、小时和分钟格式传输时间标记。
• HMS:  以小时、分钟和秒的格式传输时间标记。
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� (默认: GGA)

[MENU] > GPS > GPS TX Mode > NMEA > 
GPS Sentence

.


.




 相关信息
.




�

[MENU] > GPS > GPS TX Mode > NMEA > 
GPS Message

输入最多包含20个字符的GPS信息。（第6-21页）

.


�

[MENU] > GPS > GPS Information
显示GPS卫星方向、仰角、卫星编号和接收状态。
（第6-11页）

.


句式 Lon/Lat Alt
GPS Time 

Stamp 
(UTC)

Date
(UTC) Status 2D/3D COG

(True)
SOG
(knot)

RMC ✔ ✔ ✔ ✔ ✔ ✔

GGA ✔ ✔ ✔ ✔

GLL ✔ ✔ ✔

VTG ✔ ✔

GSA ✔ ✔

GSV

其他

RMC 磁性变化，模式指示

GGA 正在使用的卫星数量、HDOP、地磁分离、差分GPS数据年龄、差分参考站ID

GLL 模式指示

VTG COG (地磁北极), SOG (km/h), 模式指示

GSA PRN 解决方案中使用的卫星数量, PDOP, HDOP, VDOP

GSV 语式总数、语句数、视图中的卫星总数、卫星信息（ID、高程、方位角、S/N）

GPS 操作(高级版)

GPS项目

句式

模式指示
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 GPS Position(GPS位置)

[MENU] > GPS > GPS Position
将显示您的当前位置、接收到的位置、GPS内存或
GPS警报位置信息。（第6-6页）

旋转[DIAL]以选择MY、RX、MEM和ALM界面。

MY界面 (我的位置)
Compass* .

Course .

Latitude .

Longitude .

GL .


ALT .

SPEED .

TIME .

 .



RX界面(接收到另一个电台的位置数据)根据呼叫者的TX
模式或TX格式，显示的项目和这些含义是不同的。以下
列表描述了每个类别的项目。当对讲机上没有接收到位
置数据时，不会显示任何数据。

<1. 当呼叫者的发送模式为NMEA时>

Compass* .

Latitude .

Longitude .

GL

ALT

DST .

Call sign .

COURSE .

SPEED .

GPS Time Stamp .


<2. 当呼叫者的TX格式为D-PRS位置时(移动站)>

Compass*

Symbol .

Latitude
Longitude

GL

ALT

DST

Call sign

COURSE

SPEED

GPS Time Stamp

* 可以在快捷菜单界面中更改显示类型。

GPS 操作(高级版)

GPS项目

根据呼叫者所在位置的纬度和经度
显示坐标定位。

显示呼叫者海拔高度。

显示呼叫者从您所在位置的方向。

显示呼叫者纬度。

显示呼叫者经度。

显示呼叫者与您所在位置的距离。

显示呼叫者的呼号(含 SSID)。

显示呼叫者在地面上的方向。

显示呼叫者在地面上的速度。

显示呼叫者获取位置数据的时
间。

根据呼叫者所在位置的纬度和经度
显示坐标定位。

显示呼叫者海拔高度。



6

6-41

<3.  当呼叫者的TX格式为D-PRS位置时 (基地站)>

Compass*

Symbol

Latitude
Longitude

GL

ALT

DST

Call sign

POWER
HEIGHT
GAIN

DIRECT

GPS Time Stamp

<4. 当呼叫者的TX格式为D-PRS对象/项目时 >

Compass* .


Symbol .

Latitude
Longitude

GL

ALT

DST

Object/Item name .

Call sign

COURSE

SPEED

POWER

HEIGHT

GAIN

DIRECT

GPS Time Stamp

 当对象或项目被禁用时，显示“KILLED” 。

GPS 操作(高级版)

GPS项目

GPS Position(GPS位置) (续)

显示呼叫者D-PRS 符号。

* 可以在快捷菜单界面中更改显示类型。

显示呼叫者从您所在位置的方向。

显示呼叫者纬度。

显示呼叫者经度。

显示呼叫者与您所在位置的距离。

显示呼叫者的呼号(含 SSID)。

显示呼叫者发射功率等级。

显示呼叫者天线高度。

显示呼叫者获取位置数据的时
间。

根据呼叫者所在位置的纬度和经度
显示坐标定位。

显示呼叫者海拔高度。

显示呼叫者天线增益。

显示呼叫者的天线指向的方向。

显示对象/项目纬度。

显示对象/项目经度。

显示对象/项目与您所在位置的距离。

根据对象/项目所在位置的纬度和
经度显示坐标定位。

显示对象/项目海拔高度。

显示对象/项目发射功率等级。

显示对象/项目天线高度。

显示对象/项目获取位置数据
的时间。

显示对象/项目天线增益。

显示对象/项目的天线指向的方向。

显示对象/项目的呼号(含 SSID)。

显示对象/项目在地面上的方向。

显示对象/项目在地面上的速度。
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<5. 当呼叫者的TX格式为D-PRS天气时>

Compass*

Symbol

Latitude
Longitude

GL

DST

Call sign

Temperature

Humidity

RAIN

WIND DIR

WIND SPD

BARO

GPS Time Stamp

MEM 界面 (GPS 存储位置)

Compass*

Latitude

Longitude

GL

DST

GPS memory name

 可以在快捷菜单界面中更改 GPS存储信道。 

ALM 界面 (GPS 报警位置)

Compass*

Latitude

Longitude

GL

DST

GPS Alarm

 可以在快捷菜单界面中更改GPS报警。 

GPS 操作(高级版)

GPS项目

GPS Position(GPS位置) (续)

显示呼叫者D-PRS 符号。

显示呼叫者从您所在位置的方向。

显示呼叫者纬度。

显示呼叫者经度。

显示呼叫者与您所在位置的距离。

显示呼叫者的呼号。

显示呼叫台所在区域的温度。

根据呼叫者所在位置的纬度和经度
显示坐标定位。

显示呼叫台所在区域的湿度。

显示呼叫台所在区域的降雨量。

显示呼叫台所在区域的风向。

显示呼叫台所在区域的风速。

显示呼叫台所在区域的气压。

显示呼叫者获取位置数据的时
间。

* 可以在快捷菜单界面中更改显示类型。

显示GPS存储信道从您所在位置
的方向。

显示GPS存储信道纬度。

显示GPS存储信道经度。

显示GPS存储信道与您所在位置
的距离。

显示GPS存储信道的名称。

根据GPS存储信道所在位置的纬
度和经度显示坐标定位。

显示GPS报警区域从您所在位置
的方向。

显示GPS报警区域纬度。

显示GPS报警区域经度。

显示GPS报警区域与您所在位置
的距离。

显示为GPS报警功能指定
的“RX”、GPS存储群组名称或
GPS存储信道名称。

根据GPS报警区域所在位置的
纬度和经度显示坐标定位。
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[MENU] > GPS > GPS Memory
对讲机具有300个GPS存储信道来存储接收数据或者
常用位置数据。
信道可分为(No Group)组和每个信道群组(A至Z)，
以便于信道管理。

显示GPS MEMORY界面

(No Group) GPS存储信道未分配给任何群组
中。

A ~ Z: Group Name .

GPS 信道群组(A ~ Z)

GROUP NAME GPS 信道群组名称
(最多16个字符)

 可以编辑GPS信道群组名称。 (p. 6-25)

GPS存储信道

NAME

DATE 数据保存

TIME 时间保存

LATITUDE 位置保存(纬度)
LONGITUDE
ALTITUDE

GROUP 群组字母和组名称

 当接收到的位置数据保存在GPS position界面上时，
         接收到的电台呼号将用作GPS 信道名称。
 在快速菜单窗口中，可以编辑GPS信道内容，
    例如GPS存储信道名称。 

� (默认: OFF)

[MENU] > GPS > GPS Alarm > Alarm Select
.

• OFF:
• RX:

• Group:

• Memory:

.









� (默认: 0.25′)

[MENU] > GPS > GPS Alarm > Alarm Area (Group)
.





• 纬度/经度=ddd°mm.mm'
范围：00.08′至59.99′（0.01′步进）

• 纬度/经度=ddd°mm′mm〃
范围：00′05〃至59′59〃（0′01〃步进）

• 纬度/经度=ddd.dddd°
范围：0.0014°至0.9999°（0.0001°步进）
按 D-pad() 将光标移动到十分位数和百分位数，

      或千分位数和万分位数。 

.



站点 C
3次提示音

你的位置

站点A

站点B

0�
25

′
0�

25
′

0�25′ 0�25′
N

GPS 操作(高级版)

GPS项目  

GPS Memory(GPS存储信道)

GPS 信道名称
(最多16个字符)

位置保存(经度)
海拔高度保存
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Alarm Area (RX/Memory)� (默认: Both)

[MENU] > GPS > GPS Alarm >  
Alarm Area (RX/Memory)

选择GPS激活报警范围。
当目标进入活动警报范围时，GPS警报响起，GPS警
报图标闪烁。 
 当“Alarm Select” 设置为 “RX” or “Memory” 时，此设置被
启用。（第6-43页）

.











• Limited:

• Extended:

• Both:

.




目标站点

响起1声提示音。 响起3声提示音

有限范围约500米，547Y

扩展范围约1公里，1094 Y

你的位置

N

GPS Logger� (默认: ON)

[MENU] > GPS > GPS Logger
.


.


.





 此功能需要一个microSD卡（用户自备）。
 当“GPS select”设置为“OFF”或“Manual”时，此功能不会
     保存日志。

提示：日志数据保存在microSD卡上。文件名将自动
创建，如下所示:
• 日志开始日期和时间：2021 11月1日15:30:00
• 文件名: 20211101_153000�csv

� (默认: 10sec)

[MENU] > GPS > GPS Logger > Record Interval
.


推荐句式：
(默认: ✔  RMC/ ✔  GGA/ ✔  VTG/ ✔  GSA)

[MENU] > GPS > GPS Logger > Record Sentence
.

.

.


<<GPS Logger Only>>（仅限GPS记录）

[MENU] > GPS > GPS Logger > 
<<GPS Logger Only>>

.



 相关信息
.



GPS 操作(高级版)

GPS项目
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(默认: OFF)

[MENU] > GPS > GPS Auto TX
.




• OFF:  不会自动传输位置数据。（当按下[PTT]时，
对讲机会传输位置数据。）

•• 30 sec to 30 min:
.


GPS 操作(高级版)

GPS项目  

GPS Auto TX (GPS自动传输)
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7 语音传输功能

7-2

Voice TX (语音传输)功能以设定的时间间隔一次性
或重复传输microSD卡上录制的音频，最多传输10
分钟。

此功能便于重复调用CQ，或用于其他传输。

可以将[Voice TX]键功能，分配给可选的麦克风按键
或可选的蓝牙耳机。（第12-18、12-34页）

.


语音传输功能

D 录制语音
[MENU] > VOICE > Record

1. 按[MENU]。
2. 选择 “VOICE ” 。
3. 选择 “Record ” 。

.

 相关信息
.





.



.
.

音量大小
录音时间

.




播放时显示 

回放时间

总时间

录音时显示 
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语音传输功能

.


[MENU] > VOICE > <<Single TX>>

[MENU] > VOICE > <<Repeat TX>>

.


.


 相关信息
••
••
传输时，SD卡图标会闪烁。
当您选择<<Repeat TX>>时，对讲机会按“Repeat Time(重复
时间)”中设置的间隔，重复传输录制的语音长达10分钟 。
([MENU] > VOICE > TX Set > Repeat Time)

• 以下任何操作都会取消传输。
-按下[PTT]
-关闭对讲机，然后再次打开。
-按下任意键（[VOL]和[   ]除外）

• 第二次传输后，如果接收到信号，即使““Busy Lockout(忙
锁定)”设置为“ON”，传输仍会继续暂停
([MENU] > SET > Function > Busy Lockout)
但是，如果在FM模式下手动打开静噪，则会根据“Repeat
Time(重复时间)”设置重复传输语音音频。

• 可以选择是否从扬声器输出传输语音。
([MENU] > VOICE > TX Set > TX Monitor)

提示: 
要在快捷菜单窗口中，传输录制的语音，请按 
[QUICK]，然后选择“Voice TX”。

D 传输录制的音频

闪烁

传输暂停 

语音传输功能

1. 按[MENU]。
2. 选择 “VOICE ” 。
3. 选择 “<<Single TX>>” 或“<<Repeat TX>>”。
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Record(录制)

[MENU] > VOICE > Record
.




� (默认: 5sec)

[MENU] > VOICE > TX Set > Repeat Time
.


.




� (默认: ON)

[MENU] > VOICE > TX Set > TX Monitor
.

• OFF:  无法从扬声器中听到传输的语音。 
. 

语音项目

<<Single TX>>单次传输

[MENU] > VOICE > <<Single TX>>
录制的语音只传输一次。

 在快捷菜单中选择 “Single TX” 。
([QUICK] > Voice TX > Single TX)

<<Repeat TX>>多次传输

[MENU] > VOICE > <<Repeat TX>>
.


 相关信息
• 在快捷菜单中选择 “Single TX” 。

([QUICK] > Voice TX > Repeat TX)
• 如果在传输过程中经过了10分钟，对讲机将继续
传输，直到完成完整的语音音频传输。

• 以下任何操作都会取传输。
-按下[PTT]。
-关闭对讲机，然后再次打开。
-按下任意键（[VOL]和[   ]除外）。�

语音传输功能
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8 录音功能

8-2

注意:

录制QSO音频

开始录音

.

停止录音
1� 按[QUICK]。
2� 选择 “<<REC Stop>>” 。

录音待机

.


 相关信息
.








提示: 
.












• 录音时必须插入SD卡。
• 一旦开始录音，即使您关闭了对讲机，录音也将持
续，直到停止录音。

• 无法录制调频收音机信号。��

1. 按[QUICK]。
2. 选择 “<<REC Start>>”。

• .
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播放录音

.


[MENU] > RECORD > QSO Recorder > Play Files
1. 按[MENU]。
2. 选择 “RECORD ”。
3. 选择“QSO Recorder ”。

4. 选择“Play Files”。

5� 选择要播放文件的文件夹。

文件夹命名为yyyymmdd (y: 年, m: 月, d: 日). 
.

.

VOICE PLAYER语音播放界面说明

快进[LO]/快退[CD]
.









播放之前的文件 [RX→CS]
.





.






提示：选择要显示的记录文件类型。
在步骤6中，按下[QUICK]，然后选择“Display 
File”并选择要显示的记录文件类型。

• ALL: 显示所有录制的文件。
• A only: 仅显示在A频段上录制的音频文件。
• B only: 仅显示在A频段上录制的音频文件。

频段 (A/B)

TX/RX
            操作模式
操作频率

总播放时间

录制时间

.


频段 (A/B)
TX/RX操作信息 

录制开始日期
和时间

播放时间/和时
间

[RX→CS] 
播放之前的文件

[LO] 快进

            [ ENT] 暂停或播放
[DR] 播放下一个文件

[CD] 
快退

录音功能
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更改QSO录制设置

[MENU] > RECORD > QSO Recorder >  
Recorder Set > RX REC Condition

 默认设置为 “Squelch Auto(自动静噪)”
     (仅在静噪打开时记录）。

将QSO音频录制为一个文件

[MENU] > RECORD > QSO Recorder >  
Recorder Set > File Split

 



.





在所选频段(MAIN主频段)上单独开始或停止录制

[MENU] > RECORD > QSO Recorder >  
Recorder Set > REC Operation

 .

.


 将录音同步到PTT

[MENU] > RECORD > QSO Recorder >  
Recorder Set > PTT Auto REC

 默认设置为“ON”(录音与PTT同步) 。

提示：当 “PTT Auto REC” 设置为 “ON”
.





更改跳过时间

[MENU] > RECORD > QSO Recorder >  
Player Set > Skip Time

 默认为“10sec ”。

录音功能
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删除音频文件/文件夹

.

D 删除音频文件夹
.

[MENU] > RECORD > QSO Recorder > Play Files
1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “QSO Recorder ” 。

4. 选择 “Play Files ” 。

5. 选择要删除的文件夹。

不要按[ENT]。
6. 按 [QUICK]。
7. 选择“Delete ” 。

.
8. 选择 “YES ” 。

.


.


录音功能



8

8-6

删除音频文件夹/文件

D 删除音频文件
[MENU] > RECORD > QSO Recorder > Play Files

4� 选择 “Play Files ”。

5� 选择包含要删除的文件的文件夹 。

6� 选择要删除的文件。

7. 按 [QUICK]。
8. 选择“Delete ” 。

• “Display File”是“ALL”

• “Display File” 是 “A only”

• “Display File” 是 “B only”

录音功能

1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “QSO Recorder ” 。

不要按[ENT]。

• 显示确认删除对话框。
9. 选择 “YES ” 。

• 文件被删除。
按[MENU]退出菜单。 

提示：删除所有文件
在上面的步骤8中，选择“Delete All”。
 如果显示文件设置为 “A only” 或 “B only”， 

 只删除显示的文件。
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查看文件信息
.


[MENU] > RECORD > QSO Recorder > Play Files

4� 选择 “Play Files ” 。

5. 选择查看音频文件的文件夹。

6. 选择查看音频文件。

8� 选择 “File Information ” 。

.
.

.



文件名
文件总数(总大小)
创建日期和时间

录音功能

1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “QSO Recorder ” 。

7. 按 [QUICK]。
不要按[ENT]。
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查看文件信息

文件信息示例
 根据记录状态的不同，某些数据可能无法显示。
 文件的命名格式如下:  yyyymmdd_hhmmss  

(yyyy:年, mm: 月, dd: 日, hh: 时, mm: 分, ss: s秒)

•传输音频文件信息 •接收音频文件信息
操作信息（TX）
录制日期和时间

我的站点信息

DR 设置

文件数据

呼叫者和接收中继器

接收站点信息

录音功能

操作信息（RX）
录制日期和时间

我的站点信息

文件数据
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使用录音功能

.


.


D 开始录音
.




[MENU] > RECORD > Voice Recorder > Record

4� 选择“Record”。

.

.
.

.
.

.






更改麦克风增益级别
在 VOICE RECORDER语音录制界面，按 
[QUICK] ，选择“MIC Gain ”。

  .



剩余时间

麦克风增益等级

录制时长

麦克风等级

录音功能

1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “Voice Recorder” 。
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使用录音功能

D 播放录制的音频
.




[MENU] > RECORD > Voice Recorder > Play Files

5. 选择要播放的音频文件的文件夹。

 文件夹命名如下 
.



 VOICE PLAYER语音播放界面介绍

[CD] 

.


总播放时长

录制时间

录音功能

4� 选择“Play Files”。

1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “Voice Recorder” 。

快进[LO]/快退[CD]
• 按住可连续快进或快退文件。
• 默认跳过时间为10秒。如果想更改它，请参阅第8-16页
了解详细信息。

• 可以通过旋转[DIAL]来快进或快退文件。快进/快退时间
为文件总时间的1/20，与跳过时间设置无关。

• 如果在文件的前1秒内按下[CD]，则会播放上一个文件的
结尾。

播放之前的文件 [RX→CS]
• 当播放文件夹中最旧的文件时，按下[RX→CS]播放相

• 移到上一个文件的开
同的文件。
当文件暂停时，按下[RX→CS]
头。

播放下一个文件[DR]
[DR]会播放相当播放文件夹中的最新文件时，按下

同的文件。

正在播放的文件数/
已录制的文件总数

录制开始日期
和时间

播放时间/和时
间

[RX→CS] 
播放之前的文件

[LO] 快进

            [ ENT] 暂停或播放
[DR] 播放下一个文件

快退
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D 删除音频文件夹
注意: 
.


[MENU] > RECORD > Voice Recorder > Play Files

.
8� 选择 “YES ”。

.


.


录音功能

使用录音功能

5. 选择要删除的文件夹。

4� 选择“Play Files”。

1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “Voice Recorder” 。

        不要按[ENT]。
6. 按 [QUICK]。
7. 选择“Delete”。
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D删除音频文件
.

[MENU] > RECORD > Voice Recorder > Play Files

6� 选择音频删除 。

 不要按[ENT]。
7. 按 [QUICK]。
8. 选择“Delete”。

9� 选择 “YES ” 。

.


录音功能

使用录音功能

• 显示确认删除对话框。

• 文件被删除。
按[MENU]退出菜单。 

5. 选择要删除包含文件的文件夹。

4� 选择“Play Files”。

1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “Voice Recorder” 。
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D查看文件信息
[MENU] > RECORD > Voice Recorder > Play Files

.



录音功能

使用录音功能

6� 选择需要查看的文件 。

 不要按[ENT]。
7. 按 [QUICK]。
8. 选择“File Information”。

5. 选择要查看包含文件的文件夹。

4� 选择“Play Files”。

1. 按[MENU]。
2. 选择“RECORD ” 。
3. 选择 “Voice Recorder” 。

按[MENU]退出菜单。 

文件名
文件总数(总大小)
创建日期和时间
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在电脑上播放

1. 将microSD卡插入电脑的存储卡插槽或读卡器。

2� 点击“Open folder to view files” 打开SD卡文件夹。

点击

3. 双击 ‘ID-52’ 文件夹。

双击

4. 双击 ‘Voice’ 文件夹

双击

PC
读卡器microSD

ID-52A/E

双击

双击

 电脑播放操作可能会有所不同，具体取决于应用程   
     序。有关详细信息，请参阅应用程序的说明手册。
 双击该文件播放时，文件没有响应，请下载相应
     的软件应用程序。(例如：Windows Media®播放
     器) 

提示: 当 “USB Connect” 设置为“SD Card Mode” ，并
且对讲机通过USB数据线连接到电脑时，可以从电脑
直接访问对讲机中设置的microSD卡。
([MENU] > SET > Function > USB Connect)

录音功能

音频也可以在电脑上播放。
 操作信息(频率、日期等)不显示。
 这些说明基于Microsoft Windows 10。

示例：使用SD卡和电脑，然后在电脑上播放。

5. 双击包含要播放的文件的文件夹。(示例：20211101)

6. 双击要播放的文件。 (例: 20211101_152135A.wav)
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<<REC Start>>录制开始

[MENU] > RECORD > QSO Recorder >  
<<REC Start>>

.
.

 相关信息
.






Play Files播放文件

[MENU] > RECORD > QSO Recorder > Play Files
.


.



.


.


注意:
••

••

••

••

.











录制项目

�(默认: Squelch Auto)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > RX REC Condition

• Always:

• Squelch Auto:

.
 







� (默认: ON)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > File Split

.
• OFF:   一旦开始录制，对讲机将继续在同一文件上进

行录制。
如果文件大小超过2GB，则会在同一文件夹中自
     动创建一个新文件，继续录制。 
在录制过程中，如果传输和接收或静噪状态*
(打开或关闭)发生变化，则会在同一文件夹中
自动创建一个新文件，并将音频保存到一个新
的文件中。

• ON: 

* 仅限 “RX REC Condition” 设置为“Squelch Auto”。

� (默认: A/B Link)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > REC Operation

.

• A/B Separate:

• A/B Link:

.
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�

  (默认: ON)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > PTT Auto REC

打开或者关闭PTT自动录制。
 .



• OFF: 关闭PTT自动录制功能。
• ON:  按下[PTT]时，录音会自动开始。

出现以下情况时，录制将停止：
•
• 

松开[PTT]后10秒钟内不发送任何信号。
松开[PTT]后10秒钟内未接收到任何信号。
.


.


(默认: 10sec)

[MENU] > RECORD > QSO Recorder >  
Player Set > Skip Time

Record(录制)

[MENU] > RECORD > Voice Recorder > Record
按[ENT]以显示VOICE RECORDER界面，然后按
[PTT]以开始语音录制。录制时，再次按下[PTT]可停
止录制。（第8-9页）

相关信息
.



Play Files播放文件

[MENU] > RECORD > Voice Recorder > Play Files
.



� (默认: 3)

[MENU] > RECORD > Voice Recorder 
> Recorder Set > MIC Gain

.


� (默认: 10sec)

[MENU] > RECORD > Voice Recorder 
> Player Set > Skip Time

当在播放录制的音频时，按下快退或快进键时，将“跳
过时间”设置为3、5、10或30秒，以便在此设置的时间
段内快退或快进。
请参阅语音播放界面介绍以了解快进或快退。(第8-10页)

DV Auto Reply(DV自动回复)

[MENU] > RECORD > DV Auto Reply
.



录音功能

Skip Time跳过时间 

当在播放录制QSO时，按下快退或快进键时，将“跳过
时间”设置为3、5、10或30秒，以便在此设置的时间段
内快退或快进。
请参阅语音播放界面介绍以了解快进或快退。(第8-3页)
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9 存储操作

9-2

一般说明

.



群组 存储 
信道 说明

00-99 00 - 99

.



CALL CH 144 C0/C1
430 C0/C1

.


D 存储信道内容
可以将以下信息输入存储信道：
•工作频率
•双工开/关
•双工方向（DUP+或DUP-）
•双工频率偏移
•存储名称
•扫描跳过设置
•调整步进
•操作模式
•亚音频音调编码、音调静噪或DTCS静噪开/关
•亚音频音调频率、音调静噪频率或带极性的DTCS代码
•数字代码
•数字呼号静噪或数字代码静噪开/关
•UR站点呼号
•R1/R2呼号

注意:
存储数据可能会被静电、电流瞬变和其他原因清除。 
此外，数据还可以在故障和维修过程中清除。 因此，
将存储数据保存到microSD卡或电脑来备份存储数
据。

• microSD卡由用户自备。
• CS-52编程软件也可用于备份您的内存内容。详见
其使用说明书。
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选择存储信道

在存储模式下，可以通过旋转[DIAL]来选择存储信
道。

1. 按 [MR]以进入存储模式。

仅限ID-52A，每次按[MR]可在存储和天气信道切换。 

.
• 选择一个存储信道。
 不选择空白信道。
 要选择存储组，请按[QUICK]，然后选择“Group Select”。 
 存储信道通常用于A和B频段。在B频段，如果您选
      择的存储信道超出了可选择的频率范围，则会显示
       “        ”，并且无法接收信号。 

提示：按顺序选择不同组中的信道
1. 按 [QUICK]。
2. 选择 “Channel Select Group Range ” 。

3� 选择“All Groups ” 。

选择呼叫信道

呼叫信道用于快速调用最常用的工作频率。
出厂默认频率和操作模式被输入到呼叫信道中。可根
据操作需要进行更改。

1. 按住 [CALL] 1秒钟进入到呼叫信道。

.
.

存储操作
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输入存储信道内容

在VFO模式下选择频率后，可以将其输入到选定的信
道或自动选择的空白信道。

D 进入选定信道

示例: 将146.030 MHz/FM 模式
           存储到群组01中的11信道 

1. 按[VFO/MHz]选择VFO 模式。
2. 按[MODE] 选择 FM 模式。
3. 旋转 [DIAL]将频率设置为 146.030 MHz.。�

.
.

5. 选择“Write to New CH ” 。

6. 按 [QUICK]。
7. 选择 “Group Select ” 。

8. 选择群组 “01” 。

9. 旋转[DIAL] 选择信道 “11”。

.
.

11. 选择 “YES”。

.

.
.














存储操作
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输入存储信道内容

仅限ID-52A,按 [MR] 在天气信道和存储信道间切换。

 选择存储组，请按[QUICK]，然后选择“Group Select ”。
3. 按[VFO/MHz] 选择VFO模式。
4. 旋转 [DIAL] 设置频率146.330 MHz。

4� 按住 [MW] 3秒钟。

.

存储操作

D 覆盖所选信道
可以在选定的信道中输入新内容进行覆盖。

示例: 将146.330 MHz/FM 模式
           存储到群组01中的11信道 

1. 按[MR]选择存储模式。

2. 旋转 [DIAL]选择群组01的11信道。

5. 按住[MW] 1秒钟。
• 响起一短和一长提示音。

6. 选择“Write to New CH ” 。

7. 按 [MR]。
8. 选择 “YES” 。

• 短暂提示音和存储内容后，返回VFO模式。

D 存储到空白信道

示例: 将441.100 MHz/FM 模式
           存储到空白信道 

1. 按[VFO/MHz]选择VFO 模式。
2. 按[MODE] 选择 FM 模式。
3. 旋转 [DIAL]将频率设置为441.100MHz.。�
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将存储内容复制到VFO中

.



5� 选择“YES ” 。

存储操作

1. 按[MR]选择存储模式。
仅限ID-52A,按 [MR] 在天气信道和存储信道间切换。

2. 旋转 [DIAL]选择群组01的11信道。

 选择存储组，请按[QUICK]，然后选择“Group Select ”。
3. 按住[MW] 1秒钟。

•响起一短和一长提示音。
4. 选择“Copy to VFO ” 。

• 短暂提示音和将选定的存储容复制到VFO
后，返回VFO模式。
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存储界面

在存储信道界面上，可以轻松管理存储信道或呼叫信
道的内容。

D 存储界面树视图

D 查看存储信道内容
可以在存储界面上查看存储信道的内容。

示例:  查看群组00中信道01的内容。

[MENU] > MEMORY > Memory CH
1. 按 [MENU]。
2. 在菜单的界面的第二页，选择 “MEMORY” 。
 在VFO、存储信道或呼叫信道模式下，可以通过按
     住[MW]1秒，然后选择“Manage Memory”来打开存
     储界面。

3. 选择“Memory CH ”。
4. 选择群组“00” 。

5. 选择信道 “01” 。

.



提示: 编辑、复制或清除内存内容。
1. 在步骤5中按下 [QUICK] 。
2. 选择 “Edit编辑”、 “Copy复制” 或“Clear 清除” 。

存储界面

Memory CH

Call CH

你的呼号

中继器列表

Group 00

S: SKIP CH*

Group 99

00

144 C0

430 C0

99

144 C1

430 C1

.
（当VFO扫描暂停时，如果您想跳过频率，按住
[MW]1秒将频率设置为跳过频道。）
”

存储操作
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.



.


[MENU] > MEMORY > Memory CH
1. 按 [MENU]。
2. 选择 “MEMORY ” 。
3. 选择 “Memory CH”。
4. 选择群组 “00 ” 。
5. 选择信道 “01 ” 。

 不要按[ENT]。
6. 按[QUICK]。
7. 选择 “Copy ” 。

8� 选择目标信道。

.

  .


提示：将信道复制到不同的组中
在步骤6中，当显示“DESTINATION”时，按下
[QUICK]并选择“Group Select” 。

.

存储操作
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将存储内容移动到不同群组的信道中

可以将存储内容移动到不同群组的信道中。

示例: 将群组00中信道01的内容移动到
            群组02中的信道00上。

[MENU] > MEMORY > Memory CH

8. 按[QUICK]。
9. 选择“Group Select ” 。

10.选择目标群组。

11.选择目标信道。

提示：重新排列信道列表
在步骤7中，当显示“DESTINATION” 时，执行步骤
11以重新排列组中的信道列表。

存储操作

1. 按 [MENU]。
2. 选择 “MEMORY ” 。
3. 选择 “Memory CH”。
4. 选择群组 “00 ” 。
5. 选择信道 “01 ” 。

 不要按[ENT]。
6. 按[QUICK]。
7. 选择 “Move ” 。

• 响起提示音，内容被移动到目标信道。
  除去移动的信道，其他信道将向上移动。
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插入空白信道

可以在两个存储信道之间，插入一个空白信道。此功
能便于管理存储信道。

示例：在群组00信道00和01之间插入空白信道。 

[MENU] > MEMORY > Memory CH

存储操作

1. 按 [MENU]。
2. 选择 “MEMORY ” 。
3. 选择 “Memory CH”。
4. 选择群组 “00 ” 。
5. 选择信道 “01 ” 。

 不要按[ENT]。
6. 按[QUICK]。
7. 选择 “Insert ” 。

•  响起提示音，在所选信道的上方插入一个空白信道。
  如果在步骤5中选择信道99，则会显示一个确认对话�

    框。当您选择“YES”时，信道99将被删除。

提示：插入空白群组
在Memory Group(存储群组)界面上，选择一个群
组并按下[QUICK]然后选择 “Insert Group”。

•将在选定群组的上方插入一个空白群组。 
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输入群组/存储信道名称
可以为每个信道群组(00~99)和存储信道命名，可命名
最多16个字符。

示例:将群组00中的信道01命名为 “Calling” 。

[MENU] > MEMORY > Memory CH

8. 选择“NAME ” 。

9. 输入名称。

.

10. 输入完毕，按[ENT]。

11. 选择 “<<Overwrite>> ” 。

12. 选择“YES ” 。

存储操作

1. 按 [MENU]。
2. 选择 “MEMORY ” 。
3. 选择 “Memory CH”。
4. 选择群组 “00 ” 。
5. 选择信道 “01 ” 。

 不要按[ENT]。
6. 按[QUICK]。
7. 选择 “Edit ” 。

•  响起提示音，然后返回到存储信道界面。

提示:输入群组名
在“存储组列表”界面上，选择一个群组并按 
[QUICK] 然后选择“Edit Name”编辑名称。

•出现群组名称编辑界面。
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选择信道名称显示

.




4. 选择显示类型。

.

.

.


• Freq (Normal Name):
显示大字体频率和小字体存储名称。
  在双频显示中，选择““Freq”。

.



.


.


存储操作

1. 按[MR]选择存储模式。
仅限ID-52A,按 [MR] 在天气信道和存储信道间切换。

2. 按 [QUICK]
3. 选择“Display Type ” 。
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清除存储内容

.


.
[MENU] > MEMORY > Memory CH

存储操作

8. 选择“YES ” 。

1. 按 [MENU]。
2. 选择 “MEMORY ” 。
3. 选择 “Memory CH”。
4. 选择群组 “00 ” 。
5. 选择信道 “01 ” 。

 不要按[ENT]。
6. 按[QUICK]。
7. 选择 “Clear ” 。

•  响起提示音，信道被删除。

如果需要，可以清除输入存储的内容。
清除的信道变为空白信道。
也可以清除跳过信道 (群组  “S”)。

提示：删除存储信道
在步骤7中，选择 “Delete (next CH moves up)”。

•所选信道被删除。
 也可以删除存储群组。
      选择一个群组，然后选择“Delete Group”。��
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.





ID-52A/E
接收开始频率

ID-52A/E
接收截止频率

扫描

跳过

P SKIPP SKIP

.


扫描

跳过

PSKIPPSKIP

频段边界开始频率 频段边界截止频率 

.




扫描

跳过
跳过

扫描范围
低频边界 高频边界

PSKIPPSKIP

 重复扫描选定的编程扫描范围。
.





.




编程扫描边界  示例: P00 ~ P10)

跳过

扫描
P00 P01 P02 P03 P10

.





 存储群组(00 ~ 99和S: 跳过信道)

00 01 02 98 99 S03

跳过空白存储群组
跳过

扫描

选定频段扫描(BAND)
扫描与所选信道位于同一频带上的所有存储信道。

模式扫描(MODE)
扫描与当前所选模式相同的存储信道。
 模式扫描搜索所有存储群组。

AM
Scan

AM FM AM DV AM

跳过AM以外的模式

(群组00 ~ 99, S: 跳过信道) 

示例:  扫描 AM 模式  
存储群组 02

.


0201 00   S99 98  

跳过未选中的群组
跳过

扫描

 存储群组 (00 ~ 99 和 S: 跳过信道)

 至少有2个群组，才能启动群组链接扫描。 
.


.


.
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扫描类型

双工扫描
双工扫描搜索双工操作中，使用的TX和RX频率上的
信号(p. 11-4)。
在双工模式，显示 “D–” 或 “D+”。
 当频率偏移设置为“0.000.00 MHz”时，
     双工扫描不启动。

亚音扫描
亚音扫描使用亚音功能，搜索来自电台的具有亚音
频率或DTCS代码的信号。  
音调扫描可用于任何VFO、存储或呼叫信道模式。
 在扫描过程中，旋转[DIAL]以更改扫描方向。
 关于模拟亚音功能和DTCS数字亚音功能，
     请参见第15-8页和第15-9页。

10扫描操作
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.


D扫描的静噪设置
可以更改静噪等级，以满足操作需求。根据接收到
的信号强度，设置静噪等级以打开静噪。
 .



闪烁

D VFO扫描的调谐步进
选定的调谐步进将应用于扫描。
对于编程扫描或编程链接扫描，请在编程扫描边缘范围
(P扫描边缘)中设置调谐步进。

D 扫描跳过功能
跳过功能通过不扫描设置为跳过信道的频率，以此来加
快扫描速度。 
 这些设置可以分别设置为A频段和B频段。

在VFO模式下
在扫描过程中会跳过设置为“PSKIP”的频率。(第10-6
页)
在存储模式下
设置为跳过信道“PSKIP”和“SKIP”的频率不会被扫描。
(第10-11页)
 必须输入2个或多个存储信道才能开始存储信道扫描。

提示：当“Program Skip”设置为OFF时，将不能使用
Program Skip功能。 (p. 12-5)
([MENU] > SET > Scan > Program Skip)

D 扫描时的操作模式
.



.






[MENU] > SET > Scan > Pause Timer

[MENU] > SET > Scan > Resume Timer

闪烁

D 扫描停止提示音功能
当接收到信号时，可以响起扫描停止提示音。
此功能可以在菜单界面上打开或关闭。（第12-29页）

[MENU] > SET > Sounds > Scan Stop Beep

10扫描操作

关于扫描

D在扫描过程中使用 [DIAL]
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.



.
4. 选择扫描类型。

闪烁

.

当接收到信号时，S-表显示接收到的信号强度。

.
.


D扫描类型

 相关信息
.









提示:
.








VFO 扫描

10扫描操作

• ALL
• BAND:
• P-LINK0 ~ 9:
• P00 ~ 24:
• DUP:
• TONE:

全扫描
频段扫描
编程链接扫描
编程扫描。 
双工扫描。(设置双工时显示)
亚音频扫描(亚音频静噪扫描)
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D 存储跳过频率
可以在扫描过程中跳过不必要的频率。扫描暂停时，
如果想跳过频率，可以将其作为跳过信道(PSKIP)，存
储到跳过信道群组S(00~99)中。
扫描跳过功能可加快扫描速度。

1.当VFO扫描暂停时，按住[MW]1秒钟。

.
2. 选择 “Adds to SKIP MR Group ”

• 发出两声短促的提示声。
• 频率存储在跳过信道群组中。
• 存储后，扫描恢复。
  .



提示: 将频率设置为跳过信道后，将跳过该频率，直
到清除该跳过设置。要清除跳过设置，请参阅第
10-11页。
 .



VFO 扫描

D 关于编程扫描名称
当在编程扫描中输入扫描名称时，该名称将显示在扫
描类型选择窗口中。（第10-5页）
  描过程中不显示名称。
要输入名称，请参见第10-7页。

输入扫描名称时

未输入扫描名称时

D关于编程链接扫描名称
当输入编程链接扫描名称时，它将显示在扫描类
型选择窗口中。（第10-5页）
 扫描过程中不显示名称。
 要输入名称，请参见第10-8页。

输入编程链接名称时

未输入编程链接名称时

10扫描操作



10-7

8. 编辑完成，选择 “<<Write>> ”。
.

9. 选择 “Yes ” 。

.

提示:
.



.





[MENU] > SET > Scan > P-Scan Edge
1. 按 [MENU]。
2. 在“SET”菜单选择“Scan” 。
3. 选择“P-Scan Edge ”。

4. 选择一个空白编程扫描范围“00” ~”24” 。

 不要按 [ENT]。
5. 按 [QUICK]。
6. 选择 “Edit ” 。

.
7. 选择 “FREQ LOW” 或 “FREQ HIGH” 编辑开始频率

.

相关信息
.











10扫描操作

VFO 扫描
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D 设置编程链接功能
[MENU] > SET > Scan > Program Link

4� 选择一个编程链接号码 “0” ~ “9 ” 。

.
• 编程链接号码界面显示预先注册的编程扫描范

当未选编程扫描范围时，将显示 “– Blank –” 

7� 选择要添加的编程扫描范围。

.


.

提示:
.





...

编程链接  0：

1：

9：

编辑名称

01：144.000−440.000

编程链接号码(0 to 9)

空白

删除

编程扫描 
开始频率 结束频率

相关信息
.






编程扫描范围(p. 10-7)

10扫描操作

VFO 扫描

D 关于编程链接扫描
此项目设置两个或多个编程扫描范围的链接功能，以
便在编程链接扫描期间按顺序扫描。编程链接扫描将
搜索范围内的所有频率。

编程链接的设置示例

编程扫描 

1. 按 [MENU]。
2. 在“SET”菜单选择“Scan” 。
3. 选择“Program Link”。

5. 按 [QUICK]。
6. 选择 “Add ” 。
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存储信道扫描

D 扫描类型

 当输入两个或多个未设置为跳过信道的存储信道时，
      存储信道扫描可用
设置为跳过信道(PSKIP或Skip)的存储信道，
     在扫描过程中被跳过。（第10-11页）

.



.
仅限 ID-52A按[MR]在存储信道和天气信道间转换。

.
.

3. 选择扫描类型。

闪烁

• 扫描开始。
• 小数点和 “  ”闪烁。
 当接收到信号时，S表显示接收到的信号强度。

.

10扫描操作

• 取消扫描
按下[CLR]也会取消扫描。

提示:
• [DIAL]以更改扫描方向。
•
在扫描过程中，旋转
在扫描过程中，按住[         ]可打开或关闭锁定功能。

• 即使在扫描过程中按下[MENU]或[QUICK]，扫描也会
持续运行。

• 可以通过在按住[scan]的同时，旋转[DIAL]来选择扫
描类型。松开[SCAN]以开始扫描。

• ALL
• BAND:
• MODE
• DUP:
• GROUP LINK:
• GROUP 00 ~ 99:
• TONE:

全扫描
频段扫描
模式扫描
双工扫描。(设置双工时显示)
存储群组链接扫描
群组扫描
亚音频扫描(亚音频静噪扫描)
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.



[MENU] > SET > Scan > Group Link

4. 选择一个群组, “00” ~ “99,” “S: SKIP CH” 。

.
• 当功能设置为“ON”时，将显示“  ” 。
 按[QUICK] 可快速打开或关闭所有群组。

.

D 关于群组扫描名称
将群组名称输入到存储信道组时，该名称将显示在扫
描类型选择窗口中。（第10-9页）
 扫描过程中不显示名称。
 要输入名称，请参见第9-11页。

输入群组名称时

未输入群组名称时

10扫描操作

存储信道扫描

1. 按 [MENU]。
2. 在“SET”菜单选择“Scan” 。
3. 选择“Group Link”。



10-11

.



2. 选择需要跳过的信道。
3. 选择 [QUICK]。
4. 选择 “SKIP ”。
5. 选择一个选项。

.


• OFF:
• SKIP:

.


• PSKIP: 在VFO和存储信道扫描期间跳过。

临时跳过功能

在扫描过程中，该功能在设置的时间段或条件下临时
跳过不需要的频率(或存储信道)，而不更改跳过信道
设置。

1. 扫描暂停时，按住[MW]1秒钟。
2. 选择“Temp Skip Set” 。

.


提示:
• 
• 

• 

最多可以设置20个临时跳过频率或存储信道。当设置第
21个频率或存储信道时，最旧的设置会自动删除。
也可以在快捷菜单窗口中设置临时跳过功能。
当临时跳过计时器(默认: 5分钟），或在快捷菜单窗口
中选择“Temp Skip Cancel”进行设置。
([MENU] > SET > Scan > Temporary Skip Timer)

10扫描操作

存储信道扫描

1. 按[MR] 进入存储信道模式
仅限 ID-52A按[MR]在存储信道和天气信道间转换。
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第11部分 中继和双工操作
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调频中继操作

有关访问D-STAR中继的详细信息，请参阅第5部分。

D     设置中继频率
1. 按 [VFO/MHz] 选择VFO 模式。
2. 按[MODE]选择FM模式。

3� 旋转 [DIAL] 选择接收频率。

提示: 仅限美国版本
自动中继功能(p. 11-5) 
当功能开启时，不需要执行步骤4至8。
 可以关闭该功能并手动设置中继器置。

([MENU] > SET > Function > Auto Repeater)

4� 设置偏移频率和双工方向。(p. 11-4) 

.
.




 

7. 按 [QUICK]。
8. 选择 “TONE” ，然后开启中继亚音。

.
.

.


10. 与单工呼叫相同的方式操作，交替传输和接收。

站点 A
RX: 145�500 MHz
TX: 144�900 MHz

站点 B
RX: 145�500 MHz
TX: 144�900 MHz

中继站
RX: 144.900 MHz
TX: 145.500 MHz

访问中继器 从中继器接收

按[PTT] 2秒钟 接收中继器的呼号

▲

提示:
•当中继器亚音或频率偏移发生变化时，自动中继功能的亚
音或偏移也会发生变化。
•如果偏移值导致发射频率超出频段，则当按下[PTT]时，显
示屏上将显示“OFF band”，并禁止发射。（第11-5页）

按频差偏移量
       偏移

接收频率 发射频率

11 中继和双工操作

中继操作是在一个频率上接收信号，然后在另一个频率
上发射信号。当使用中继操作时，发射频率以接收频率
为基础进行频率偏移。

当使用收发异频功能访问当地中继时，电台的频差设置
要与当地中继的频差相同。
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调频中继操作

.


.



1. 按[MENU]。
2. 在SET”菜单选择 “DTMF/T-CALL” 。

3. 选择 “DTMF Memory ” 。

4. 选择 “T-CALL ” 。

5. 按[MENU] 退出菜单模式。
6. 旋转[DIAL] 以设置从中继器。
7. 设置偏移频率和双工方向。(p. 11-4)

.
8. 按住[PTT] 发射时, 按[SQL] 传输1750音调。

.
.
与单工呼叫相同的方式，交替传输和接收。

 相关信息
• 监听时，状态指示灯亮起绿色，S/RF仪表点闪烁。
• 监听时，显示的频率会自动更改为对讲机发射频率(中继器

输入频率)。
• 当可以直接接收到另一个电台的信号时，变更到非中继器

频率，并使用单工。(双工关闭)

D 查看中继输入信号
可以通过监听中继输入频率，来查看是否可以直接接
收另一个电台的发射信号(而不是通过中继器)。

按住[SQL]以监听中继器输入频率。

监听时显示

11 中继和双工操作
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双工操作

双工操作将发送频率从接收频率上移或下移偏移
量。

D 设置频率偏差
.


[MENU] > SET > DUP/TONE... > Offset Freq

3. 选择“Offset Freq ” 。

4. 旋转[DIAL] 设置频率偏差数值。

 相关信息

提示: 
如果偏移值导致发射频率超出频带，则按下[PTT]时
会显示“OFF band”，并且发射将被禁止。（第11-5
页）

D设置双工方向
1. 按[QUICK]。
2. 选择 “DUP ”。

.

• 显示 “D–” 或 “D+”。

D 双工操作
1. 按住[SQL]监听发射频率，以检查另一个
站是否在其上进行发射。

.

.
与单工呼叫相同的方式，交替传输和接收。 

注意: 
当自动中继器功能打开，并且工作频率设置在中继器
输出频率范围之外时，双工模式将自动取消。
([MENU] > SET > Function > Auto Repeater)

11 中继和双工操作

1. 按[MENU]。
2. 在SET”菜单选择 “DUP/TONE...” 。

• 设置范围 0.000.00 - 59.995 MHz。
• 设置频率偏差时，使用的是VFO模式中选择的调谐
步进。

• 按[MENU]退出菜单。�

• OFF:  单工操作。(接收和发射频率相同)
• DUP–:  发射频率低于接收频率一个频差值。

             (显示“D-”)
• DUP+:  发射频率高于接收频率一个频差值。

             (显示“D+”) 
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自动中继功能 带外指示

.




.




[MENU] > SET > Function > Auto Repeater

3� 选择 “Auto Repeater ” 。

4� 选择选项以打开自动中继器功能。 

• OFF:
• ON (DUP):
• ON (DUP, TONE):   
.

频率范围和频差方向

如果发射频率超出业余频段，则按下[PTT]时会显示
带外指示“OFF BAND”。在这种情况下，请检查频率
偏移或双工方向。（第11-4页）

11 中继和双工操作

1. 按[MENU]。
2. 在SET”菜单选择 “Function” 。

关闭自动中继
只开启双工操作 (默认)
开启双工操作和亚音

频率范围 频差方向
145.200–145.495 MHz 设置“DUP–” 
146.610–146.995 MHz
147.000–147.395 MHz 设置“DUP+” 
442.000–444.995 MHz 设置“DUP+” 
447.000–449.995 MHz

设置“DUP–” 

设置“DUP–” 



12-1

Selecting an item(选项)�����������������������������������������������������������������������
D MENU 菜单界面操作 ��������������������������������������������������������������.�������������..
D 选择菜单项目 ������������������������������������������������������������������������������������......

DUP/TONE...(双工/亚音...)�������������������������������������������������������������������
Scan (扫描)������������������������������������������������������������������������������������������
Scope(频谱)�����������������������������������������������������������������������������������������
Call Sign(呼号) ������������������������������������������������������������������������������������
My Station(我的站点)���������������������������������������������������������������������������
DV Set(DV设置)�����������������������������������������������������������������������������������
SPEECH(语音播报)�����������������������������������������������������������������������������
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可以通过按下[MENU]来打开菜单屏幕。可以使用
MENU菜单界面设置不常更改的值或功能设置。
除此页面外，有关每个项目的选项和默认值的详细信
息，请参见第12-4至12-36页。

D MENU菜单界面操作

12设置模式

选项

.

.




[ENT]
.

返回上一级 

转到下一级 

返回到默认设置 

.

简化描述

.



1. 按[MENU]。
2. 选择 “30min”。
操作:
1. 按[MENU] 打开菜单界面。
2. 按 D-pad() 选择 “30min”，再按[ENT]。

本手册简化了用户的“选择”操作，如下所述。
简化描述：
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[MENU] > SET > Time Set > Auto Power OFF

.

12设置模式

选项

D 选择菜单项目

示例: 设置“自动关机” 为 “30 分钟”。

1. 按[MENU]。
2. 选择 “SET”。
3. 选择 “Time Set”。

4. 选择“Auto Power OFF”。

5. 选择“30min”。

•设置选项，然后返回到上一级。
(显示TIME SET界面）
 要退出菜单屏幕，请按[MENU]。�

提示：恢复默认设置
1. 在上面步骤5，按下[QUICK] 。
2. 选择 “Default”。

•。�
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� (默认: 0�600�00*)

[MENU] > SET > DUP/TONE... > Offset Freq
.






* 默认值可能会有所不同，具体取决于频带(在进入MENU
菜单屏幕之前选择为MAIN主频带)和对讲机版本。

� (默认: 88�5)

[MENU] > SET > DUP/TONE... > Repeater Tone
.


TSQL Freq� (默认: 88�5)

[MENU] > SET > DUP/TONE... > TSQL Freq
.


• 可选择中继器亚音/TSQL亚音频率 (Unit: Hz)
67.0 88.5 114.8 151.4 177.3 203.5 250.3
69.3 91.5 118.8 156.7 179.9 206.5 254.1
71.9 94.8 123.0 159.8 183.5 210.7
74.4 97.4 127.3 162.2 186.2 218.1
77.0 100.0 131.8 165.5 189.9 225.7
79.7 103.5 136.5 167.9 192.8 229.1
82.5 107.2 141.3 171.3 196.6 233.6
85.4 110.9 146.2 173.8 199.5 241.8

� (默认: OFF)

[MENU] > SET > DUP/TONE... > Tone Burst
.


• OFF:  .



• ON:   .


� 默认: 023)

[MENU] > SET > DUP/TONE... > DTCS Code
.


• 可选 DTCS 代码
023 072 152 244 311 412 466 631
025 073 155 245 315 413 503 632
026 074 156 246 325 423 506 654
031 114 162 251 331 431 516 662
032 115 165 252 332 432 523 664
036 116 172 255 343 445 526 703
043 122 174 261 346 446 532 712
047 125 205 263 351 452 546 723
051 131 212 265 356 454 565 731
053 132 223 266 364 455 606 732
054 134 225 271 365 462 612 734
065 143 226 274 371 464 624 743
071 145 243 306 411 465 627 754

� (默认: Both N)

[MENU] > SET > DUP/TONE... > DTCS Polarity
.
• Both N: TX和RX均使用正向极性。
• TN-RR:  正向极性用于TX，反向极性用于RX。
• TR-RN: 反向极性用于TX，正向极性用于RX。
• Both R: 反向极性用于TX和RX。

� (默认: 00)

[MENU] > SET > DUP/TONE... > Digital Code
.


.


双工/亚音...

12设置模式
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扫描

� (默认: 10sec)

[MENU] > SET > Scan > Pause Timer
.


• 2sec ~ 20sec:

• HOLD:

.




� (默认: 2sec)

[MENU] > SET > Scan > Resume Timer
.

.




.





.

� (默认: 5min)

[MENU] > SET > Scan > Temporary Skip Timer
选择临时跳过时间。
 可单独设置A频段和B频段。
 计时器可激活为VFO扫描、存储信道扫描和DR扫描。 
• 5min/10min/15min: 

• While Scanning:

• While Powered ON:

.






� (默认: ON)

[MENU] > SET > Scan > Program Skip
.




• OFF: 对讲机扫描所有频率。
• ON:  对讲机不会扫描设置为“PSKIP”的频率。

Group Link(信道组链接) 
(默认: �✔  00 ~ ✔  99/ ✔  S: SKIP CH)

[MENU] > SET > Scan > Group Link
选择要在信道组链接扫描过程中扫描的群组。Group 
Link群组链接功能扫描所选组中的所有信道。
选择一个群组, A ~ Z, 然后按 [ENT] ，打开或者关闭信
道组链接。
 设置开启时吗，显示“ ✔” 。
 可单独设置A频段和B频段。

P-Scan Edge(编程扫描的频率边界范围)。

[MENU] > SET > Scan > P-Scan Edge
可以删除、复制或编辑编程扫描的上下频率。
对讲机总共有多达25个频率边界范围(00~24)，可以
为每个扫描边界设置扫描名称、调谐步进和操作模
式。  
默认设置可能会有所不同，具体取决于对讲机版本。

12设置模式
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[MENU] > SET > Scan > Program Link
为两个或多个编程扫描边界范围设置链接功能，以
便在编程链接扫描期间按顺序扫描。链接功能将扫
描范围内的所有频率。

编程链接的默认设置：

 默认设置可能会有所不同，具体取决于对讲机版本。
当只输入一个编程扫描边界范围，或者没有剩余的编程
   扫描边界时，按下[QUICK]后不会显示“Add”。 

�
 (默认: OFF)

[MENU] > SET > Scan > DUP Check During MR Scan
.

.
 

...

Program Link 0：

1：

9：

编辑名称

01： 144.000−148.000

编程链接组： (0 -9)

空白

编程扫描边界范围

删除

02： 430.000−450.000

删除

12设置模式
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Program Link(编程链接)
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频谱

� (默认: Center)

[MENU] > SET > Scope > Scope Mode
.

• Center:

•  FIX:
• Scroll (FIX):

.






� (默认: ±15 Steps)

[MENU] > SET > Scope > Displayed Steps
.


• ±15 步进:

• ±20 步进:

� (默认: ON)

[MENU] > SET > Scope > Waterfall Function
.

.
 

� (默认: Fast)

[MENU] > SET > Scope > Waterfall Speed
.
.
 

FIX Mode Center Frequency(固定中心频率模式)

[MENU] > SET > Scope > FIX Mode Center Frequency
为每个频段设置固定中心频率。
   VFO模式中，选择的调谐步进用于设置中心频率。
          要选择调谐步进，请打开待机界面上的快捷菜单窗口。
  要返回到默认设置，请按下[[QUICK]，然后在
     “ Center Freq. (FIX)”或“FREQUENCY”界面上选择
     “Default”。
 默认设置可能会有所不同，具体取决于对讲机版本。

�
 (默认: OFF)

[MENU] > SET > Scope > AF Output (DUAL/AIR Band)
.



• OFF: 扫描过程中没有音频输出。
• ON:  在扫描过程中，接收到的音频会瞬间输出。

12设置模式
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[MENU] > SET > Call Sign
设置或查看要在DV模式中使用的“UR”、“R1”、“R2”
和“MY”呼号。
不使用DR功能时，在此屏幕上设置呼号。

对于单工操作(DV模式)
可以设置“UR”和“MY”呼号。

用于双工(中继器)操作(DV模式/DR功能)
当DR功能打开时，只能设置“MY”呼号。

<手动设置双工(中继器)操作>

示例:  在DV模式下从Hirano (JP3YHH a)向Kirkland 
  中继器(N71H B)进行网关CQ呼叫。

  .


提示：当数字中继器设置功能打开时，中继器呼号
会自动设置。
([MENU] > SET > DV Set > Digital Repeater Set)

步骤 1. 设置呼号 “R1”
.





 可选字符是字母数字和符号（“/”）。

5. 按 D-pad ()移动光标。
6. 重复步骤4和5，输入最多8个字符(包括空格)的

中继器呼号。
.


.

步骤 2. 网关 “R2” 设置
1. 选择 “R2 ”。
 要手动输入呼号，请按 [QUICK], 然后选择“Edit”。

2. 选择“GW ”。

关于RPT2 SELECT(RPT2选择)界面
NOT USED* 用于本地呼叫。

GW .

Repeater name .


步骤 3. 目的地“UR”设置

关于选择界面

CQCQCQ .


Gateway CQ* .


Your Call Sign .


RX History .


TX History .


.

12设置模式

呼号

Call Sign(呼号)

1. 选择 “UR ”。
 要手动输入呼号，请按 [QUICK], 然后选择“Edit”。

2. 选择“Gateway CQ ”。
3. 选择列出目的中继器的中继器组。
4. 选择目的地中继器。
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[MENU] > SET > My Station > My Call Sign
我的站点对讲机共有6个存储信道，来保存自己的呼
号，以便在DV模式下使用。最多可输入8位字符的呼
号。

此外，还可以输入最多4个字符的注释，用于操作对讲
机类型、区域等。

 有关我的呼号输入，请参阅基本手册中的D-STAR指南。
 要选择另一个我的呼号，请按 D-pad() 选择呼号，
     然后在 MY CALL SIGN 界面上按[ENT] 。

TX Message(发射信息)

[MENU] > SET > My Station > TX Message
对讲机共有5个存储信道，用于保存短消息，以便在
DV模式下与语音信号一起传输。

每个存储器信道，最多可存储20个字符的信息。

 请参阅第5-17页的TX消息输入。
要选择其他发送信息，请按 D-pad() 选择存储信道，
     然后在TX MESSAGE界面上按[ENT]。

提示: 要不发送信息，请选择“OFF ”。

12设置模式

我的站点

My Call Sign(我的呼号)
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DV设置

RX Bass� (默认: Normal)

[MENU] > SET > DV Set > Tone Control > RX Bass
.
.

 

� (默认: Normal)

[MENU] > SET > DV Set > Tone Control > RX Treble
.

� (默认: OFF)

[MENU] > SET > DV Set > Tone Control >  
RX Bass Boost

打开或关闭接收音频低音增强功能。 
此功能不同于“RX BASS”的“Boost”设置。 
.
 

� (默认: Normal)

[MENU] > SET > DV Set > Tone Control > TX Bass
.

� (默认: Normal)

[MENU] > SET > DV Set > Tone Control > TX Treble
.

� (默认: OFF)

[MENU] > SET > DV Set > Auto Reply
.

.






关闭功能。 
使用自己的呼号(MY)进行回复。（不
发送音频回复）
使用您的呼号（MY）和microSD上记
录的任何自动回复信息进行回复（最
长10秒）。
 


使用自己的呼号，并使用内部GPS接收
器传输您的位置数据。 

.





.



� (默认: Auto)

[MENU] > SET > DV Set > DV Data TX
.
• PTT: 按[PTT]，手动传输数据。
• Auto: 当数据通过[USB]端口从PC输入时，

            对讲机会自动传输数据。 

� (默认: OFF)

[MENU] > SET > DV Set > DV Fast Data > Fast Data
.



• OFF: 以慢速（约950 bps）发送数据。
• ON:   以慢速（约3480 bps）发送数据。
 即使选择“ON”，当按[PTT]时，数据也会以低速发送， 

      因为音频帧用于音频传输。
 GPS数据速度设置在 “GPS Data Speed”中。

12设置模式

• Cut:       减少高频。。
• Normal: 正常音调平衡。
• Boost: 增加高频。

• Cut:       降低低频。
• Normal: 正常音调。
• Boost: 增加低频率。

• Cut:       减少高频。。
• Normal: 正常音调。
• Boost: 增加高频。

当“GPS Select”设置为“OFF”或“Manual”
时，内部GPS接收器将暂时打开。



• Position:  
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DV设置

� (默认: Slow)

[MENU] > SET > DV Set > DV Fast Data > 
GPS Data Speed

.


• Slow:  以低速(约950 bps)发送GPS数据。
• Fast:  以低速(约3480 bps)发送GPS数据。

� (默认: 2sec)

[MENU] > SET > DV Set > DV Fast Data > 
TX Delay (PTT)

.


• OFF:
1 ~ 10sec:

.





注意：
此功能仅在“DV Data TX”设置为“PTT”时可用。

� (默认: Auto)

[MENU] > SET > DV Set > Digital Monitor
.

• Auto:

• Digital:
• Analog:

.




� (默认: ON)

[MENU] > SET > DV Set > Digital Repeater Set
.


.
 

� (默认: OFF)

[MENU] > SET > DV Set > DV Auto Detect
.



• OFF:  关闭功能。操作模式固定为DV模式。
• ON:   自动选择调频模式进行临时操作。

� (默认: ALL)

[MENU] > SET > DV Set > RX Record (RPT)
.




• ALL: .
.

� (默认: Call Sign Capture)

[MENU] > SET > DV Set > [RX>CS] Key
.

• Call Sign Capture:  

• RX>CS List:

.






� (默认: OFF)

[MENU] > SET > DV Set > BK
.


• OFF:  关闭功能
• ON: 开启功能
 当对讲机关闭时，BK功能会自动关闭。

12设置模式
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DV设置

� (默认: OFF)

[MENU] > SET > DV Set > EMR
.


• OFF: 关闭功能。
• ON:  开启功能。
 当对讲机关闭时，EMR功能会自动关闭。

� (默认: 19)

[MENU] > SET > DV Set > EMR AF Level
设置接收到EMR信号时的音频输出电平。当接收到
EMR信号时，将以编程电平或对讲机的音频电平(以
较高者为准)听到音频。
若要禁用该设置，请设置为“0”

.



12设置模式
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�
(默认: ON (Kerchunk))

[MENU] > SET > SPEECH > RX Call Sign SPEECH
.


相关信息
.













• OFF:

• ON (Kerchunk):
• ON (All):

.





� (默认: ON)

[MENU] > SET > SPEECH > RX>CS SPEECH
RX>CS语音功能，通过按下 [RX→CS]，来播报从接收
的呼叫记录中选择的电台呼号。
  .



.
 

� (默认: OFF)

[MENU] > SET > SPEECH > DIAL SPEECH
打开或关闭主旋钮语音功能。
主旋钮语音功能，播报旋钮选择的频率或中继器呼
号。
使用DR功能时，如果选择单工模式或调频中继器没有呼
     号，则会播报频率。
当您在广播中收到信号时，对讲机会取消播报，可以听到
     接收到的音频。

• OFF:
• ON:

.





� (默认: OFF)

[MENU] > SET > SPEECH > MODE SPEECH
开启或者关闭模式播报功能。
 在VFO扫描期间，当更改模式时，会播报操作模式。

• OFF:  所选的模式不播报。
• ON:   播报选择的模式。

� (默认: English)

[MENU] > SET > SPEECH > SPEECH Language
.

� (默认: Normal)

[MENU] > SET > SPEECH > Alphabet
选择语音播报的类型。
• Normal: 使用普通代码。

(示例：A表示eh，B表示bee)
.

(示例：A表示 Alfa, B 表示 Bravo)

12设置模式
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DTMF/T-CALL
.



� (默认: d0)

[MENU] > SET > DTMF/T-CALL > DTMF Memory
.
• T-CALL: 1750 Hz 音调。
• d0 ~ d#: DTMF存储信道列表。

� (默认: 100ms)

[MENU] > SET > DTMF/T-CALL > DTMF Speed
.

• 100ms:

• 200 ms:

• 300ms:

• 500ms:

.








� (默认: Fast)

[MENU] > SET > SPEECH > SPEECH Speed
.

� (默认: 7)

[MENU] > SET > SPEECH > SPEECH Level
设置语音合成器音频输出电平大小。
在0(OFF)、1(最小)和9(最大)之间。
  .



语音播报

12设置模式
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QSO/RX日志

� (默认: ON)

[MENU] > SET > QSO/RX Log > QSO Log
.



• OFF:
• ON:

.



提示:
•文件夹名称会自动创建为[ID-52\QsoLog]。
•文件名会自动创建，如下例所示：

日志开始日期和时间:    1st November 2021 15:30:00
文件名称: 20211101_153000.csv

.


� (默认: OFF)

[MENU] > SET > QSO/RX Log > RX History Log
.




• OFF:
• ON:

.




提示:
.








� (默认: Sep[,] Dec[.])

[MENU] > SET > QSO/RX Log > CSV Format > 
Separator/Decimal

选择CSV格式的分隔符和十进制字符。
 默认数值有所不同，具体参考对讲机版本。

• Sep [,] Dec [.]: 分隔符 “,” ，小数 “.”
• Sep [;] Dec [.]: 分隔符 “;” ，小数 “.”
• Sep [;] Dec [,]: 分隔符 “;” ，小数 “,”

� (默认: mm/dd/yyyy)

[MENU] > SET > QSO/RX Log > CSV Format > 
Date

选择介于“yyyy/mm/dd”、“mm/dd/yyyy”和“dd/
mm/yyyy”之间的日期格式.
（y：年，m：月，d：日）
 默认数值有所不同，具体参考对讲机版本。

12设置模式
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内容 示例 说明

TX/RX TX RX 传输和接收
Date 11/01/2021 13:51:48 11/01/2021 13:51:48 .
Frequency 438.010000 438.010000 操作频率
Mode DV DV 操作模式 (FM/FM-N/DV)

My Latitude 34.764667 34.764667 您的纬度（单位：度）
（+：北纬，–：南纬）

My Longitude 135.375333 135.375333 您的经度（单位：度）
（+：东经，–：西经）

My Altitude 50.5 50.5 .


RF Power LOW (Blank) 发射输出功率

S meter (Blank) S0 接收信号的相对信号强度（14级）

RPT Call Sign JP3YHJ JP3YHJ A 中继器呼号（仅限DV模式）
TX Call Sign CQCQCQ (Blank) 发射呼号（仅限DV模式）
RX Call Sign (Blank) JA3YUA A/52 接搜呼号/备注呼号（仅限DV模式）

RX Latitude (Blank) 34.764667
.



RX Longitude (Blank) 135.375333
.



RX Altitude (Blank) 30.5 .


QSO/RX日志

通话日志内容如下所示：

 12设置模式
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Frequency 438.010000 接收频率
Mode DV 操作模式 (DV模式已固定)
Caller JA3YUA A 主叫台呼号（最多8个字符）
/ ID52 呼号后的备注（最多4个字符）
Called CQCQCQ 被叫站呼号

Rx RPT1 JP3YHH G .

Rx RPT2 JP3YHH A 被叫站接入中继器呼号
Message Hello CQ D-STAR! 接入被叫站的中继器呼号接收到的呼叫中包含的消息（最多20个字符）
Status (Blank) 正常：空白，上行链路：“RPT UP”，接入中继器回复：“UR？”或“RPT？”

Received date 11/01/2021 13:51:48 .


BK * BK呼叫：“*”，正常呼叫：空白
EMR * EMR呼叫: “*”, 正常呼叫：空白
Latitude 34.764667 呼叫者的纬度，如果发送的话。（单位：度）（+：北纬，–：南纬）
Longitude 135.375333 呼叫者的经度，如果发送的话。（单位：度）（+：东经，–：西经）
Altitude 30.5 .
SSID -A 呼叫者的SSID（如果已发送）。（0，-1到-15，-A到-Z）
D-PRS Symbol Car 图标：转换为文本，无：代码
Course 123 来电者方位（单位：学位）
Speed 23.5 .
Power 49 发射功率（单位：瓦）
Height 24 天线高度（单位：米）
Gain 6 天线增益 (单位: dB)
Directivity Omni 天线方向性（Omni、45、90、135、180、225、270、315或360）
Object/Item Name HAM FES 对象名称或项目名称（最多9个字符）
Data Type Live Object 对象或项目的数据类型（Live或Kill）
Temperature 20.5 .
Rainfall 253.75 .
Rainfall (24 Hours) 253.75 .
Rainfall (Midnight) 253.75 .
Wind Direction 315 风向（单位：度）
Wind Speed 10.0 .
Gust Speed 10.0 .
Barometric 1013.0 .
Humidity 85 湿度（单位：%）
GPS Time Stamp 12:00:00 主叫站获取的时间数据以及位置数据

GPS Message Osaka City/ID-52 呼叫者为“NMEA”：记录GPS消息
呼叫者是“D-PRS：记录D-PRS备注

 12设置模式

QSO/RX日志

通话日志内容如下所示：

内容 示例 说明
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(默认: Auto (Short))

[MENU] > SET > Function > Power Save
.


. 
• Auto (Short): 将节能时间设置为“Short”。

15 ms

75 ms

5秒钟内未收到任何信号。

待机

接收→
禁用

• Auto (Middle): 将节能时间设置为“Middle”。

15 ms 15 ms

75 ms 150 ms

↑ 60 s

～ ～

• Auto (Long): 将节能时间设置为“Long”。

↑

15 ms 15 ms

75 ms 300 ms

60 s

～ ～

注意：出现以下功能时，省电功能禁用:
.




� (默认: Push)

[MENU] > SET > Function > Monitor
为[SQL]按键设置选项。（基本手册第3部分）

.


� (默认: ON)

[MENU] > SET > Function > Dial Speed-UP
.

.
 

� (默认: ON (DUP))

[MENU] > SET > Function > Auto Repeater
.


• OFF:  关闭功能。
• ON (DUP):   仅打开双工设置。
• ON (DUP, TONE):  打开双工设置和亚音功能。

Remote MIC Key(远程麦克风键)

[MENU] > SET > Function > Remote MIC Key
此功能指定可选HM-75LS遥控扬声器麦克风上的
按键[A], [B], 和上下按键。
有关可分配的关键功能，请参见第12-19页和第
12-20页。

• During RX/Standby:   指定的按键功能在接收或待
机模式下启用。
(默认: [A] ：频段

[B]:	 VFO/MR 
[]:	 UP
[]:	 DOWN)

•• During TX:  传输时启用指定的按键功能。
 (默认:  [A]: T-CALL 

[B]:	 --- 
[]:	 ---
[]:	 ---)

提示: 监测时音量水平调整
.
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Power Save (省电)

5秒钟内未收到任何信号。

待机

接收→
禁用

5秒钟内未收到任何信号。

待机

接收→
禁用
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• 接收/待机期间

功能 说明

--- 无功能

UP .

DOWN .

VOL UP .

VOL DOWN .

SQL UP .

SQL DOWN .

Monitor (Push) .

Monitor (Hold) .

CALL .

MR (00-00 CH) .

MR (00-01 CH) .

VFO/MR .

DR .

FROM (DR) 在DR屏幕上，按下以选择“FROM”。
TO (DR) 在DR屏幕上，按下以选择“TO”。

Home CH .


BAND .

SCAN .

Temporary Skip .


RX>CS
按住1秒钟，将最后一个呼叫站的呼号设置为“TO”（目的地）。
如果“[RX→CS]”设置为“RX>CS List”，则不会捕获接收到的呼号。此时会显示接收历史记录列表。
要使用可选遥控扬声器麦克风在接收历史记录中选择呼号，请指定 “UP”/“DOWN”按键功能。

SPEECH

•
• 

.



.

MAIN/DUAL .


MODE .

LOW .

DUP .

TONE/D.SQL .


MW .

REC .


Voice TX .


12设置模式
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• 发射期间

功能 说明

--- 无功能

VOL UP .

VOL DOWN .

Voice TX
.



T-CALL .

功能

按键指定功能

12设置模式
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� (默认: Normal)

[MENU] > SET > Function > Key Lock
.

.


• Normal: 除[SQL]和[VOL]外，所有按键和旋钮锁定。
• No SQL: 除[SQL]外，所有按键和旋钮锁定。
• No VOL: 除[VOL]外，所有按键和旋钮锁定。
• ALL:       所有按键和旋钮锁定 

� (默认: OFF)

[MENU] > SET > Function > PTT Lock
.


.
 

� (默认: OFF)

[MENU] > SET > Function > Busy Lockout
.


� (默认: 5min)

[MENU] > SET > Function > Time-Out Timer
.

. 
• 1 to 30 min:  设定的时间段结束后，传输被切断。

.

� (默认: All)

[MENU] > SET > Function > Active Band
.

• Single:   

• All:

.









• HAM:

 



.



� (默认: 2)

[MENU] > SET > Function > MIC Gain (Internal)
.



� (默认: 2)

[MENU] > SET > Function > MIC Gain (External)

12设置模式

功能

• OFF: 关闭功能
• ON: 开启功能。

将内置麦克风增益设置为1(最小)到4(最大)之间，以
满足操作需要。
值越高，麦克风对声音越敏感。
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� (默认: OFF)

[MENU] > SET > Function > VOX > VOX
.


• OFF: 关闭功能。
• ON: 开启功能。

� (默认: 5)

[MENU] > SET > Function > VOX > VOX Level
.

• OFF: 关闭VOX 功能
• 1 ~ 10:  1 (最小灵敏度)，10(最大灵敏度)

� (默认: 0.5sec)

[MENU] > SET > Function > VOX > VOX Delay
.



� (默认: 3min)

[MENU] > SET > Function > VOX >  
VOX Time-Out Timer

设置VOX发射限时，以防止意外的长时间传输。要禁用
该功能，请设置为“OFF” 。
• OFF: 关闭功能
• 1, 2, 3, 4, 5, 10, or 15min:

.


� (默认: Other)

[MENU] > SET > Function > VOX > Headset Select
.
.
 

CI-V Address(CI-V地址) (默认: A6)

[MENU] > SET > Function > CI-V > CI-V Address
以十六进制代码设置CI-V地址。
  .





CI-V Baud Rate (SP Jack)
(CI-V速率(SP插孔)) (默认: Auto)

[MENU] > SET > Function > CI-V >  
CI-V Baud Rate (SP Jack)

.




CI-V Transceive(CI-V收发) (默认: OFF)

[MENU] > SET > Function > CI-V > CI-V Transceive
打开或关闭收发功能。  
 要使用RS-MS1A或RS-MS1I，请设置为“ON”。
• OFF: 不输出状态未。
• ON:  .




CI-V USB/Bluetooth→REMOTE Transceive
�
 (默认: 00)

[MENU] > SET > Function > CI-V > 
CI-V USB/Bluetooth→REMOTE Transceive Address

.







12设置模式
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� (默认: Serialport)

[MENU] > SET > Function > USB Connect
.

• 仅限充电:
 只能使用USB电缆为对讲机充电。 

.



 相关信息
•需要安装USB驱动程序。
•连接电脑时，对讲机上会显示USB连接指示灯        。
•在 “USB Serialport Function”中选择输入/输出数据类型
•当输出接收到的位置数据时，确认“GPS Select”设置
为“ON”。

([MENU] > GPS > GPS Set > GPS Select)

• SD 卡模式:
 可以使用USB数据线在插入的microSD卡和电脑
之间传输文件。
将显示一个确认对话框。（第2-9页）

注意:
.









提示: 
从Icom网站下载USB驱动程序和安装指南。
https://www.icomjapan.com/support/

USB Serialport Function
(USB串行端口功能) (默认: CI-V (Echo Back OFF))

[MENU] > SET > Function > USB Serialport Function
.

• CI-V (Echo Back OFF):
.


• CI-V (Echo Back ON):
.


• DV Data:  DV数据被输入或输出到USB端口。

.



� (默认: Normal)

[MENU] > SET > Function > Heterodyne
.






12设置模式
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(默认: BP-271/BP-272)

[MENU] > SET > Function > Battery Pack Select
.

� (默认: OFF)

[MENU] > SET > Function > Battery Pack Confirmation
.


� (默认: ON)

[MENU] > SET > Function > Charging (Power ON)
当可选的外部直流电源电缆(CP-12L或OPC-254L)连接
到[DC IN]时，选择是否为电池充电，即使对讲机处于
打开也可以。

USB Power Input (Phone, Tablet, PC) 
(USB电源输入(手机、平板电脑、电脑)

[MENU] > SET > Function >  
USB Power Input (Phone, Tablet, PC)

.

� (默认: OFF)

[MENU] > SET > Function > Screen Capture [PWR] Key
.
• OFF: [ ] 按键不指定截图功能
• ON:   [ ] 按键指配成截图功能，截图信息存储到

SD卡上。

� (默认: BMP)

[MENU] > SET > Function > Screen Capture File Type
.

�
 (默认: Standard)

[MENU] > SET > Function > LO/CALL Key Actions
.

• Standard:  按键的操作不会改变。
• ID-51 Compatible (CS/LOW):

按键的操作如下所述。
[CALL]: 

[LO]: 

[MR]:  

.






.


[CALL]
[MR]

[LO]

12设置模式
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Battery Pack Select 
（电池选择）

（电池确认）

(默认: ON)
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显示

� (默认: Auto (DC IN:ON))

[MENU] > SET > Display > Backlight
.
• OFF: 背光不亮。
• ON:  背光长亮
• Auto:  按下按键或旋转[DIAL]时，背光亮起，并在

“Backlight Timer”中设置的时间段后降低亮度* 。
• Auto (DC IN:ON):

 按下按键或旋转[DIAL]时，背光会亮起，并
在“Backlight Timer”中设置的时间段后降低亮度*。 
当连接外部直流电源时，灯会持续亮起。

 仅使用GPS记录模式时，会自动选择 “Auto”。
* 当“Dim Screen”设置为“OFF”时，背光在“backlight Timer”

中设置的时间段后熄灭 。

� (默认: 10sec)

[MENU] > SET > Display > Backlight Timer
将背光计时器设置为5秒、10秒或30秒。根据
“Backlight”设置，背光在该设置的时间段内点亮，
然后自动降低亮度。
当“Dim Screen”设置为“OFF”时，背光在设置时间段后熄灭。

� (默认: 8)

[MENU] > SET > Display > Brightness
.

� (默认: ON)

[MENU] > SET > Display > Dim Screen
.

• OFF:

• ON:   

在“Backlight Timer”中设置的时间段后，背光
立即熄灭。
背光亮度在“Backlight Timer”中设置的时间段
后自动更改为“Brightness (Dim)”级别，并
在“Dim Timer”中的设置时间段后熄灭。

调暗屏幕功能的图像

� (默认： 1min)

[MENU] > SET > Display > Dim Timer
.



• 1/2/5/10min:
• Hold:

.


� (默认: 1)

[MENU] > SET > Display > Brightness (Dim)
在“Dim Timer”调光定时器中设置的时间段内，将LCD背
光亮度级别设置为1(调光)到7(亮)之间。
 设置一个比“Brightness”更低的级别。如果设置的级别高
     于“Brightness”，则调光屏幕功能不起作用。
 可以在“Brightness”屏幕上检查每个级别的亮度。

� (默认: White)

[MENU] > SET > Display > Background Color
.

� (默认: Standard)

[MENU] > SET > Display > Contrast
.

操作 不操作

调光屏幕功能开启。

Brightness级别
(默认: 8)

Brightness (Dim)级别。
(默认: 1)

背光计时
(默认: 1min)

1 2 3 4 5 6 7 8

背光计时
(默认: 10sec)

背光熄灭。

12设置模式
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� (默认: ON)

[MENU] > SET > Display > Busy LED
选择在接收信号时是否点亮TX/RX指示灯，或者静噪
打开。为了节省电池电量，请关闭此功能。
 无论设置如何，发送时指示灯都会亮起红色。 

• OFF: 即使接收到信号，指示灯也不亮。
• ON:  接收信号时，指示灯亮起绿色，或者静噪打开。

� (默认: Normal)

[MENU] > SET > Display > RX Call Sign
.

• OFF:
•Normal:

•RX Hold:

• Hold:

.










  .



� (默认: ON)

[MENU] > SET > Display > RX Position Indicator
.


• OFF:

• ON:

.




  .


�
 (默认: ON (Main/Sub))

[MENU] > SET > Display > RX Position Display
.


• OFF: 对话框中不显示任何数据。
• ON (Main/Sub):

.


• ON (Main Only):
.


 显示对话框的时间段取决于
     “RX Position Display Timer”设置。

�
 (默认: 10sec)

[MENU] > SET > Display > RX Position Display Timer
.

• 5/10/15/30sec:
• Hold:

.



� (默认: ON)

[MENU] > SET > Display > Reply Position Display
.

• OFF: 不显示呼叫者的位置数据。
• ON: 自动显示呼叫者的位置数据。

� (默认: ON)

[MENU] > SET > Display > RX Picture Indicator
.


• OFF:

• ON:

.




 .
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�



 (默认: ON)

[MENU] > SET > Display > DV RX Backlight
.


• OFF: 关闭背光功能。
• ON:   .




注意：当您将此项目设置为“ON”时，请
将“Backlight”设置为“Auto”或“Auto（DC IN:ON）”

� (默认: Your Call Sign)

[MENU] > SET > Display > TX Call Sign
.
. 


  .




� (默认: Fast)

[MENU] > SET > Display > Scroll Speed
将屏幕上显示的信息、呼号或其他文本的滚动速度设
置为“Slow”或“Fast”。

� (默认: ON)

[MENU] > SET > Display > Opening Message
.



� (默认: ON)

[MENU] > SET > Display > Voltage (Power ON)
.


.



� (默认: Date)

[MENU] > SET > Display > Single Band Display
.
. 


� (默认: dddº mm.mm′)

[MENU] > SET > Display > Display Unit 
> Latitude/Longitude

.

� (默认: ft/mi)

[MENU] > SET > Display > Display Unit 
> Altitude/Distance

选择显示距离和高度的格式。
 默认值可能会有所不同，具体取决于对讲机版本。 

� (默认: mph)

[MENU] > SET > Display > Display Unit > Speed
选择显示速度的格式。
  默认值可能会有所不同，具体取决于对讲机版本。 

� (默认: ºF)

[MENU] > SET > Display > Display Unit > Temperature
�


 (默认: inHg)

[MENU] > SET > Display > Display Unit > Barometric
选择显示气压的格式。
默认值可能会有所不同，具体取决于对讲机版本。

12设置模式
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(默认: inch)

[MENU] > SET > Display > Display Unit > Rainfall
选择显示降雨量的格式。
默认值可能会有所不同，具体取决于对讲机版本。 

� (默认: mph)

[MENU] > SET > Display > Display Unit > Wind Speed
选择显示风速的格式。
默认值可能会有所不同，具体取决于对讲机版本。 

� (默认: English)

[MENU] > SET > Display > Display Language
将屏幕显示语言设置为英语或日语。
只有当系统语言设置为日语时，才会显示此项目。

� (默认: English)

[MENU] > SET > Display > System Language
.

• English:  .








• Japanese:   对讲机的系统语言为日语。可以显示汉
字、平假名和片假名字符以及2字节符
号。要在DR屏幕或菜单模式中显示这
些字符，请将“显示语言”设置为“日
语”。

 当此项目设置为“英语”时，不显示“显示语言”。 

当对讲机的系统语言设置为日语时，对讲机可以同时
显示英语和日语字符。但是，如果选择日语，整个对
讲机系统的所有菜单项，仅以日语字符显示。不会有
英文项目名称。除非你能流利地阅读日语字符，否则
使用此功能时要格外小心。
如果对讲机的语言更改为日语，并且不理解新设置中
的菜单系统，则必须通过对对讲机CPU进行部分重
置，将语言更改回英语。部分重置不会清除的呼号数
据库。

要对CPU进行部分重置，请执行以下步骤：
1. 按 [MENU]。
2. 选择 “SET ” 。

3. 选择如下所示的项目（带有“etc”图标）。

4. 选择下面显示的底部项目。

5. 选择下面显示的上方项目。

 不要选择下方项目。
  下一项用于All reset(全部重置)功能，
   All reset清除所有条目并将所有设置，
   返回出厂默认值。 

6� 选择上方选项。

.


12设置模式
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提示音

� (默认: All)

[MENU] > SET > Sounds > Volume Select
.

• All:   .


• FM Radio Separate:
 调频广播的音频输出电平是独立调整
的。同时调整A频段(VFO A)和B频段
(VFO B)的音频输出电平。

• Separate:   .


.






当选择“All” 或“FM Radio Separate” 时: 
A频段和B频段的音频输出电平设置为“EMR  AF
Level”中的选定电平 。

当选择 “Separate”时：
接收信号的A频段或B频段的音频输出电平设置
为“EMR AF Level”中的选定电平。

� (默认: 0)

[MENU] > SET > Sounds > FM Radio Level
当 “Volume Select” 设置为“All”时，设置调频广播与
A和B频段之间的初始音频输出电平差

• +5 ~ +1: 
• 0：
• –5 ~ –1:

.



� (默认: OFF)

[MENU] > SET > Sounds > Earphone Mode
.



� (默认: 3)

[MENU] > SET > Sounds > Beep Level
.

� (默认: OFF)

[MENU] > SET > Sounds > Beep/Vol Level Link
.


• OFF:输出电平固定为“Beep Level”中设置的电平。
• ON:  可通过旋转[VOL]调节输出电平。

� (默认: ON)

[MENU] > SET > Sounds > Key-Touch Beep
.
.
 

� (默认: ON)

[MENU] > SET > Sounds > Home CH Beep
.

.





� (默认: OFF)

[MENU] > SET > Sounds > Band Edge Beep
.

� (默认: OFF)

[MENU] > SET > Sounds > Scan Stop Beep
.

12设置模式

• OFF: 没有提示音。
• ON: 选择主信道有提示音。

• OFF: 没有提示音。
• ON: 当退出或重新调谐到AIR、VHF和UHF频段的频

         率范围时，会发出提示音。  

• OFF: 没有提示音。
• ON: 扫描接到信号，而停止扫描时，有提示音。
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 (默认: ON (to me:Alarm/High Tone))

[MENU] > SET > Sounds > Standby Beep
.


• OFF:
• ON:
• ON (to me:High Tone):

• ON (to me:Alarm/High Tone):

.










 即使“Key Touch beep”设置为“OFF”,  待机提示音也会响起。
待机蜂鸣音输出电平取决于 “Beep  Level”设置。

� (默认: OFF)

[MENU] > SET > Sounds > Sub Band Mute
.

• OFF:
• Mute:
• Beep:

• Mute & Beep:

.







 .


时间设置

DATE(日期)

[MENU] > SET > Time Set > Date/Time > DATE
手动将日期设置为2020/01/01到2099/12/31之
间。
 星期几是自动设置的。

TIME(时间)

[MENU] > SET > Time Set > Date/Time > TIME
手动设置屏幕顶部显示的时间。时间以24小时格式显
示。当“GPS Time Correct”设置为“Auto”时，GPS接收
器通过计算接收到UTC时间和“UTC Offset”来自动设置
时间。

� (默认: Auto)

[MENU] > SET > Time Set > GPS Time Correct
.
• OFF: 不使用。
• Auto:   .



� (默认: ±0:00)

[MENU] > SET > Time Set > UTC Offset
.

� (默认: OFF)

[MENU] > SET > Time Set > Auto Power OFF
选择在不操作电台一段时间后，是否自动关闭对讲
机。
  .




• OFF:不开启自动关机功能。
• 30/60/90/120min:

.

12设置模式

提示音     

 Standby Beep (待机提示音)   
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SD卡

� (默认: mm/dd/yyyy)

[MENU] > SET > SD Card > Import/Export >  
CSV Format > Date

选择介于“yyyy/mm/dd”、“mm/dd/yyyy”和“dd/
mm/yyyy”之间的日期格式。
（y：年，m：月，d：日）
 默认数值有所区别，具体取决于对讲机版本。

Opening Picture(打开图片)

[MENU] > SET > SD Card > Opening Picture
选择电源接通时显示的图片。
 详见15-15页。

SD Card Info(SD卡信息)

[MENU] > SET > SD Card > SD Card Info
显示microSD卡的容量和语音录制的剩余时间。

Screen Capture View(截图)

[MENU] > SET > SD Card > Screen Capture View
显示所选的屏幕截图。

 TX/RX Picture View(发送/接收图片视图)
[MENU] > SET > SD Card > TX/RX Picture View

显示保存在microSD卡上的图片。
 对讲机在传输图片数据时无法显示图片。
 对讲机最多可显示500张图片。

Firmware Update(固件更新)

[MENU] > SET > SD Card > Firmware Update
显示固件更新模式。

 Format(格式)
[MENU] > SET > SD Card > Format

格式化microSD卡。
如果使用全新的microSD卡，请确保在对讲机中
对其进行格式化。

Unmount(移除)
[MENU] > SET > SD Card > Unmount

.



Load Setting(负载设置)

[MENU] > SET > SD Card > Load Setting
选择要加载的已保存数据文件。 

Save Setting(保存设置)

[MENU] > SET > SD Card > Save Setting
.

� (默认: Now Ver)

[MENU] > SET > SD Card > Save Form
.

• Now Ver:
• Old Ver (x.xx - x.xx):

.

.






.




Import(导入)

[MENU] > SET > SD Card > Import/Export > Import
以CSV格式文件，导入存储信道内容、广播存储内
容、UR呼号、中继器列表或GPS存储的数据。

Export(导出)

[MENU] > SET > SD Card > Import/Export > Export
.


� (默认: Sep[,] Dec[.])

[MENU] > SET > SD Card > Import/Export >  
CSV Format > Separator/Decimal

选择CSV格式的分隔符和十进制字符。
默认数值有所区别，具体取决于对讲机版本。

• Sep [,] Dec [.]: 分隔符 “,” ，小数 “.”
• Sep [;] Dec [.]: 分隔符 “;” ，小数 “.”
• Sep [;] Dec [,]: 分隔符 “;” ，小数 “,”

12设置模式
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蓝牙设置

� (默认: OFF)

[MENU] > SET > Bluetooth Set > Bluetooth
.

� (默认: ON)

[MENU] > SET > Bluetooth Set > Auto Connect
.

• OFF: 不连接到配对的设备。
• ON:  自动连接到最后一个连接的设备。

Pairing/Connect(配对/连接)

[MENU] > SET > Bluetooth Set > Pairing/Connect
搜索要连接的蓝牙设备，或在列表中显示配对的
蓝牙设备。
 详见 13-3 页。

<<Pairing Reception>>配对接收

[MENU] > SET > Bluetooth Set > <<Pairing Reception>>
.


� (默认: Headset Only)

[MENU] > SET > Bluetooth Set > Headset Set >  
AF Output

.
• Headset Only:仅限连接的蓝牙耳机输出音频。
• Headset & Speaker:

.


�
 (默认: Normal)

[MENU] > SET > Bluetooth Set > Headset Set > 
Headset Function Select

.

• Normal: .


• Microphone:

.




• PTT:  .




下面列出了每个选项的蓝牙耳机操作 

选件 发射控制 发射音频

标称 启用

麦克风

PTT
不启用

(发射时，音频来自麦克风 

� (默认: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Auto Disconnect

将断开计时器设置在0到10秒之间，或关闭。
如果蓝牙耳机没有音频输出，并且在此设置的时间段内
没有按键操作，则同步连接定向(SCO)链路*将自动断
开。
 当接收到信号、发出提示音，有按键操作时，会定向连

      接。
*用于语音通信的蓝牙链接。

12设置模式

启用

启用

启用

启用
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(默认: MAIN Band)

[MENU] > SET > Bluetooth Set > Headset Set >  
RX Priority Setting (LE Device)

在连接iOS设备(蓝牙LE(低能耗))和蓝牙耳机时，为
DV快速数据和接收音频选择通信优先级。蓝牙LE通
信不能同时用于DV快速数据和耳机音频。
  .




• DV Fast Data:  

• RX Audio:

• MAIN Band:

.









� (默认: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
VOX > VOX

打开或关闭声控传输(VOX)功能。
对着麦克风讲话时，VOX功能在不按[PTT]的情况下开
始传输，然后在停止讲话时自动返回接收。
 要使用VOX功能，需要选配蓝牙耳机.

• OFF: 关闭功能。
• ON:  .




� (默认: 5)

[MENU] > SET > Bluetooth Set > Headset Set > 
VOX > VOX Level

.


• OFF: 关闭声控。
• 1 ~ 10:  1 (最小灵敏度)

10 (最大灵敏度)

� (默认: 0.5sec)

[MENU] > SET > Bluetooth Set > Headset Set > 
VOX > VOX Delay

.



� (默认: 3min)

[MENU] > SET > Bluetooth Set > Headset Set > 
VOX > VOX Time-Out Timer

设置VOX发射限时，以防止意外的长时间传输。要禁用
该功能，请设置为 “OFF ”。
• OFF: 关闭功能
• 1, 2, 3, 4, 5, 10, or 15min:

.
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蓝牙设置

RX Priority Setting (LE Device)

(RX优先级设置（LE设备）) 
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(默认: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > Power Save

.




• OFF: 关闭省电。
• ON:  .



� (默认: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > One-Touch PTT

当连接选配的VS-3耳机时，设置一键式PTT功能。
此功能在不连续按住[PTT]的情况下进行传输。
 .



• OFF: 按住[PTT]时发送。
• ON: 按下[PTT]可在发送和接收之间切换。

� (默认: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > PTT Beep

.

.
 

� (默认: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > Custom Key Beep

.


	


(默认: [PLAY]: --- 
[FWD]: UP 
[RWD]: DOWN)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > Custom Key

.



Serialport Function
(串行端口功能) (默认: CI-V (Echo Back OFF))

[MENU] > SET > Bluetooth Set > Data Device Set >  
Serialport Function

.


•• CI-V (Echo Back OFF):
.


•• CI-V (Echo Back ON):
.


• DV Data:   .



Bluetooth Device Information(蓝牙设备信息)

[MENU] > SET > Bluetooth Set >  
Bluetooth Device Information

.

Initialize Bluetooth Device(初始化蓝牙设备)

[MENU] > SET > Bluetooth Set >  
Initialize Bluetooth Device

.

Power Save (省电)
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蓝牙设置

• OFF: 无提示音。
• ON: 一声提示音。 
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功能 说明

--- 无功能

UP .

DOWN .

VOL UP
VOL DOWN
SQL UP
SQL DOWN
Monitor (Push)
Monitor (Hold)
CALL
MR (00-00 CH)
MR (00-01 CH)
VFO/MR
DR
FROM/TO (DR)

Home CH

BAND
SCAN

Temporary Skip

RX>CS

SPEECH

••
••

MAIN/DUAL

MODE
LOW
DUP

TONE/D.SQL

MW

REC

Voice TX

T-CALL .
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蓝牙设置            

可指配的按键功能

按下以增加音量。

按下以降低音量。

按下可增加静噪级别。

按下可降低静噪级别。

按住打开静噪。松开以关闭静噪。

按下以打开或关闭静噪。

按下可选择呼叫信道模式。

在存储信道模式下，按下选择存储信道00-00。

在存储信道模式下，按下选择存储信道00-01。

按下选择VFO或者存储信道模式。

按下可打开或关闭DR功能。

在DR屏幕上，按下以选择“FROM”和“TO”。
按下可直接选择设置为所选模式（VFO/Memory）或DR屏幕的Home Channel（主信道）。
 在呼叫信道模式下，或未设置主信道时，会发出错误提示音。

按下可选择操作频段。

按下可启动先前选择的扫描。扫描时，按下可停止扫描。

按下可设置扫描时要跳过的频率。
为加快扫描速度，将暂时跳过选定的频率。

按住1秒钟，将最后一个呼叫站的呼号设置为“TO”（目的地）。
如果“[RX→CS]”设置为“RX>CS List”，则不会捕获接收到的呼号。此时会显示接收历史记录列表。
要使用可选遥控扬声器麦克风在接收历史记录中选择呼号，请指定 “UP”/“DOWN”按键功能。

•
• 在DR屏幕中，按下可播报呼号。
如果选择了单工模式，则会播报频率。

在VFO、Memory或Call Channel模式下，按下可播报频率和操作模式。

如果选择调频中继器，则会播报频率和工作模式，或呼号和工作模式。

•按下可将A或B频段设置为MAIN波段。
•按住1秒可打开或关闭Dualwatch双重值守功能。

按下可选择操作模式。

按下可选择发射输出功率。

按下可打开或关闭双工模式，并将方向切换到DUP+或DUP–。

•在FM/FM-N模式下，按下可选择亚音类型。
•在DV模式下，按下可选择数字静噪类型。

在VFO模式或DR屏幕上，按住1秒钟将存储信道内容输入到空白信道。

•按下可开始录制。
•录制时，按住1秒钟可停止录制。

• 按下可传输一次microSD卡上录制的语音音频。
• 按住1秒钟可重复传输语音音频。
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其他

Voltage(电压)

[MENU] > SET > Others > Information > Voltage
显示电池组和外部电源的电压。
连接锂电池时，会显示电池的充电状态和电池电压。
 连接可选电池盒时，会显示电池盒的端子电压。

Version(版本)

[MENU] > SET > Others > Information > Version
显示对讲机固件的版本号。

 Clone Mode

[MENU] > SET > Others > Clone > Clone Mode
进入克隆模式，从PC读取或向PC写入CS-52数据。
 重新启动对讲机，可以取消克隆模式。

Partial Reset(部分复位)

[MENU] > SET > Others > Reset > Partial Reset
将操作设置重置为默认值(VFO频率、VFO设置、菜
单内容)。
 详见15-18页。

All Reset(全部复位)
[MENU] > SET > Others > Reset > All Reset

.
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蓝牙操作

可以使用蓝牙功能将蓝牙设备连接到对讲机。
 请参阅基本手册以配对、断开连接或删除设备。

Icom 耳机
将VS-3 蓝牙耳机连接到对讲机时，可以无线发送和接
收它。VS-3有一个[PTT]开关，因此可以使用。与使用
对讲机的[PTT]开关相同的方式进行发送。VOX声控功
能还可用于通过耳机使用语音在TX和RX之间切换来选
择发送和接收。
可以将功能分配给VS-3侧面板上的按键，以远程操作对
讲机。

Android™/iOS 设备
通过蓝牙将移动设备连接到对讲机，并使用应用程序
时，可以使用扩展的D-STAR功能，如数据传输和图像
传输。
 有关应用程序以及对讲机与移动设备配对, 详见第17-5页。

打开蓝牙功能

[MENU] > SET > Bluetooth Set > Bluetooth
1. 按 [MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “Bluetooth ” 。

4. 选择 “ON ” 。

.

.








蓝牙

ID-52A/E

耳机设备

选配 VS-3
(蓝牙耳机)

移动设备

数据设备

13蓝牙操作
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连接蓝牙耳机

可以将可选的蓝牙耳机连接到对讲机。

步骤1. 选择耳机的配对模式 。
请参阅耳机的使用说明书以选择配对模式。

步骤2. 搜索耳机(对讲机)

[MENU] > SET > Bluetooth Set > Pairing/Connect

4. 选择“Device Search ” 。

5. 选择“Search Headset ” 。

.
6. 选择耳机配对

.

7. 选择“YES ” 。

• 在连接到头戴式耳机之后，     显示在配对列表中。
8. 按[MENU]退出菜单。

当连接到蓝牙设备时，蓝牙图标会显示在待机屏幕上。
当“AF Output”设置为“Headset Only”，且蓝牙连接意

外断开时，将显示一个对话框，选择是否从对讲机的
扬声器输出音频。（第13-4页）

13蓝牙操作

1. 按 [MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “Pairing/Connect” 。
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耳机设置

这些是使用蓝牙耳机时的设置。

D音频输出
[MENU] > SET > Bluetooth Set > Headset Set >  
AF Output

.




.


• YES:  音频从对讲机扬声器输出。
• NO:  .



.




[MENU] > SET > Bluetooth Set > Headset Set > 
Headset Function Select
• Normal:

按下[PTT]或内部麦克风的语音时，通过蓝牙耳机
传输语音。

• Microphone:
将蓝牙耳机用作麦克风
无法传输来自内部麦克风的音频。
也可以通过按下蓝牙耳机的[PTT]进行传输。

• PTT:
将蓝牙耳机用作PTT开关。
传输内部麦克风的音频。蓝牙耳机的音频无法传输。
也可以通过按下对讲机的[PTT]进行传输。

.

设置 发射操作 音频输出

Normal ✔ ✔

Microphone ✔ ✔

PTT ✔ (使用内置麦克风) 

13蓝牙操作

1. 按 [MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “Headset Set ” 。
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耳机设置

.







注意:
•

• 

.






 有关设置项目及其选项的详细信息，请参见第12-33页。 

[MENU] > SET > Bluetooth Set > Headset Set > VOX

VOX 界面
可以打开或关闭VOX功能。

VOX电平界面
可以设置VOX增益级别。值越高，VOX功能对声音越
敏感。

VOX 延迟界面
可以设置VOX延迟。VOX延迟是指在停止讲话后，在
VOX切换到接收之前，对讲机保持开启的时间。

VOX 限时发射界面
可以设置VOX超时定时器，以防止意外的长时间传
输。要禁用该功能，请设置为“ON”。

D自动断开
[MENU] > SET > Bluetooth Set > Headset Set >  
Auto Disconnect

可以将断开计时器设置在0到10秒之间，或关闭。
如果蓝牙耳机没有音频信号，或者在设定的时间段内
没有执行任何操作，接收器会自动断开面向同步连接
(SCO)链路。
当接收到信号，或在断开SCO链路的同时执行操作时，
     接收器将自动重新连接SCO链路。
 详见第12-32页。

DRX优先级设置(LE设备)
[MENU] > SET > Bluetooth Set > Headset Set >  
RX Priority Setting (LE Device)

.
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耳机设置

D关于Icom耳机(VS-3)
可以设置可选VS-3 Bluetooth®耳机的详细设置。
此外，可以在“Custom Key(自定义键)”屏幕上将键功
能分配给[PLAY]、[FWD]和[RWD]。
 有关设置项目及选项详细信息，请参见第12-34页

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset

.



















[FWD]
[PLAY]
[RWD]

选件 VS-3 
蓝牙耳机

13蓝牙操作
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编辑已安装的蓝牙设备名称

.


[MENU] > SET > Bluetooth Set >  
Bluetooth Device Information

4. 按 [QUICK]。
5. 选择 “Edit Name”。

6. 输入最多9个字符的名称*，然后按[输入]。
（示例：ICOM BT(ID-52)A）

*在“ICOM BT.”之后

.

初始化已安装的蓝牙单元

可以初始化对讲机的蓝牙单元。如果在蓝牙操作过程中
出现问题，则应初始化设备。
初始化设备后，配对/连接列表将被删除，但蓝牙设置和设

备名称仍保留。只有在执行部分重置或全部重置时，蓝牙
设置才会返回出厂默认值。（第15-18页）

[MENU] > SET > Bluetooth Set >  
Initialize Bluetooth Device

4� 选择 “YES” 。

.

配对设备的最大数量

可以配对两种类型的蓝牙设备：耳机和数据设备。

最大配对设备数量
.




.

13蓝牙操作

1. 按 [MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “Bluetooth Device Information ” 。

1. 按 [MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “Initialize Bluetooth Device ” 。
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14 共享图片功能

14-2

关于共享图片功能

.


相关信息
.



注意:
.



 .


.







关于要使用的图片文件
•文件类型*1:JPEG（文件扩展名为“jpg”）
• 图片大小*2:640 x 480、320 x 240或160 x 120(像素)
•文件大小：小于200 KB
•文件名称：最多23字符。(文件扩展名除外)

*1 对讲机无法读取扩展名为“jpeg”的文件，
或Progressive jpeg格式的文件。

*2  对讲机无法读取指定尺寸以外的图片，
即使其纵横比为4:3。
 即使您在microSD卡上保存的图片超过501张，
     对讲机也只能显示500张图片。 

关于免费下载软件
使用ST-4001W(适用于Windows)、ST-4001A(适用于
Android)或ST-4001I(适用于iOS)，可以添加文本并将
图片缩小到从对讲机发送的大小。当使用ST-4001A
或ST-4001I时，编辑后的图片可以通过蓝牙传输到对
讲机。
在使用之前，请仔细阅读手册说明，并按照说明使用这些
    软件。
 在本手册中，ST-4001W、ST-4001A和ST-4001I被描述
     为“Picture Utility software(图片实用软件)” 

将图片传送到对讲机
要通过蓝牙将图片传输到对讲机，请使用蓝牙功
能连接移动设备和对讲机。（第17-5页）

对讲机移动设备
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图片使用界面

[MENU] > PICTURE
1. 按[MENU]。
2. 选择“PICTURE ”。

• 此时将显示图片界面。
 要关闭图片屏幕，请按[QUICK], 然后选择 

 “<<Exit Picture Screen>> ”。

.

项目 作用

Picture TX

OFF .

Single TX

开启共享图片功能。
 .




Repeat TX .

<<TX All>> .

<<Back To 1st>> .

<< Exit Picture
Screen>> .

当接收信号包含图片数据时当接收信号包括图片数
据时，显示RX图片图标。

接收图标标记

 可以关闭接收图标标记 。
([MENU] > SET > Display > RX Picture Indicator)

接收图片界面
• 按[ENT]， 显示接收图片详细信息界面。
• 按 D-pad() 显示接收图片历史记录。(p. 14-7)

* .



接收频段

.




传输图标

.




当前时间 
历史记录编号 
图片大小
图片质量

接收时间

14 共享图片功能

传输图片界面
• 按[ENT]， 显示发送图片设置界面。
• 按 D-pad() 显示传输图片历史记录。(p. 14-7)

传输图标
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准备传输图片

.
.


D 通过蓝牙从移动设备进行传输。 
1. 将SD卡插入对讲机的插槽，然后打开对讲机。
2. 在移动设备中，打开图片实用程序软件。
 首次使用安卓设备时，请将对讲机与设备配对。
（第17-7页）

3. 打开传输设置屏幕。
4. 选择 “Using Bluetooth ”，然后将“Transfer

Devices”设置为对讲机。
    首次使用iOS设备时，请将对讲机与设备配对。

   （第17-9页）
  详见ST-4001A或ST-4001I使用说明书。
     它们可以从Icom网站下载。

.


.
 文件名自动设置如下 

.


注意: 如果无法传送图片，请检查以下内容：

在对讲机上
• 对讲机是否打开。
• 蓝牙是否打开。
• 对讲机的固件是否为最新版本。
• 将microSD卡插入对讲机。
• 对讲机是否处于正常工作模式。
 .



在设备上
.


D 使用PC或移动设备储存在microSD卡上 
1. 关闭对讲机，拆卸SD卡。
2. 将其插入电脑或移动设备上读卡器上*。

*用户提供。
3. 复制一个图片文件，并将其粘贴到卡上的

“Picture”文件夹（“ID-52”>“图片”）中。
4. 将卡从设备中取出，然后插入对讲机的插槽。

.



提示:
• 当 “USB Connect”设置为“SD Card Mode”，并且对讲机

通过USB数据线连接到电脑时，可以从电脑直接访问对讲
机中microSD卡。
([MENU] > SET > Function > USB Connect)

• 可以将收到的图片保存在SD卡的“Picture” 文件夹中。 (p.
14-7)

14 共享图片功能
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Sending the picture(传输图片)

步骤1. 选择要传输的照片
可以在TX PICT HISTORY屏幕中重新传输图片。
  （第14-7页）
 通过蓝牙传输图片时，它被设置为“TX Picture”。
     如果不需要更改，请转到“步骤2 . 传输图片”。

[MENU] > PICTURE
1. 按 [MENU]。
2. 选择 “PICTURE” 。
3. 按D-pad() 选择传输图片区域, 然后按[ENT]。

4. 再次按[ENT] 。
5. 选择“TX Picture ” 。

.
如果图片不是支持的格式(第14-2页)，
     或者已损坏，则无法查看图片。 

7. 按[ENT]。
8. 设置 “Picture Size,” “Picture Quality,” 和

“Receiver.”
 详见 14-6 页。

9. 按[MENU]退出TX PICTURE SET 界面。

步骤2. 传输图片
1. 按 [QUICK]。
2. 选择“Picture TX ” 。

3. 选择“Single TX” 或 “Repeat TX ” 。

.


.




.



  只能接收低速数据的其他对讲机发送图片时，
           请不要选择“<<TX All>>”。
 按住麦克风上的[PTT]发送语音音频时，对讲机会自动切
       换到慢速数据模式。 

14 共享图片功能
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传输图片

D移动传输标记
可以选择要开始发送区域块。
 发送图片时，无法移动传输标记。
1. 按D-pad()选择传输区域块，然后按 [ENT]。
2. 按[QUICK]。
3. 选择 “TX Picture Block Select ” 。 

4. 旋转[DIAL]或者按D-pad 移动传输区域块。

 要将发送区块标记移回第一个区块，请按[QUICK]，
     然后选择“BACK TO 1ST” 。

.


D传输图片设置
此界面用于设置图片、大小、质量及其发送目的地。
 传输图片时，无法更改设置。

1. 按D-pad()选择传输区域块，然后按 [ENT]。
2. 再次按[ENT] 。
3. 选择设置项目。 

4. 选择选项。

5. 按[MENU]退出 TX PICTURE SET界面。

.


传输图片
选择要发送的图片，保存在microSD卡的“Picture”文件
夹（“ID-52”>“Picture”）中。
当您在TX PICT HISTORY界面中设置传输图片时，文件名
之前会显示“(RE TX)”。

� (默认: 320 x 240)
设置传输图片的大小 “160 x 120,” “320 x 240,” 
或 “640 x 480”。
 不能选择大于图片大小的尺寸。

� (默认: Standard (50%))
将要发送的图片质量设置为“低(25%)”、“标准
(50%)”或“高(75%)”。

� 默认: -----)
.


.


14 共享图片功能
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查看图片

.




.

[MENU] > PICTURE
1. 按[MENU]。
2. 选择“PICTURE ”。
3. 按 D-pad()选择接收区域块，然后按 [ENT]。

4. 旋转[DIAL]以选择接收图片历史数据。
5. 按 [ENT]。

.


.

.
• Save:  将显示的图片保存到microSD卡上。

  文件名自动设置为以下格式：
Picyyyymmdd_callsign_xx
(yyyy:年，mm:month，dd:day，
callsign：呼叫者的呼号，
xx：序列号)。

• Delete:
• Delete All:

.


.




[MENU] > PICTURE
1. 按[MENU]。
2. 选择“PICTURE”。
3. 按D-pad() 选择传输区域块，然后按 [ENT]。

.


.

. 

• Delete:
• Delete All:

.


 当所选发送图片历史数据设置为“TX  Picture”
 (RE TX)时，无法删除。
传输图片时，不能将图片设置为 “TX Picture” 。

14 共享图片功能

注意：确认microSD卡在卡槽中。

4. 旋转[DIAL]以选择传输图片历史数据。
5. 按 [ENT]。
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插看图片

D 查看图片文件夹中的图片 
可以查看保存在microSD卡“图片”文件夹中的图片。
 发送图片时无法查看图片
.





[MENU] > SET > SD Card > TX/RX Picture View
1. 按[MENU]。
2. 在"SET"菜单选择“SD Card”。
3. 选择“TX/RX Picture View” 。

4� 选择图片查看。

.



• File Information: 
• Delete:
• Delete All:

.
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提示：在快捷菜单窗口中，可以选择以下选项。
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频谱功能

.








• Single Sweep:

• Continuous Sweep:

.




.



([MENU] > SET > Scope > Displayed Steps)

在中心模式下扫描期间

停止扫描期间

.





扫描标记

选择频段范围区域
（带橙色线条）强信道等级

弱信号等级

中心频率
(示例: 146.010 MHz)

频谱显示 

工作频率(移动）

滚动(固定)模式
显示指定频率范围内的信号。当操作频率移动到屏幕之
外时，显示的频率范围会自动切换。
 设置MENU菜单界面上显示的频率范围。 (p. 12-7) 

([MENU] > SET > Scope > FIX Mode Center Frequency)

固定模式
显示指定频率范围内的信号。
设置MENU菜单界面上显示的频率范围。 (p. 12-7) 

([MENU] > SET > Scope > FIX Mode Center Frequency)

.


边界
(高段频率y)模式图标

(FIX固定模式)

边界
(低段频率)

模式图标
(滚动(固定)模式

工作频率(移动）

工作频率(移动）
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频谱功能

.



D 使用频谱功能
[MENU] > SCOPE

1� 按[MENU]。
2. 选择“SCOPE ” 。

.

3. 按 [QUICK]。
4. 选择“Scope Mode ” 。

.
.

.
• 停止扫描。
 再次按 [ENT] ，恢复连续扫描功能。 

7. 当扫描停止时，旋转[DIAL]将扫描标记移动到
检测到的信号。

• 可以听到信号音频
  暂停扫描时，按下[CLR]关闭频谱功能。

频谱界面操作

按键 功能说明

[DIAL] .

D-pad() .

D-pad() .

[ENT] .

[QUICK] 按下可打开快捷菜单。
 选择频谱区域时，仅显示频谱菜单。

[CLR]
选择频谱区域时：
.


.


提示:
.









-

-

.





([MENU] > SET > Scope > AF Output (DUAL/AIR Band)) 
([MENU] > FM RADIO > FM Radio Set > Auto Mute)

 相关信息
• 较高的信号电平依次为红色、黄色、绿色、浅蓝色、蓝色

和黑色（无信号）。
• 在扫描过程中，瀑布区两侧的鳞片会随着瀑布移动。在停

止清除的同时，鳞片和瀑布也会冻结。
• 可以选择瀑布速度。

([MENU] > SET > Scope > Waterfall Speed)

瀑布式
区域 

比例 比例

选择频谱区域
（带橙色线）。

15其他功能
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主信道功能

可以在VFO模式、信道模式和DR界面中将常用频率、
存储信道或中继器设置为Home channel（主信道）。

D设置主信道
1. 选择VFO或信道模式，或DR界面设置主信道。
2. 选择要设置为主信道的频率、存储频道或接入

中继器。
3. 按下[QUICK]。
4. 选择“Home CH Set”(主信道设置)。

5. 选择“Set Frequency” (VFO 模式)， “Set
Channel” (信道模式)，或 “Set Repeater”
(DR 界面)。

.

.


.



可以将[Home CH]键功能分配给可选的麦克风键或
可选的蓝牙耳机。（第12-18、12-34页）
 可以在MENU界面的Home CH  Beep关闭提示音功能。 

([MENU] > SET > Sounds > Home CH Beep)

嘟嘟

15其他功能
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使用DTMF存储

对讲机可以保存多达16个24位DTMF代码的存储功
能。

D 输入DTMF代码

[MENU] > SET > DTMF/T-CALL > DTMF Memory
1. 按[MENU]。
2. 在“SET”菜单选择 “DTMF/T-CALL”。
3. 选择“DTMF Memory ” 。

4. 选择要输入的DTMF存储信道。

 不要按[ENT]。
5. 按 [QUICK]。
6. 选择“Edit ” 。

7. 输入DTMF代码，然后按 [ENT]。
(示例: 123456A)

.

.


提示：要清除输入的DTMF代码，请在DTMF 存储界
面上按[QUICK] ，然后选择 “Clear”。

.


[MENU] > SET > DTMF/T-CALL > DTMF Memory

.


.

提示：也可以通过按下[QUICK]，来检查DTMF代
码，并在步骤4中的DTMF 存储界面上，选择“DTMF 
Monitor”。

15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “DTMF/T-CALL”。
3. 选择“DTMF Memory ” 。
4. 选择一个DTMF存储信道进行监听。

 不要按[ENT]。
5. 按 [SQL]。
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发送DTMF代码

D 发送输入的DTMF代码

[MENU] > SET > DTMF/T-CALL > DTMF Memory

4. 选择一个DTMF存储信道进行发送。

.
.

.


.




提示:在待机屏幕中，可以通过按下[QUICK]、选
择“DTMF TX”并选择一个代码，来传输。

D发送DTMF代码(直接输入)

1. 按 [QUICK]。
2. 选择“DTMF TX” 。

3. 选择“Direct Input”。

4. 输入DTMF 代码，然后按[ENT]。
(示例: 012345#)

.



提示: 关于1750 Hz 音调
在DTMF 存储界面上，选择“T-CALL”时，可以发送
1750 Hz的音调。

.
.


15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “DTMF/T-CALL”。
3. 选择“DTMF Memory ” 。
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发送DTMF代码

.


[MENU] > SET > DTMF/T-CALL > DTMF Speed

4. 选择一个传输速率。(默认: 100ms)

.

发送DTMF代码的图像

Pi, Po, Pa

当选择“100ms”时，DTMF
传输速度很快。

Pi–, Po–, Pa–

当选择“500ms”时，DTMF
传输速度较慢。

15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “DTMF/T-CALL”。
3. 选择“DTMF Speed” 。
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亚音静噪操作

只有在FM或FM-N模式下接收到包含匹配亚音频音调的
信号时，亚音静噪才会打开。可以无声地等待来自使用
相同音调的其他电台的呼叫。此外，当信号包括匹配的
亚音频率时，反向亚音静噪功能使静噪静音。

步骤1. 设置亚音静噪频率

[MENU] > SET > DUP/TONE... > TSQL Freq
1. 按[VFO/MHz]选择 VFO 模式。
2. 按[MODE] 选择FM 或 FM-N 模式。
3. 旋转[DIAL] 设置操作频率。
4. 按[MENU]。
5. 在“SET” 菜单选择 “DUP/TONE...” 。
6. 选择“TSQL Freq” 。

7. 旋转[DIAL] 设置亚音静噪频率。然后按[ENT]。

.


亚音静噪类型指示

• TSQL: 开启亚音静噪。

• TSQL-R: 开启反向亚音静噪

• TONE(T)/DTCS(R)
(显示“T-DTCS”,“T”闪烁) :传输时，所选的亚音静噪会叠加在正常信号上。接收时，仅收听对DTCS静噪匹配音频信号。

• DTCS(T)/TSQL(R)
(显示“D-TSQL”,“D” 闪烁):传输时，所选DTCS静噪会叠加在正常信号上。接收时，仅收听对亚音静噪匹配音频信号。

• TONE(T)/TSQL(R)
(显示“T-TSQL”,“T” 闪烁) :传输时，所选的亚音静噪会叠加在正常信号上。接收时，仅收听亚音静噪匹配音频信号。

步骤2. 使用亚音静噪
1. 按[QUICK]。
2. 选择“TONE ” 。

3. 选择亚音静噪类型。

.
.



15其他功能
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DTCS静噪操作

[MENU] > SET > DUP/TONE... > DTCS Code

15其他功能

只有在FM或FM-N模式下接收到包含匹配DTCSD代码
的信号时，静噪才会打开。可以无声地等待来自使用相
同音调的其他电台的呼叫。此外，当信号包括匹配的
DTCS时，反向静噪功能使静噪静音。

步骤1. 设置DTCS静噪代码

1. 按[VFO/MHz]选择 VFO 模式。
2. 按[MODE] 选择FM 或 FM-N 模式。
3. 旋转[DIAL] 设置操作频率。
4. 按[MENU]。
5. 在“SET” 菜单选择 “DUP/TONE...” 。
6. 选择“DTCS Code” 。

7. 旋转[DIAL] 设置DTCS代码。然后按[ENT]。

设置范围在 023 -- 754。
按[MENU]退出菜单。

步骤2. 使用DTCS静噪

1. 按[QUICK]。
2. 选择“TONE ” 。

3. 选择DTCS静噪类型。

4. 正常操作。
• 将只能听到使用相同DTCS静噪代码的电台的音频。

所有其他信号将被静音。

亚音DTCS类型指示

• DTCS: 开启DTCS静噪。

• DTCS-R: 开启反向DTCS静噪

• DTCS(T)
(“DTCS”闪烁) :传输时，所选的DTCS静噪会叠加在正常信号上。接收时，DTCS静噪功能关闭。

• TONE(T)/DTCS(R)
(显示“T-DTCS”,“T”闪烁) :传输时，所选的亚音静噪会叠加在正常信号上。接收时，仅收听对DTCS静噪匹配音频信号。

• DTCS(T)/TSQL(R)
(显示“D-TSQL”,“D” 闪烁):传输时，所选DTCS静噪会叠加在正常信号上。接收时，仅收听对亚音静噪匹配音频信号。
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VOX 功能

.



.



VOX语音声控功能，可通过语音在发送和接收之间进行
切换。此功能可提供免提操作。
VOX功能选配件耳机是HS-94、HS-95或HS-97。
选配耳机适配器是OPC-2006LS。

D 选择耳机类型
[MENU] > SET > Function > VOX > Headset Select

1. 按[MENU]。
2. 在“SET”菜单选择 “Function” 。
3. 选择 “VOX ” 。

4� 选择“Headset Select ” 。

5� 选择配件 。

.

.

OPC-2006LS
(选配件)

HS-94*

ID-52A/E

连接到 
[MIC/SP] 插口

.

15其他功能

(选配件)
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D 使用VOX功能
[MENU] > SET > Function > VOX > VOX

4. 选择“VOX ” 。

5. 选择“ON ”。

6. 按[MENU]退出菜单。

.


.



D 设置VOX电平
注意：在设置VOX级别之前，我们建议将麦克风增
益级别设置为3。
([MENU] > SET > Function > MIC Gain (External))

[MENU] > SET > Function > VOX > VOX Level

4. 选择 “VOX Level ”。

5. 对着麦克风讲话时，旋转 [DIAL] 选择VOX等级

• 当输入TX电平音频时，显示“VOX”。
 VOX电平可以在1(最小)到10(最大)之间调整，
      也可以关闭。（默认值：5） 
 值越高，VOX功能对声音越敏感。 

.
  如果S表没有显示输出功率电平，并且对讲机没有

发送，则调整VOX延迟时间。
([MENU] > SET > Function > VOX > VOX Delay)

.


15其他功能

VOX 功能

1. 按[MENU]。
2. 在“SET”菜单选择 “Function” 。
3. 选择 “VOX ” 。

1. 按[MENU]。
2. 在“SET”菜单选择 “Function” 。
3. 选择 “VOX ” 。
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D VOX相关设置
可以在菜单屏幕上设置VOX延迟和VOX限时发
射。

VOX 延时

[MENU] > SET > Function > VOX > VOX Delay
VOX延迟是指在停止讲话后，发射器保持开启的时
间。它可以使说话正常不停顿。（第12-22页）

VOX 限时发射

[MENU] > SET > Function > VOX >  
VOX Time-Out Timer

VOX限时发射可防止长时间的意外传输。
(第12-22页)

15其他功能

VOX 功能
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每按一次[MR] ，可以在存储信道和天气信道之间
    切换。 

.
.

D 天气报警功能
NOAA广播电台在发布重要天气公告之前发送天气警
报音。
当天气警报功能打开时，所选的天气信道将每5秒监控
一次，以便发布公告。
当检测到警报信号时，“ALT”和WX通道交替显示，并
发出嘟嘟声，直到更改模式或天气信道、关闭天气报
警功能或关闭对讲机。
在待机期间或扫描时，会定期监测先前选择(使用)的天
气信道。

1. 按[QUICK]。
2. 选择“Weather Alert ” 。

3� 选择 “ON ”。

.

15其他功能

天气信道操作(仅限USA版本)
有10个天气信道可供监测NOAA的天气广播。

D选择天气预报信道
1� 按[MR] 选择天气信道。
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截图功能

可以将对讲机截图存储到SD卡上。本手册中使用的
大多数截图都是使用此功能拍摄的。但是，有些显示
无法捕获。

D设置截图功能
[MENU] > SET > Function >  
Screen Capture [PWR] Key

4� 选择 “ON ” 。

.

.

 

.

D 查看截图
[MENU] > SET > SD Card > Screen Capture View

.


4. 选择所需的屏幕截图后，显示截图内容。

• 将显示屏幕截图。
 在显示截图时，旋转[DIAL]可以浏览所有截图。 
.

查看文件信息并删除文件 
1. 选择要查看或删除的屏幕截图。
 不要按[ENT]。

2. 按 [QUICK]。
3. 从“File Information,” “Delete,” “Delete All”

中选择一个项目。

• File Information:

• Delete:
• Delete All:

.




[ ]

15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “Function” 。
3. 选择 “Screen Capture [PWR] Key ” 。

1. 按[MENU]。
2. 在“SET”菜单选择 “SD Card” 。
3. 选择 “Screen Capture View” 。
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设置开机图片

.

.


使用的图片文件要求
• 图片类型:  24位图(文件扩展名为“bmp”)
• 图片大小:      320 x 280 (px)
• 图片名称:      最多 23字符（文件扩展名除外）

步骤1.在microSD卡上保存图片 (电脑)
1. 将图片文件复制到SD卡上的“OpeningPicture”文件夹

.

.


步骤2. 设置显示图片 (对讲机)

[MENU] > SET > SD Card > Opening Picture

4. 选择显示的图片。

.
.
.
.

6. 选择 “YES”。
.

.


即使出现以下情况，也可以显示所选图片：
.


15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “SD Card” 。
3. 选择 “Opening Picture” 。
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克隆

对讲机具有数据克隆功能。如将所有设置和输入的内
容从一个ID-52A/ID-52E复制到另一个对讲机时，此
功能非常有用。本节介绍使用microSD卡进行克隆的
方法。

步骤1.  将主对讲机的设置数据保存到microSD卡上。

[MENU] > SET > SD Card > Save Setting

4. 选择“<<New File>> ” 。

.





.
6. 选择“YES ” 。

.


.

步骤2. 从主对讲机中取出microSD卡，
            然后将其插入子对讲机。   
1.关闭主对讲机。
2.从主对讲机中取出microSD卡。
3.将卡插入子对讲机，然后打开子对讲机。

主对讲机 字对讲机

注意:
.




.






(继续下一页的步骤。)

录制的语音不包括在克隆数据中。要播放主对讲机的语
    音，请将microSD卡插入子对讲机，或使用PC复制到子 

 对讲机的microSD卡上。 
 假设microSD卡已插入对讲机。 

15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “SD Card” 。
3. 选择 “Save Setting” 。
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克隆

步骤 3. 将设置数据加载到子对讲机中。

[MENU] > SET > SD Card > Load Setting

4. 选择要加载到对讲机中的数据文件。

5. 选择加载内容。

.










6. 选择 “YES” 或 “NO ” 。

.





7. 选择“YES”。

.


8. 重新启动对讲机以使用新设置进行操作 。

15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “SD Card” 。
3. 选择 “Load Setting” 。
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重置复位

.






有时，可能会显示错误的信息。这可能是由静电或其
他因素引起的。
如果出现此问题，请关闭收发对讲机。等待几秒钟
后，再次打开对讲机。如果问题仍然存在，请执行部
分重置复位。
如果执行部分重置后问题仍然存在，则执行全部重置
复位。

D 部分重置复位
部分重置将操作设置重置为默认值，而不清除以下内
容：
• 存储信道内容
• 呼叫信道内容
• 无线广播存储内容
• 扫描边缘内容
• 消息数据
• GPS存储内容
• 呼号存储
• DTMF存储内容
• 中继器列表
• 蓝牙配对列表
• 开机图片

[MENU] > SET > Others > Reset > Partial Reset

4. 选择 “Partial Reset”。

.
5. 选择“YES ”。

.


D 全部重置复位
全部重置将清除所有数据，并将所有设置返回到出厂
默认值。存储信道内容、筛选器设置等都将被清除，
因此除非有备份，否则需要重写操作设置。
 蓝牙配对列表和打开的图片不会被删除。

[MENU] > SET > Others > Reset > All Reset

4. 选择 “All Reset ” 。�

15其他功能

1. 按[MENU]。
2. 在“SET”菜单选择 “Others” 。
3. 选择 “Reset” 。

1. 按[MENU]。
2. 在“SET”菜单选择 “Others” 。
3. 选择 “Reset” 。

• 显示确认对话框。
5. 选择“YES ”。

• 显示“ALL RESET”，然后显示器自动返回到默认屏幕
界面。
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更新固件第16部分
注意：
有关如何插入或取出microSD卡
以及注意事项的详细信息，请参
阅基本手册第6部分。
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https://www.icomjapan.com/support/

.




[MENU] > SET > Others > Information > Version

4. 选择“Version ” 。

.


一般设置

D  关于更新软件
可以使用SD卡更新ID-52A/E的固件。更新固件可能
会添加新功能并提高性能参数。

可以从Icom网站下载最新的软件。

D 查阅软件版本
打开电台后，可以在ഡᇂଆൔ下查看固件版本。

1. 按[MENU]。
2. 在“SET”菜单选择 “Others” 。
3. 选择 “Information” 。

提示: 
打开电台时，可以在打开的屏幕界面上查看软件版本。

显示固件版本
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点击

5� 在显示的文件下载对话框中单击 “Save as” 。

6�  

.




一般设置

2	点击

1	输入

2	点击
1	点击

点击

16更新固件

https://www.icomjapan.com/support/
 这些说明基于Microsoft®Windows®10。

1. 点击“Firmware Updates/Software” 。

D准备
访问以下网址并下载固件文件。

2.  在搜索框中输入“ID-52”，然后单击[Search]。

3.  单击所需的固件文件链接。

4.  仔细阅读“关于此下载服务”，单击同意[Agree]，然
后再点击[Download]。

 选择要保存固件的位置，然后在显示的文件下载对话框
中单击保存[Save] 。

点击

1. 右键单击下载的固件文件夹(zip格式)。
• 显示右键单击菜单。

2. 点击 “Extract All...”

•  解压后，在下载文件夹所在的位置创建一个文件夹。
 在“52*”文件夹中，创建“52*.dat”。
*表示发布号。

D解压缩固件文件夹
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更新固件

.





1� 将下载的固件数据复制到SD卡上的 “ID-52”文件夹。

复制

.


[MENU] > SET > SD Card
4. 选择 “Firmware Update ” 。

5� 在您阅读并同意所有预防措施后，选择“YES ” 。

.





6. 选择更新的文件 (示例: 52*).
.

.





7. 阅读并同意所有注意事项后， 选择[YES] 。

.

提示: 
当 “USB Connect” 设置为 “SD Card Mode ” ，并且对
讲机通过USB数据线连接到电脑时，可以从电脑直接
访问对讲机中设置的microSD卡。
([MENU] > SET > Function > USB Connect)

16更新固件

注意：
在更新固件时，切勿关闭电台。
如果关闭电台，或更新时发生电源故障，电台将损
坏，必须将电台送回最近的Icom分销商进行维修。即
使电台仍在保修期内，这种类型的损坏，也不在保修
范围内。

提示: 
一定要解压缩下载的文件。详见前一页。

8. 对话框中显示“Firmware updating has completed”
固件更新已完成。
• 对讲机将自动重启。
 更新完成后，显示操作界面。��
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可以在Icom网站上找到这些选项的信息。
https://www.icomjapan.com/support/

由于版本不同，选配件有所不同。

选配件列表

其他

AD-92SMA天线连接或适配器
连接带有BNC连接器的天线或天线电缆。

FA-S270C甚高频/超高频天线
与提供的相同。

LC-193皮套
当BP-307连接到对讲机。

MB-127带扣
与提供的相同。

VS-3蓝牙耳机

电池/充电器
BC-167SA/BC-167SD电池充电器
与提供的相同。
形状可能会有所不同，具体取决于充电器的型号。

BC-202IP2快速充电器

+ BC-123SA/BC-123SE (L型插头)交流适配器

BC-202IP3L 快速充电器

+BC-123SA/BC-123SE（直型插头)交流适配器(用于
单个单元）

+BC-228交流适配器（适用于多个单元）

BP-271锂离子电池
电压：7.4 V
放电容量：1150毫安时(最小)，1200毫安时(标称)电
池寿命：约4.25小时（FM）

BP-272锂离子电池
与提供的相同。
电压：7.4 V
放电容量：1880毫安时(最小)，2000毫安时(标称)电
池寿命：约7.25小时（FM）

BP-273电池盒
使用3节LR6（AA）碱性电池。

BP-307锂离子电池
电压：7.2 V
放电容量：3050毫安时(最小值)，3150毫安小时(标
称值)电池寿命：约12小时（FM）

电缆

.

	
保险丝额定电压：125V
保险丝额定电流：3A
OPC-254L直流电源电缆
直接连接到直流电源。
保险丝：Fuse 250V 3A
保险丝额定电压：250V
保险丝额定电流：3A
CP-23L点烟器电缆
对于BC-202IP2，12 V
无法连接到对讲机的[DC IN]插孔。

OPC-515L直流电源电缆
对于BC-202IP2
无法连接到对讲机的[DC IN]插孔。

CP-25H点烟器电缆
对于BC-202IP3L，12 V
无法连接到对讲机的[DC IN]插孔。

OPC-2417数据线（USB micro-B/USB micro-B）

OPC-2418数据线（USB micro-B/USB Type-C）耳机/耳麦

HS-94/HS-95/HS-97耳机
+ OPC-2006LS插头适配器
		



耳钩类型
颈部和手臂类型
喉咙麦克风

OPC-2006LS:  将HS-94/HS-95/HS-97连接到用于VOX
功能对讲机。 

.








扬声器麦克风

.
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选配件列表

关于免费下载软件
CS-52 编程软件
RS-MS1A (安卓设备) 安卓应用程序
RS-MS1I (iOS设备) iOS应用程序
RS-MS3A (安卓设备) 终端模式/接入点模式软件
RS-MS3W ( Windows设备) 终端模式/接入点模式软件
ST-4001A (安卓设备) 图片实用软件
ST-4001I (iOS设备) 图片实用软件
ST-4001W (Windows设备) 图片实用软件

.
https://www.icomjapan.com/support/

使用前，请阅读每本手册和指南，并按照说明使用。 
.
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.






注意:
.



D指配远程控制功能
示例:  指配 “TO (DR)” 功能到 [A] 按键。

[MENU] > SET > Function > Remote MIC Key

4. 选择 “During RX/Standby”。

5. 选择 “[A]”。

.


17选配件

可选HM-75LS遥控器    麦克风

6� 选择 “TO (DR) ” 。

.


提示：要返回默认设置
• 在“During RX/Standby”界面或“During TX”界面上，

按下[QUICK]并选择“Default All”。
• 在每个按键屏幕上，按下[QUICK]并选择“Default”

A

OFF ON

LOCK

B

A

B

麦克风

发射指示

[PTT]

扬声器

锁定开关

[A]

[B]

[]

[]

耳机插口

1. 按[MENU]。
2. 在“SET”菜单选择 “Function” 。
3. 选择 “Remote MIC Key” 。
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使用应用程序

以下应用程序与安卓或iOS设备兼容。有关详细信息，请参阅每个应用程
序的手册。
从您的设备下载应用程序。

D 兼容的应用程序
	�






RS-MS3A:	
ST-4001A:	�

iOS
RS-MS1I:	�

ST-4001I:	�

.











D 必需项目
安卓设备
您可以将RS-MS1A/RS-MS3A/ST-4001A与安装了
Android 5.0或更高版本的设备一起使用。
 这些应用程序已经在Android 5.x.x、6.x.x、7.x.x、8.x.x、
     9.0和10.0上进行了测试。(截至2021年11月) 

iOS设备
可以将RS-MS1I/ST-4001I与安装了iOS版本12或更高
版本、iPadOS版本13或更高版的设备一起使用。
ST-4001I已经在iOS 12和13以及iPadOS 13上进行了测
    试。(截至2021年11月)

免责声明
.






使用USB电缆时
• 安卓设备

具有USB主机功能的Android 5.0或更高版本。

• 电缆(单独购买)
OPC-2417数据线（USB micro-B/USB micro-B）或
OPC-2418数据线（USB micro-B/USB Type-C）

.



使用蓝牙功能
• 安卓设备或者iOS设备

具有蓝牙功能的Android 5.0或更高版本。或具有蓝
牙功能的iOS版本12或更高版本、iPadOS版本13或
更新版本。
使用RS-MS3A时，无法通过蓝牙将Android设备连
    接到对讲机。  

注意：有些功能可能无法正常工作
.
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使用应用程序

.



 不要缩写应用程序名称，以确保能找到它。 

4. 触按 “  ”。
.
  .


.

.
.

.


D 使用USB 电缆

具有USB
主机功能
的安卓设备

连接USB端口连接 [USB]端口

USB电缆

ID-52A/E

  .


注意:
• 在连接或拔下电缆之前，请关闭对讲机。

• 当连接安卓设备时，USB连接指示灯(       )会显示在对讲
机上。如果指示灯未显示，请启用您的安卓设备来检测
USB设备。
在支持USB自动检测的移动设备上，不需要任何操作。

• 当使用RS-MS1A时，确认设置了以下项目。
当使用RS-MS1A时，确认设置了以下项目。
（[菜单]>设置>功能>CI-V）
将“CI-V Address”设置为与RS-MS1A侧相同的值。（默认
值：A6）

• RS-MS1A侧：应用程序设置→ CI-V设置
（默认值：对讲机[A6]）

• 将“CI-V: Transceiv”设置为“ON”。

（[MENU]>SET>Function>USB Serialport Function）
将“USB Serialport Function”设置为“CI-V(Echo Back
OFF)”。

（[MENO]>SET>Function>USB Connect）
将“USBConnect”设置为“Serialport”。

• 使用接入点模式时，不能使用RS-MS1A。

• 当您不使用USB电缆时，请拔下USB电缆。否则，电池会
很快耗尽。

D下载过程（iOS设备）
1. 打开iOS设备。
2.
3.

触按“Play Store”。
在搜索字段中输入应用程序的名称。
 不要缩写应用程序名称，以确保能找到它。

4. 触按 “  ”。
• 应用程序的名称将显示为搜索结果。
  如果iOS设备不支持该应用程序，其名称可能不会

出现在搜索结果上。
5. 触摸要安装的应用程序。

• 显示应用程序的介绍屏幕。
6. 触按 <GET>。

• 安装开始。
• 安装完成后，图标将显示在屏幕上。
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通过蓝牙将安卓设备连接到对讲机

.






.


步骤1.进入配对接收模式 (对讲机)

[MENU] > SET > Bluetooth Set >  
<<Pairing Reception>>

� (安卓设备)
.
.
可以在蓝牙设备信息屏幕上确认对讲机蓝牙单元的名称。 

 (默认: ICOM BT(ID-52)) (p. 13-7)
 详见安卓设备使用说明。 

.


步骤3. 向对讲机发送配对请求 (安卓设备)
.

•
• 

安卓设备开始发送配对请求。
安卓设备显示，“要与：ICOM BT(ID-52)配对。请确
保显示此密钥：“*****”。

步骤4. 接收配对请求 (对讲机) 
1� 当对讲机收到配对请求时，确认显示的密钥与您的

密钥相同，然后选择“CONFIRM” 。

•• Pairing starts.
2� 选择“Pairing/Connect”。

配对列表

.


.




1. 按[MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “<<Pairing Reception>>” 。
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通过蓝牙将安卓设备连接到对讲机

D连接
本节介绍如何使用RS-MS1A应用程序将安卓设备
连接到对讲机。
连接之前，请将对讲机与安卓设备配对。(第17-7
页)
 当使用ST-4001A应用程序时，对讲机和安卓设备在传
    输图片时会自动连接。

步骤 1. 准备连接 (对讲机)

[MENU] > SET > Function > CI-V > CI-V Transceive
.


� (安卓设备)
触按RS-MS1A启动。
 有关下载RS-MS1A的详细信息，请参阅第17-6页。

步骤3. 连接对讲机 (安卓设备)
.

• 开始连接
 如果呼号尚未输入对讲机，则应在连接之前输入呼号
连接完成后，对讲机显示“ ***  Connected”，并显示蓝牙
     图标。 

显示

.

.



[MENU] > SET > Bluetooth Set > Pairing/Connect

• 显示 “MMM Connecting���”
( “MMM” 是安卓设备的蓝牙名称。)

注意: 
如果无法连接，请检查对讲机和RS-MS1A中是否设
置了相同的CI-V地址。
可以看到如下所述的CI-V设置：
对讲机
菜单界面中的“CI-V Address”。
([MENU] > SET > Function > CI-V > CI-V Address)
(默认: A6)
RS-MS1A:
“Application Settings” → “CI-V settings”
(默认: Transceiver[A6])

设备名称
 连接时显示

1. 按[MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “Pairing/Connect” 。
4. 选择配对列表中显示的安卓设备名称。
5. 选择“YES”。

 在配对/连接屏幕上，显示“     ”。
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步骤3. 向对讲机发送配对请求 (iOS 设备)
1. 在应用程序上，触摸 “Scan ”。

• 对于RS-MS1I，项目显示在 “Other” >
“Bluetooth Connection ”。

•

• 

.





        可以在蓝牙设备信息界面上，确认对讲机蓝牙单元
              的名称。(默认：ICOM BT（ID-52）)(第13-7页)

2. 选择显示的对讲机蓝牙单元的名称，以发送配对
请求。
.


关于对讲机显示
连接完成后，对讲机显示“ * * * Connected” 并显示
蓝牙图标。
(“ * * * ” 是iOS设备的蓝牙名称。)

显示

17选配件

通过蓝牙将iOS设备连接到对讲机

.




注意:
.




.

• 将对讲机中“CI-V Transceive” 设置为ON。

([MENU] > SET > Function > CI-V > CI-V Transceive)
• 在对讲机和RS-MS1I中设置相同的CI-V地址。

对讲机:
在菜单界面“CI-V Address”。
([MENU] > SET > Function > CI-V > CI-V Address)
(默认: A6)
RS-MS1I:
• “Application Settings” → “Select the default”

(默认: Auto Select)
• “Application Settings” → “CI-V address”

(默认: Auto Setting)

(对讲机)

[MENU] > SET > Bluetooth Set > <<Pairing Reception>>

步骤 1. 启动应用程序 (iOS设备)
.






在显示的时间段内向对讲机发送配对请求(步骤3)。
当时间用完时，对讲机将退出配对接收模式。

1. 按[MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “<<Pairing Reception>>” 。

 在配对/连接屏幕上，显示“     ”。

设备名称
 连接时显示
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通过蓝牙将iOS设备连接到对讲机 

D 连接
本节介绍如何从iOS设备连接到配对的对讲机。连
接之前，请将对讲机与iOS设备配对。（第17-7
页）
当使用ST-4001I应用程序时，对讲机和iOS设备在传
    输图片时会自动连接。

[MENU] > SET > Bluetooth Set > Pairing/Connect

步骤 1.启动RS-MS1I (iOS设备)
触按RS-MS1I启动。
 有关下载RS-MS1I的详细信息，请参阅第17-6页。

步骤2. 连接对讲机 (iOS设备)
1. 触按“Other ”。
2. 触按 “Bluetooth Connection.”
3. 触按显示的对讲机蓝牙单元的名称进行连接。

• 开始连接
 如果呼号尚未输入对讲机，则应在连接之前输入呼号。
连接完成后，对讲机显示“ ***  Connected”，并显示蓝牙
     图标。 

显示

 在配对/连接屏幕上，显示“     ”。

设备名称
 连接时显示

提示：要从连接到对讲机iOS设备
当RS-MS1I在iOS设备上启动时，可以从对讲机连
接到设备。

• 显示 “MMM Connecting���”
( “MMM” 是iOS设备的蓝牙名称。)

1. 按[MENU]。
2. 在“SET”菜单选择 “Bluetooth Set” 。
3. 选择 “Pairing/Connect” 。
4. 选择配对列表中显示的安卓设备名称。
5. 选择“YES”。

 在配对/连接屏幕上，显示“     ”。
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